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Chapter 1  Introduction to LAN Support Center

Welcome to LAN Support Center, McAfee’s Windows-based problem management
system.

LSC is a member of McAfee’s family of network administration and management
tools, a group of network applications that help you manage your LAN more
effectively.

About LAN Support Center

The Purpose of LSC

LAN Support Center (LSC) tracks support activities by allowing you to create,
maintain and retrieve tickets electronically.  Easily accessible windows display vital
information regarding the caller’s equipment, software and call history.  To help
solve problems rapidly and identify recurring problem areas, the LSC database gives
you instant access to information regarding help desk activity.

LSC also provides management with automated tools to supervise support
operations more efficiently.  Call histories, support procedure documents and scripts
can all be accessed easily to help staff rapidly identify and diagnose problems.  Data
in every help desk session can be consolidated to analyze staff performance and
response times.  Help desk issues and their solutions can also be analyzed to identify
recurring problem areas which may need configuration adjustments or user training
programs.

LSC is a sophisticated yet easy-to-use ticketing system based on a powerful database
technology.  Each organization can customize the LSC database field labels, the
ticket list information display and the information to be included in reports.  This
ability to customize LSC results in more streamlined workflow.

LSC is a fully compatible Microsoft Windows 3.1 system.  Familiar Windows
techniques execute commands, scroll and select list information, and open, close and
move between multiple windows.  Entering, editing, cutting and pasting functions
are also consistent with Windows, minimizing required training time.
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The reports included with LSC provide management with valuable information
regarding staff response time, frequency of problem occurrence, and customer
support requests.  These reports can be customized to satisfy the requirements of
each organization.  LSC also includes Crystal Reports, a powerful and easy-to-use
custom report writer.

Help Desks

The Problem

The help desk is emerging as a central, corporate organization designed to solve end-
user computer hardware and software problems quickly.  With the increasing
reliance on computers in today’s workplace, the effectiveness of the help desk staff
has direct impact on workstation user productivity and organization profitability.
Automated problem management systems, such as McAfee’s LAN Support Center,
can have a dramatic impact on how rapidly user problems are resolved and can help
managers record and understand data on how the help desk is functioning.

Today’s help desk organization faces numerous challenges.  As incoming call
volumes increase, the time required to log problems manually (i.e., write down
messages, problem descriptions and user configurations) negatively effects
productivity.  It is critical that calls are neither lost nor follow-up activities
misplaced and forgotten.  Thus arises the need to analyze help desk operations in
order to develop programs which minimize user downtime.

Like all other corporate organizations, help desks are asked to do more with less
staff.  Valuable senior technical staff must be utilized wisely, and junior staff must
develop their support skills independently.  Within the growing computer user
population, perhaps the most critical demand of help desks is to resolve problems
faster than ever before.

The McAfee Solution

LAN Support Center is a powerful problem management system that tracks support
activities by creating a ticket for every support call.  LSC lets you record all
necessary details in easy-to-use screens that are fully customized to your
organization and individual support staff preferences.  By replacing manual
procedures with sophisticated information management functions that track a ticket
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until it is resolved, LSC dramatically improves help desk operations.  Support staff
spend less time with paperwork and more time on actually solving problems.
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The Cost

The justification for automating help desk operations consists of two important
elements.  First is the direct time saved by the help desk staff in the performance of
daily activities.  Second are the intangible costs to corporate users and help desk
departments that are incurred when users cannot be supported as rapidly as possible.
Both cost saving elements are discussed below.

Time Cost Savings

Help Desk Practices,1 a survey published by the Help Desk Institute about its
membership, confirms the broad range of sizes of help desk organizations and user
communities.  A profile of a five person help desk organization is as follows:

Number of Employees:  5

Average annual salary and benefits (all help desk departmental employees):  $35,000

Average hourly wage:  $17.00

Average number of users supported:  2,500

Average number of calls/month:  2,000

Cost/month (assuming 5 days/week of operation):  $35,000/12 x 5 employees:  $14,583/month

Average percentage calls resolved by the help desk:  71%

Average number of calls resolved by the help desk:  1,420

Cost/call/month:  $14,583/1,420 calls:  $10.20/call

LSC can increase the productivity of existing staff by over 20% in comparison with
manual systems.  These productivity increases are the direct result of eliminating
many of the labor-intensive activities connected with receiving and following
through on a support problem.  LSC eliminates the time required to manually record
details about the caller and the problem.  LSC electronically displays configuration
and call history information and can help staff members retrieve existing solutions.
By capturing help desk information electronically, problem data can be analyzed to
identify potential networking improvements that could eliminate future help desk
calls.

The model below characterizes the hard cost savings that exist for automated help
desks with a 20% productivity increase at current calling rates.  At 20%, the cost per

                                                  
1Help Desk Institute, Help Desk Practices, A Survey of Help Desk Institute
Members,  (
Colorado Springs, CO: Help Desk Institute, 1993).
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call savings can justify an additional employee.  More importantly, productivity time
savings can be the vital resource for those help desks grappling with increasing
demands to support new technologies and manage changes to existing hardware and
software installations.

Help Desks with

No Automation

Expected Savings with LSC

(20% savings)

# of Calls 1,420 1,420

Calls/year: 17,040 17,040

Cost/call: $10.20 $8.16

Costs/year: $173,808 $139,046

Savings/year: $ 34,762

Hidden Cost Savings

LSC’s most important benefit is its ability to free up staff time.  This increases the
number of end users served and makes time available to gain expertise in emerging
technologies.  According to the Help Desk Institute, its members reported that the
issues impacting help desk operations include calls related to new technology
support, new customers and changes and upgrades to existing systems.  LSC gives
your staff the time it needs to keep apace with your growing user community and to
stay on top of rapid technological change.

By making your staff more effective, LSC reduces one of your corporation’s most
critical hidden costslost worker productivity.  LSC provides support staff with the
tools to resolve calls rapidly and share information to maximize technical expertise.
This “found time” can be used for any number of activities, including the following:

application training to reduce the need for support calls
cross training to expand your users’ knowledge base
keeping up with industry technology changes
planning for network expansions



14 Using LAN Support Center

LAN Support Center’s Features
LSC automates ticket creation, problem management and the reporting requirements
of an active help desk.  LSC simplifies help desk operations by eliminating the
paperwork that slows down your response to support calls.  LSC’s database
maintains support information on-line and lets you quickly view your caller’s
support history and search for similar problems, to diagnose support problems
rapidly.  To meet the individual needs of your organization, you can customize
many aspects of LSC: field labels, ticket listings and the type of information stored
and included on reports.

With McAfee’s LAN Support Center, you can perform the following functions:

Track support activities by creating a ticket for every support call, stored
in a powerful ticket database.
Build, edit, display and select from lists of customized information
needed to create or manage a ticket.
Give staff and managers a snapshot of current support activities, all
active tickets and the status of any support problems.
Maintain user and equipment profiles on-line to rapidl y display a caller’s
configuration.
Assign up to four priority levels so urgent problems get quicker attention
and resolution.
Route calls to other or more qualified support technicians to get the most
productivity out of junior, senior and specialized technicians.
Automate record-keeping and reporting by electronically capturing the
entire history of the help desk session including all ticket information,
actions taken and follow-up activities.
Sort, display and save any user-defined, cross section “view” of the
ticket database, to facilitate a particular job function.
Filter sections of the ticket database for display or reporting, eliminating
extraneous information.
Display multiple windows of ticketing or departmental information
simultaneously, and let users rapidly move between windows to create
and process a ticket quickly and accurately.
Display solutions to recurring or past problems to quickly resolve similar
situations.
Provide powerful query, sorting and reporting features to generate daily
and periodic performance reports.
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Produce a variety of standard reports detailing support productivity and
help desk operations.
Utilize Crystal Reports, a powerful, flexible and easy-to-use report
generator to produce LSC information in an unlimited number of
formats.
Store custom report formats for future use.
Archive and restore inactive tickets whenever necessary to utilize disk
space efficiently.
Support file importing and exporting to share data between LSC and
other applications.
Display on-line help information.
Protect against unauthorized access through log-in pa ssword security.

LAN Support Center integrates with the following applications:

Novell Btrieve Record Manager - LSC uses the fast and highly
sophisticated database system for database management.
Microsoft Windows 3.1 - LSC supports the familiar user interface to
minimize training time and maximize ease of use.
Other McAfee network management applications as follows:
- LSC links to LAN Inventory for a comprehensive and accurate

description of a user’s hardware configuration.
- LSC connects to SiteMeter to identify user software version and

revision levels.  Support staff can also determine whether a user is
“locked out” of a metered application due to licensing limits.

- LSC accesses NetRemote to run the user’s workstation remotely,
without leaving the help desk.

LSC’s Major Components
The LAN Support Center software consists of one executable file and several
supporting components.  As an introduction to the entire product, this section briefly
describes each LSC component.  A complete list of LSC files is provided in
Appendix C.

The LSC components are:
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LAN Support Center Console (LSC.EXE)
LAN Support Center Database Lists
Reporting Module
Import/Export Utility

LSC Console

LSC.EXE is the LSC console and administrative program which provides access to
most LSC functions.  This main module is a Windows-based program and is
intended to be used by the support administrator and the support staff members.

The administrative functions available from the LSC console include:

Setting up staff members and defining access rights
Customizing the LSC database labels
Maintaining the database lists
Archiving and restoring tickets

The support staff functions available from the LSC console include:

Generating tickets to track events
Maintaining ticket information and related activities
Modifying ticket views to speed support response time
Customizing and generating reports

LSC Database Lists

LSC is an integrated database system which tracks and manages all information
regarding ticket data.  Novell’s Btrieve is used as the database record manager.
LSC’s major databases are:

Current Ticket Database  - the group of tickets to which new tickets are
added.  There is only one current database at any time.
Historical Ticket Database(s)  - a group of tickets that have been
removed from the current database.  These archived tickets can be loaded
into LSC for reference purposes; however, changes to the historical
database tickets should not be made.  There can be any number of
historical databases.



Using LAN Support Center 17

Qualification Lists  - the categorized lists of information entered into
LSC which act as reference aids to facilitate data entry and maintain the
integrity of the data files.

Appendix C provides a complete list of the LSC data and executable files.

Reporting Module

LSC is shipped with several pre-defined reports that represent reports often
requested by support desk management.  These reports provide valuable information
regarding ticket activity, staff response time, problem types, and much more.

LSC’s pre-defined reports can be customized to reflect individual reporting
requirements.  By applying filtering criteria (i.e., a “query”) to a pre-defined report,
the report will only include the data in the LSC database that matches the query
constraints.  These customized reports can be saved for future use.

LSC also includes the Crystal Reports software, a powerful and easy-to-use report
generator.  With Crystal Reports, you can create and customize your own reports
using data from the LSC database.  Powerful calculation and formatting features will
help you generate more meaningful performance monitoring and analytical reports.

NOTE:
The Crystal Reports software is installed using the LSC install utility.  A
Crystal Reports program icon is added to the McAfee Program Manager
group.  Procedures for using Crystal Reports are presented in Part Two of this
manual.
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Import/ Export Utility

The LSC import/export utility is a DOS application which enables the transfer of
ticket data into and out of LAN Support Center.  Upon installation, the utility
(LSCIMEX.EXE) is copied into the LSC program directory.

LAN Support Center ticket and action information can be exported into an ASCII
text file for use in another database application.  Similarly, data from comma
delimited ASCII files can be imported into LSC.

Because LSC 3.0 has a customizable interface, most data fields are not restricted to a
particular format.  The import/export utility will match the field names in LSC even
if they have been changed by the administrator.  The only fields that have a specified
format are date and time fields.  All other fields may be of any type or format.

Procedures for using the import/export utility are discussed in Appendix E.

Environment
The following minimum criteria must be met in order to run LAN Support Center:

386SX CPU
4 MB of RAM
Novell Btrieve Record Manager
Windows 3.1 in Enhanced Mode

NOTES:
a - LSC can operate on Novell NetWare via IPX/SPX and is compatible with
NetWare 4.0 and NMS.

b - LSC will work with Client Based and Server Based Btrieve.  Server Based
Btrieve (BREQUEST version 6.10) is recommended for increased performance.
Refer to Appendix D for more information on using BREQUEST.
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How This Manual is Organized
This manual is organized in three parts:

Part One: Using LAN Support Center
Part Two: Using Crystal Reports
Part Three: Reference Guide

The individual chapters in each part of the manual are listed in the tables below.

Part One: Using LAN Support Center

CHAPTER DESCRIPTION

Chapter 1:
Introduction to LAN
Support Center

Provides introductory information about LSC, its
requirements and how to receive technical support.

Chapter 2:
Installation &
Configuration

Provides complete installation instructions and
troubleshooting information.  It also discusses the
configuration of Novell’s Btrieve record manager.

Chapter 3:
Getting Started

Discusses the LSC interface and provides a tutorial for
the first time LSC user.

Chapter 4:
Ticket Data Display

Presents an overview of the various windows that display
the ticket data maintained by LSC.

Chapter 5:
Setup and
Administration

Describes the procedures for defining the LSC database
labels, assigning staff membership and security,
managing the qualification lists, archiving/restoring
tickets and configuring print parameters.

Chapter 6:
Work Tickets

Describes the procedures for creating and maintaining
work tickets.

Chapter 7:
Viewing Ticket Data

Discusses the various methods available for viewing
ticket information.

Chapter 8:
LSC Reports

Discusses procedures for generating both pre-defined and
custom reports.  Illustrates and discusses each report
type.
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Part Two: Using Crystal Reports

CHAPTER DESCRIPTION

Chapter 9:
Introduction to
Crystal Reports

Provides a brief overview of Crystal Reports to familiarize
you with the Crystal Reports screens, using the mouse,
error messages, and the help facility.

Chapter 10:
Using Crystal
Reports

Conceptually leads you through the process of creating a
report with Crystal Reports. It suggests a methodology for
creating reports starting with nothing more than a one
sentence statement of purpose for the report.

Chapter 11:
Practical Crystal
Reports

Contains a variety of report creation topics and additional
information on the practical aspects of using Crystal
Reports to solve typical reporting problems.

Part Three: Reference Guide

CHAPTER DESCRIPTION

Appendix A:
Error Messages

Lists the error messages associated with LSC and provides
explanations for each.

Appendix B:
Btrieve Status
Codes

Lists the error messages associated with Novell’s Btrieve
and provides explanations for each.

Appendix C:
LSC File List

Lists and defines the files included with LSC.

Appendix D:
Using Brequest

Provides recommendations on how to setup and use
BREQUEST.

Appendix E:
LSC
Import/Export
Utility

Provides instructions on using the import/export utility.

This ends the introduction to LAN Support Center.  Refer to the next chapter for
installation and configuration instructions.
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Chapter 2  Installation and Configuration

The previous chapter introduced LAN Support Center.  This chapter describes the
installation procedures for LAN Support Center and provides an installation
troubleshooting section.  It also discusses the configuration of Novell’s Btrieve
record manager.

NOTE:
If you purchased LAN Support Center with McAfee's BrightWorks package
2.01 or later, refer to Chapter 2, "Installation" in either your Getting Started:
BrightWorks guide or your Using BrghtWorks Manual.

Introduction

What’s in this Chapter

The following chart describes the sections in this chapter:

SECTION DESCRIPTION

Before Installation Lists several requirements that must be met before installing
the LSC software.

LSC Installation
Instructions

Provides instructions on installing LSC.  The options are: Basic
Install, Custom Install, Upgrade and Conversion.  The
procedures for each option are discussed in their separate
sections in this chapter.

Uninstalling LSC Provides procedures for removing the LSC software.

Installation
Troubleshooting

Lists the messages that might display during the installation
procedure.

Btrieve Configuration
Options

Presents the alternatives for configuring the Btrieve Record
Manager.
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Before Installation
LAN Support Center can be used in either a stand-alone or a networked
environment.  In both cases, you must run Windows 3.1 in enhanced mode.

LSC and NetWare

For LSC installation and use on a Novell NetWare network, the following file
versions are recommended:

IPX version 3.10
NETX version 3.26 or greater
VIPX version 1.13
NETWARE.DRV version 2.02
VNETWARE.386 version 1.06
Windows version 3.1 (enhanced mode)

NOTE:
If you are using ODI drivers instead of IPX, you must have the following:
- LSL version 1.2 or 2.01
- IPXODI.COM version 1.2 or 2.1

The latest versions of these files can be found on Compuserve in Library 5 of the
Novell Libraries (GO NOVLIB; Lib 5). As of this writing, the current IPX, NETX,
and IPXODI are contained within the self-extracting file DOSUP9.EXE.

The current versions of the Novell support drivers for Windows (VIPX.386,
VNETWARE.386, NETWARE.DRV, etc.) can be found in the self-extracting file
WINUP9.EXE.

NOTE:
As these drivers are updated and added to the Compuserve file, the number
within the Compuserve filename will increment.  For example, if Novell were to
release a newer IPX and add it to DOSUP9.EXE, the name would change to
DOSUP10.EXE.
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Determining Version Numbers

You can determine the versions of the above software by using the following
methods:

To determine the installed version of IPX and the NET shell, use the
Novell NVER command.
To determine the version and mode of Windows, run Windows and
choose the About Program Manager command from the Program
Manager Help menu.
To determine the version of your Novell Windows support drivers, use
the Novell VERSION command. For example, type:
VERSION VNETWARE.386 <ENTER>

To determine the version of your IPXODI.COM file, use the Novell
VERSION command.  For example, type:
VERSION IPXODI.COM <ENTER>

LSC Installation  Instructions
This section provides the step-by-step instructions necessary to install LAN Support
Center.

Follow the steps below to install LSC.  You can exit the installation at any time by
choosing the Exit button in the lower right corner of the installation screen.

1. Run Windows 3.1 in enhanced mode.

2. Place distribution diskette #1 in your floppy drive.

3. Choose the Run command from the Program Manager File menu.

The Run dialog box displays.

4. In the Command Line field, enter the drive letter of the floppy drive where you
inserted the distribution diskette.  Enter the SETUP command, and then choose
the OK button.

Your Run dialog box should look similar to Figure 2-1.



24 Using LAN Support Center

Figure 2-1: Initiating the LSC Install Procedure

Upon choosing the OK button, a Log File named LSC300.LOG is created and
placed in your local WINDOWS directory.  The Log File is an ASCII file listing
the date, time and location of the LSC installation.

The Log File also lists any errors that occurred during installation.  If an error
that prevents completion of the installation process occurs, the Log File
automatically displays.
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5. If LSC finds an existing Log File, you are asked if you want to overwrite the old
file.

 If you answer Yes to this prompt, the existing file is overwritten and the install
program continues.  If you answer No, you are prompted to enter a new Log File
name for this LSC installation.

After responding to this message, the Install Options dialog box displays.

6. Select one of the following install options, and then choose the OK button.

Basic Install - runs the install process with minimal user input;
automatically creates the Program Manager group McAfee (if not
found) containing the LSC program icon, LSC README file icon
and Crystal Reports icon.  Refer to the instructions on page 25.
Custom Install - allows you to choose specific install actions: install
LSC program files on the file server, serialize product executables,
create the McAfee Program Manager group and the program icons,
and install the Crystal Reports software.  Refer to the instructions on
page 27.
Upgrade - allows you to upgrade your existing LSC 2.02 software
and database files with minimal user input.  Refer to the instructions
on
page 29.
Conversion - allows you to convert additional LSC 2.02 database
files.  Refer to the instructions on page 31.

NOTE:
The Conversion option allows you to convert multiple LSC 2.02 database files.
Before choosing the Conversion option, the LSC 3.0 software must already have
been installed using the Basic, Custom or Upgrade install options.

Refer to the appropriate section in this chapter for procedures regarding the selected
option.

Basic Install Procedure
The Basic Install process automatically performs the following operations:

Installs the LSC software
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Installs the LSC license
Installs the Crystal Reports software into the LSC program directory
Creates a Program Manager group McAfee containing the following
program icons: LSC 3.00, LSC README, Crystal Reports

Continue with the following steps to complete the Basic Install procedure:

7. In the Enter Pathname dialog box, enter the full pathname to where the LSC
files should be copied and choose the OK button.

LSC will create the directory if it does not exist.  (LSC will only create one
subdirectory level.)

If LSC already exists in the specified directory, a prompt displays asking
whether or not you wish to replace the existing copy of LSC.  Choose the Yes
button to overwrite the existing files, or choose the No button to abort the
installation.

8. The install program prompts you for each LSC program diskette.  Place the
requested diskette in the floppy drive, and choose the OK button to continue.

9. In the Enter Serial Number dialog box, enter the serial number of your LSC
software and choose the OK button.

The serial number is the last 7 digits located on the label of your distribution
diskettes.

10. In the Enter Company Name dialog box, enter your Company Name and choose
the OK button.

The length of the Company Name must be between 1 and 20 characters.

11. In the Modification of WIN.INI dialog box, choose either the Yes or No button
to continue.
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Choosing the Yes button  - By choosing this button, your existing
local WIN.INI file is backed up as WIN.BDI.  In the [Extensions]
section of the new WIN.INI file, the following line is added:
rpt=CRW.exe ^.rpt

Choosing the No button  - By choosing this button, your existing
WIN.INI file is not modified.  The changes that need to be made to
the WIN.INI file (listed above) are saved in the file named
WIN.BDI.

12. Several messages display recommending that you modify your WIN.INI file (as
in step #11 above), check the LSC log file, and review the LSC README file.
Choose the OK button after reading each message.

To view the LSC log file, use any text-based program (e.g., Notepad).  To open
the README file, double click on the icon in the McAfee Program Manager
group.

Custom Install Procedure
The Custom Install process gives you the option to perform any of the following
operations:

Install the LSC software
Serialize the LSC product executables
Install the Crystal Reports software
Create a Program Manager group McAfee containing the following
program icons: LSC 3.00, LSC README, and Crystal Reports (if
installed)

Continue with the following steps to complete the Custom Install procedure:

7. In the Custom Install Options dialog box, select the desired install option(s), and
choose the OK button.

Place a checkmark next to the install options you want to perform.

The prompts which subsequently display depend on the install option(s) you
select here.
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8. In the Enter Pathname dialog box, enter the full pathname to the LSC program
directory and choose the OK button.

If you are installing the software for the first time, then specify the full
pathname to the directory in which the files should be copied.

If you have already installed the software and you are installing the license or
creating the Program Manager group at this time, then specify the full  pathname
to the directory in which the LSC files already exist.

LSC will create the directory if it does not exist.  (LSC will only create one
subdirectory level.)

If you have selected the “Install files to your desired drive” option and the LSC
files already exist in the specified directory, a prompt displays asking whether or
not you wish to replace the existing copy of LSC.  Choose the Yes button to
overwrite the existing files, or choose the No button to keep the existing files.

9. The install program prompts you for the LSC program diskettes.  Place the
requested diskette in the floppy drive, and choose the OK button to continue.

The disks you are prompted for depend on the install options you selected in
step #7 above.

10. In the Enter Serial Number dialog box, enter the serial number of your LSC
software and choose the OK button.

This prompt displays if you are installing the LSC software or the LSC license.

The serial number is the last 7 digits located on the label of your distribution
diskettes.

11. In the Enter Company Name dialog box, enter your Company Name and choose
the OK button.

This prompt displays if you are installing the LSC software or the LSC license.

The length of the Company Name must be between 1 and 20 characters.

12. In the Modification of WIN.INI dialog box, choose either the Yes or No button
to continue.

This prompt displays if you are installing the Crystal Reports software.

Choosing the Yes button  - By choosing this button, your existing
local WIN.INI file is backed up as WIN.BDI.  In the [Extensions]
section of the new WIN.INI file, the following line is added:
rpt=CRW.exe ^.rpt

Choosing the No button  - By choosing this button, your existing
WIN.INI file is not modified.  The changes that need to be made to
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the WIN.INI file (listed above) are saved in the file named
WIN.BDI.

13. Several messages display recommending that you modify your WIN.INI file (as
in step #12 above), check the LSC log file, and review the LSC README file.
Choose the OK button after reading each message.

To view the LSC log file, use any text-based program (e.g., Notepad).  To open
the README file, double click on the icon in the McAfee Program Manager
group.

Upgrade Procedure
The Upgrade option installs the new LSC software and converts the existing 2.02
data files into the new format.

NOTE:
Backup all existing LSC files before upgrading the LSC software.

The Upgrade from 2.02 install option automatically performs the following actions:

Installs the LSC 3.0 software
Converts the LSC 2.02 data files to the 3.0 format
Installs the LSC license
Creates a Program Manager group McAfee which contains the following
program icons: LSC 3.00, LSC README, Crystal Reports (if installed)

You are also given the option to install the Crystal Reports software into the LSC
program directory and to convert additional LSC 2.02 databases to the 3.0 format.

Continue with the following steps to complete the Upgrade procedure:

7. In the Upgrade Install Options dialog box, indicate whether you want to install
the Crystal Reports software.  Then choose the OK button.

Note that the Crystal Reports software can be installed at a later time using the
LSC Custom Install procedure.

8. In the Enter Pathname dialog box, enter the LSC 2.02 source directory and
choose the OK button.
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The source directory is the directory in which the existing LSC version 2.02
files exist.  Specify the full pathname.

9. In the subsequent Enter Pathname dialog box which displays, enter the
destination directory and choose the OK button.

The destination directory is the directory in which you want the new LSC 3.0
files to be copied.  Specify the full pathname.

If you entered your existing LSC 2.02 directory as the destination directory,
then a message displays informing you that the LSC 2.02 files will be
overwritten.  Choose the OK button to proceed with the upgrade, or choose the
Cancel button to specify another destination directory.

10. The install program prompts you for the LSC program diskettes.  Place the
requested diskette in the floppy drive, and choose the OK button to continue.

11. In the Enter Serial Number dialog box, enter the serial number of your LSC 3.0
software and choose the OK button.

The serial number is the last 7 digits located on the label of your distribution
diskettes.

12. In the Enter Company Name dialog box, enter your Company Name and choose
the OK button.

The length of the Company Name must be between 1 and 20 characters.

13. A message displays prompting you to convert the existing LSC 2.02 data files
into the LSC 3.0 format.  Choose the Convert button to convert the LSC 2.02
data files.

If you do not want to convert the data files at this time, choose the No button.
(You can later use the LSC Conversion option to convert the data files.)

Upon choosing the OK button, the conversion routine begins.

14. After the database files are successfully converted, a prompt displays asking if
you want to convert a subsequent 2.02 database.

To convert another database, choose the Yes button.

To exit the upgrade procedure, choose the No button.

15. If you answered Yes to the above prompt and wish to convert another database,
you are prompted to enter the source directory.

As in step #8 above, enter the full pathname to the directory in which the
additonal LSC version 2.02 database files exist.

You can continue to execute steps #14 and 15 for each LSC 2.02 database you
need to convert.
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16. In the Modification of WIN.INI dialog box, choose either the Yes or No button
to continue.

This prompt displays if you are installing the Crystal Reports software.

Choosing the Yes button  - By choosing this button, your existing
local WIN.INI file is backed up as WIN.BDI.  In the [Extensions]
section of the new WIN.INI file, the following line is added:
rpt=CRW.exe ^.rpt

Choosing the No button  - By choosing this button, your existing
WIN.INI file is not modified.  The changes that need to be made to
the WIN.INI file (listed above) are saved in the file named
WIN.BDI.

17. Several messages display recommending that you modify your WIN.INI file (as
in step #15 above), check the LSC log file, and review the LSC README file.
Choose the OK button after reading each message.

To view the LSC log file, use any text-based program (e.g., Notepad).  To open
the README file, double click on the icon in the McAfee Program Manager
group.

Conversion Procedure
The Conversion option gives you the opportunity to convert any additional LSC
2.02 data files into the new 3.0 format.  These converted database files are appended
to the data files in your LSC 3.0 program directory.

NOTE:
The LSC 3.0 software must be installed before choosing the Conversion option.
Use the Basic, Custom or Upgrade install option to first install the 3.0 software.

Continue with the following steps to complete the Conversion procedure:

7. In the Enter Pathname dialog box, enter the LSC 2.02 source directory and
choose the OK button.

The source directory is the directory in which the existing LSC version 2.02
database files exist.  Specify the full pathname.

8. In the subsequent Enter Pathname dialog box which displays, enter the
destination directory and choose the OK button.
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The destination directory is your LSC 3.0 program directory.  Specify the full
pathname.

Upon choosing the OK button, the conversion routine begins.

9. After the database files are successfully converted, a prompt displays asking if
you want to convert a subsequent 2.02 database.

To convert another database, choose the Yes button.

To exit the conversion routine, choose the No button.

10. If you answered Yes to the above prompt and wish to convert another database,
you are prompted to enter the source directory.

As in step #7 above, enter the full pathname to the directory in which the
additonal LSC version 2.02 database files exist.

You can continue to execute steps #7 through 10 for each LSC 2.02 database
you need to convert.

Upgrade Conversion Charts

The following charts list the database fields that are converted when upgrading from
LSC 2.x to LSC 3.0.  The windows or dialog boxes on which the LSC 3.0 fields
appear are listed in parenthesis beneath the LSC 3.0 file name.

LSC 2.x File:
ACCOUNT.DAT

LSC 3.0 File: HLPDSK1C.DAT
(Ticket window, Setup Account dialog box)

Account ⇒ Account

First Name ⇒ First Name

Last Name ⇒ Last Name

Voice Phone ⇒ Phone

Department ⇒ Department

NetNumber + NodeAddress ⇒ Network Address

LSC 3.0 File: HLPDSK1Z.DAT
(Contact Details and Setup Company
dialog boxes)
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Account ID ⇒ Company ID

Address 1 ⇒ Address 1

Address 2 ⇒ Address 2

City ⇒ City

State ⇒ State

Zip ⇒ Zip

Fax Phone ⇒ Fax #

Data Phone ⇒ Email

LSC 2.x File: CAT.DAT LSC 3.0 File: HLPDSK1G.DAT
(Ticket window, Qualification Lists
dialog box)

Category ID ⇒ Problem Type

Full Name ⇒ Product Category
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LSC 2.x File: DEPT.DAT LSC 3.0 File: HLPDSK1D.DAT
(Ticket window, Qualification Lists
dialog box)

Department ⇒ Department

LSC 2.x File:
PROBTYPE.DAT

LSC 3.0 File: HLPDSK1G.DAT
(Ticket window, Qualification Lists
dialog box)

“LSC 2.x” ⇒ Problem Type

Problem Type ⇒ Product Category

NOTE:
Since the Problem Type in LSC 2.x allows 30 characters, it will be converted to
Product Category in LSC 3.0.  These product category items will be the related
items for the problem type entry of “LSC 2.x”.

LSC 2.x File: CLASS.DAT LSC 3.0 File: HLPDSK1G.DAT
(Ticket window, Qualification Lists
dialog box)

Class ID ⇒ Problem Type

Full Name ⇒ Product Category

LSC 2.x File:
SUPPORT.DAT

LSC 3.0 File: HLPDSK1S.DAT
(Setup Staff dialog box)

Support Person (initialized) ⇒ Staff Initials

Support Person ⇒ Full Name

Password ⇒ Password

LSC 2.x File:
EXPERT.DAT

Trouble ⇒ New Ticket & Edit Ticket

Reports ⇒ Reports
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Administration ⇒ Setup Staff & Label Options & Qualification
List

NOTE:
The password in LSC 2.x will be truncated to the new length of 8 characters.
The conversion will determine staff initials for the Support Person.  The
corresponding rights for each support person will be retrieved from
EXPERT.DAT.

LSC 2.x File:
TICKET.DAT

LSC 3.0 File: HLPDSK1H.DAT
(Ticket window)

Account ⇒ Account

First Name ⇒ First Name

Last Name ⇒ Last Name

Phone ⇒ Phone

Department ⇒ Department

NetNumber + NodeAddress ⇒ Network Address

Problem Type ⇒ Product Category

Status ⇒ Opened or Closed

Opened by or Assigned To ⇒ Assigned To

Opened Date ⇒ Opened Date

Opened Time ⇒ Opened Time

Closed Date ⇒ Closed Date

Closed Time ⇒ Closed Time

NOTE:
If the Assigned to field in LSC 2.x is blank, then the Opened by field will be
converted to the Assigned to field in LSC 3.0.  The corresponding ticket number
in LSC 3.0 is a combination of the Assigned to initials, the Ticket Date, and the
Opened Time.  If the status is OPEN or ASSI, the status will be Opened in LSC
3.0.  If it is CLOS or INAC, the status will be Closed in LSC 3.0.

LSC 2.x File:
TNOTES.DAT

LSC 3.0 File: HLPDSK1P.DAT
(Ticket window)

Notes ⇒ Problem Description
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NOTE:
The Notes field on the ticket is converted to the problem description in LSC 3.0.

Uninstalling LSC
Use the following procedure to remove the LAN Support Center program.

1. Delete the LSC program directory.

All LSC executable files and data files will be erased.

NOTE:
To move LSC to another location (e.g., from one file server to another), use the
Windows File Manager utility to move the entire LSC program directory.  It is
highly recommended that you first backup the existing LSC program directory
before moving it to another location.

Installation Troubleshooting
If you receive any errors while installing or upgrading LSC, display the log file to
view the errors and possible solutions.  The errors are listed here for your reference.

A log file with the name LOGFILE was found. Do you wish to overwrite this file?
A prior version of the log file has been detected in your Windows directory.  Choose the Yes button to
overwrite the existing log file, or choose the No button to specify a new log file name.

Are you sure you want to CANCEL installation?
This message displays if you have chosen to cancel the installation.  You must verify the decision by
choosing either the Yes or No button.

Converting  LSC 2.02  databases requires LSC 3.00 files.  Setup could not find LSC 3.00
files in your specified directory.  Please choose other upgrade option instead.

You must already have installed the LSC 3.0 software in order to convert LSC 2.02 databases.  Choose
the OK button in response to this message.  Either choose another option to install the software, or
specify a valid source LSC 3.0 program directory.



Using LAN Support Center 37

DRIVELETTER is an invalid drive. Choose OK to choose another drive.
You have entered an invalid disk designation.  Correct the entry to continue.

Error calling DLL function.  This indicates that install was unable to find PROGLIB.DLL or
NETWARE.DRV didn’t load or wasn’t configured in your SYSTEM.INI file.

The install was unable to find a file necessary to continue the installation. Please confirm that your
Windows environment is configured to run with NetWare (NETx 3.22 or greater) and that your
Windows directory is not MAP ROOTed.  Also verify the following:
- The shells are loaded.
- The following line is included in your SYSTEM.INI file in the [386Enh] section:
network=*vnetbios, vnetware.386, vipx.386
- You have Write and Modify rights to your Windows directory.

Install did not find a copy of LSC 2.02 in DESIGNATEDPATH.  Please choose another path.
You have chosen to upgrade a previous copy of LSC; however, no copy exists in the designated
directory.  Choose the OK button in response to this message, and enter a valid LSC 3.0 pathname.

Install found another, possibly older, copy of LSC.  Would you want to upgrade this copy?
Install found an older copy of LSC.  Choose the Yes button to upgrade the existing LSC files.

Not enough space on DISK to install LSC.  Please choose OK to try another target disk.
There is not enough space on your target drive.  Either choose another drive or make room on the target
disk.

Please enter a company name with a minimum of 1 character and a maximum of 20
characters.

The length of the company name must be between 1 and 20 characters.

Serialization Error: Install encountered a fatal error attempting to serialize LSC.EXE.  Please
contact McAfee Technical Support at (908) 530-9650.

The install was unable to serialize the executable. LSC cannot be run unless the executable is serialized
properly.

The serial number you have entered is not valid. Please enter the last 7 digits of the serial
number and password as they appear on the original LSC diskette.

You have entered an invalid serial number.

The target location must be different than the source.  Please specify a different location.
When transferring files, the source and destination must be different.

There is not enough space on DISKDRIVE to perform a complete install of LAN Support
Center.  Choose Yes to continue installing LAN Support Center.  Choose No to cancel the
installation.

Install detected that there was not enough space on the designated disk drive to perform a complete
install.  Choose Yes to continue the installation if you are not transferring files or are copying over
existing files with the same name.
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This installation FAILED/ABORTED.  Please run Install again to be sure that LSC is installed
correctly.  Choose OK to exit Install and view the install log file.

If you received a FATAL ERROR or chose to abort the installation, you will receive this error and then
the log file will be displayed automatically.

Unable to copy or decompress file: FILENAME.  Make sure that you have permission to
write to the designated path and that you have included the drive letter.

The install program was unable to copy or decompress the designated file from the source diskette.
Verify your rights and try the installation again.

Unable to create specified path: PATH.   Please enter a correct path such as
SUBDIRECTORY.

The target path cannot be created.  Install can only create one layer of subdirectories.

Unable to create specified path: PATHNAME.  Please enter a correct path such as
SUGGESTEDPATHNAME.

The target path cannot be created. The install can only create one layer of subdirectories.

You have entered WRONGDISK. Install needs LAN Support Center Disk
#CORRECTDISKNUMBER.

You have put the wrong disk into the floppy drive.

Your entry is not a valid 7 digit number. If the serial number printed on your original disk is
LSC-300-XXXXXXX, please enter XXXXXXX as the serial number.

The serial number has been entered incorrectly.

Btrieve Configuration Options
LAN Support Center uses the Novell Btrieve Record Manager as its record manager.
Btrieve is integrated with NetWare and offers an extremely high performance
mechanism for storing information.  In addition, Btrieve is the basis for Novell’s
Network Management System (NMS), which allows McAfee to integrate with this
important management platform more easily.

There are two methods of implementing Btrieve:

Server-based - All data processing is done at the file server by the
Brequestor (the Btrieve NLM or VAP).  Each workstation communicates
with the NLM or VAP by loading BREQUEST.EXE  in the local PC’s
memory.
Brequest uses 31-45KB of RAM, depending on the options specified.
(Version 6.10 or greater is required when using Brequest with LSC.)  It



Using LAN Support Center 39

is much faster than the local Btrieve; however, it requires that the NLM
or VAP be loaded on the file server.
Client-based - Workstations perform all data processing locally.  Client-
based Btrieve is initialized automatically through the client-based
WBTRCALL.DLL file.

LAN Support Center is fully compatible with both methods of access.  It is highly
recommended that you use the server-based method, as this will improve the
performance of LSC’s database access by at least 50% and by as much as 500%.

NOTES:
a - General instructions for configuring the Btrieve NLM are provided in
Appendix D.  Refer to your Novell documentation for details on configuring
Btrieve.

b - When running the Brequestor, BSPXCOM must also be loaded.  Refer to
your Novell documentation for details on loading this program.

LSC and Btrieve

LSC is fully compatible with both Btrieve methods discussed in the above section.
LSC provides two batch files which configure the program to run with either server-
based or client-based Btrieve.  Upon installation, LSC is automatically configured to
run with server-based Btrieve (i.e., the Btrieve NLM or VAP).

If you are using local Btrieve instead of Brequest, then you must run the
USEBTR.BAT batch file before launching LSC.  This batch file renames several
files which instruct LSC to look for local Btrieve.

The USEBRQ.BAT batch file provided with LSC renames several files which
instruct LSC to look for Brequest.  (As mentioned above, this is the default
configuration upon LSC installation.)

NOTE:
If you are using local Btrieve, you must run the USEBTR.BAT file before
launching LSC.  If you use server-based Btrieve later, you must then run the
USEBRQ.BAT file before launching LSC.

Both batch files are copied into the LSC program directory upon installation.

USEBTR.BAT - The batch file which renames certain files and instructs
LSC to look for local Btrieve.
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USEBRQ.BAT - The batch file which renames certain files and instructs
LSC to look for Brequest.

NOTE:
The LSC batch files only need to be run when you have changed the Btrieve
method being used.  They do not need to be run each time you launch LSC.

This ends the chapter on LAN Support Center installation and configuration.  Refer
to the next chapter for instructions on getting started with LSC.
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Chapter 3  Getting Started

Chapter 2 provided you with LSC installation and upgrade instructions.  This
chapter introduces LAN Support Center and presents a tutorial for the first-time LSC
user.

Introduction

What’s in this Chapter

The following chart describes the sections in this chapter:

SECTION DESCRIPTION

Planning Your LSC
Database

Discusses the importance of planning the labels in your
LSC database before using the LSC program.

The LSC Application
Window

Provides instructions on entering and exiting LSC,
selecting commands from the menu bar, using the tool
bar as an alternative to the menu bar, and using LSC’s
on-line help facility.

Tutorial Describes the tasks associated with LSC’s main
features: tailoring the database labels, defining the
qualification lists, creating tickets, viewing the ticket
database, and generating reports.
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Planning Your LSC Database
LSC’s flexibility allows you to tailor the database to completely satisfy your
requirements.  LSC can be used in either an enterprise environment or internally
within a company.  For example, an enterprise environment may have clientele for
which they need to track support requests.  Using LSC internally may facilitate a
company’s management of any number of events: scheduled installations and
upgrades, problem reporting, and even employee training classes.

The software is installed with a default database labeling scheme.  Before you begin
using LAN Support Center, you should take the time to review the default labels and
determine whether or not they apply to your environment.  The database label names
should reflect the event(s) you intend to track.

The following examples illustrate how companies can tailor the LSC database labels
for their individual purposes:

An insurance company uses LSC to track insurance claims.  They have
changed the default ‘Department’ field label to ‘Policy Number.’  The
‘Issue Type’ field is used to reflect the type of insurance held by the
insured.  The ‘Problem Type’ and ‘Product Category’ fields are used to
track the types of claims being made.  The ‘Cross Reference’ field is
used to maintain the insured’s policy number for cross-referencing
purposes.
A software development company uses LSC to track new features to be
incorporated into their product upgrades.  They have changed the default
‘First Name’ field label to ‘Product Name,’ and the ‘Last Name’ field
label to ‘Version Number.’  The ‘Problem Type’ and ‘Product Category’
field labels are changed to ‘Feature’ and ‘Module’ to track the new
feature request and the module which must be modified.  The ‘Assigned
to’ field is used to indicate the programmer responsible for the new
feature.  The ‘Priority’ field reflects the urgency of the new feature.
A manufacturing company uses LSC to track customer support calls .
The ‘Account ID’ field is used to track the companies from which calls
are being received.  The ‘First Name,’ ‘Last Name’ and ‘Phone’ fields
are used to track data regarding the contact person for the account.  The
‘Priority’ field is used to reflect the urgency of the support call.  (The
URGENT priority displays in red in the View Tickets window so the
staff determine quickly which tickets must be handled first.)
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Defining the labels in your LSC database is an easy task.  The entire database
labeling scheme is defined in one straight-forward and intuitive dialog box.  The
steps for defining the LSC database are discussed in Chapter 5, “Setup and
Administration.”

The LSC Application Window
This section will familiarize you with the LSC application window.  In addition to
providing instructions for launching and exiting LSC, it also discusses the menu bar,
tool bar, and help facility.

Windows Terms

LAN Support Center should be used with a mouse.  Several Windows terms
regarding the use of the mouse are briefly defined below:

TERM DESCRIPTION

Cancel Button Choosing the Cancel button exits the current dialog box
without saving any changes you made in this dialog box or
executing a command you selected in this dialog box.

Choose Click the left mouse button on an item to initiate an action.
The item can be a menu, a command or a button.  For
example, “Choose the Administration menu.”

Click Press the left mouse button once.

Double click Press the left mouse button twice in quick succession.

Icon A graphic representation of a Windows object.  The object
can be a program or a minimized window.

Point Position the mouse with the tip of the screen pointer resting
on the desired item.

Scroll Use the scroll bars and buttons to move through a list of
items.

Select Mark or highlight an item by either clicking on it with the
mouse or using key combinations.  For example, “Select a
ticket in the View Tickets window.”
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NOTE:
The remainder of this manual assumes that you are familiar with Windows.
Refer to your Microsoft Windows manual for information on the fundamental
operating conventions of the Windows environment.

Launching LSC

After successfully installing LAN Support Center, a McAfee group and an LSC
program icon are created on your Windows desktop.
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Use the following procedure to launch LSC.

1. If you are using LSC on a network, load the Novell Btrieve record manager.

Ignore this step if you are using LSC in a stand-alone environment.

Either server-based or client-based Btrieve can be used with LSC.  Server-based
Btrieve is strongly recommended due to its increased database access speed.  If
you are running server-based Btrieve, proceed to the next step.

NOTE:
Upon installation, LSC is configured to run with Brequest.  If you are running
client-based Btrieve, LSC will automatically load the local Btrieve for you;
however, you must configure the LSC files to run with local Btrieve.  To do this,
you must run the USEBTR.BAT file in the LSC program directory before
launching LSC.  For example, from within the LSC program directory, enter
the following command: USEBTR.

Refer to “Btrieve Configuration Options” in Chapter 2 for details on the batch
files provided with LSC.

2. Run Windows, and double click on the LSC program icon.

The LSC program icon is shown in Figure 3-1.

Figure 3-1: LSC Program Icon

If you are using Novell’s local Btrieve, a message displays recommending that
you use Brequest for increased database access speed.  This message will
display when LSC cannot detect Brequest.  It will also display when LSC is
configured to run with client-based Btrieve (i.e., by running the USEBTR.BAT
file). To disable the warning message under all circumstances, place a
checkmark in the “Disable warning message when Brequest isn’t running” field
in the message window.  (To re-enable the warning message, the LSC.INI file
must be edited.  Refer to page 50 for more information on the LSC.INI file
parameters.)
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Choose the OK button to continue the LSC program launch.  The LSC Login
dialog box displays, as in Figure 3-2.

Figure 3-2: Logging in to LSC

3. Enter your login initials and password, and choose the OK button.

After entering your login initials, press the <TAB> key to move the cursor to the
Password field.  Then enter your LSC password.

NOTE:
The default LSC login initials and password are LSC and LSC.  Changing the
default password or changing the rights given to the default login is highly
recommended.  The procedures for defining Staff Membership and Security
begin on .

Upon choosing the OK button in the LSC Login dialog box, the LAN Support
Center application window displays, as in Figure 3-3.

Figure 3-3: The LSC Application Window

NOTE:
If previously you have launched LSC and saved the monitor configuration upon
exiting, there may be open ticket windows in your LSC application window.
Refer to the following section entitled “Exiting LSC.”

The application window consists of the following items which are discussed in
this section:

The LSC menu bar
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The LSC tool bar
Access to the LSC on-line help facility

Exiting LSC

Use the following procedure to end an LSC session.

1. Choose the Exit command from the File menu.

A dialog box displays prompting you to confirm the exit action, as shown in
Figure 3-4.

Figure 3-4: The LSC Exit Prompt

2. To save your monitor configuration, check the ‘Save monitor configuration’
option.

Checking this option will save the configuration of any windows that are
currently open in your LSC application window.  All open windows will be
automatically restored upon starting your next LSC session.  For example, if the
View Tickets window and three additional Ticket windows are open when you
exit LSC and enable this option, then all four windows will be opened the next
time you launch LSC.

NOTE:
The column widths in LSC’s View Tickets window can be modified.  Any
modified column widths are saved upon exiting LSC regardless of your
response to this exit prompt.

3. Choose the OK button to close the LSC application.

LSC Menu Bar

The LSC menu bar consists of the menu items shown in Figure 3-5.  To choose a
menu, point to the menu name and click the left mouse button.
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 Figure 3-5: LSC Menu Bar

The general purpose of each menu item is defined below:

File Menu - Lists commands for printing reports, configuring global
print settings and exiting LSC.
Edit Menu - Lists standard editing commands for use when creating and
editing tickets.
Administration Menu  - Lists commands for setting up and maintaining
the LSC environment.  This includes staff setup and security, account
setup, company setup, database labeling and administration, qualification
list administration, custom view definitions and archiving/restoring
tickets.
View Menu - Lists commands for selecting and managing the ticket
display of the View Tickets window.
Ticket Menu - Lists commands for creating and managing tickets and
their supporting information, as well as provides access to other McAfee
LAN management products.
Reports Menu - Provides access to pre-defined and custom LSC
reports.
Window - Lists commands for arranging the open windows in the LSC
application area.  (This menu only displays when there are open
windows in the LSC application area.)
Help Menu - Lists commands for accessing LSC’s on -line Windows
hypertext help facility.

NOTE:
Holding down the left mouse button over a menu command causes the function
of the command to display in the LSC title bar at the top of your screen.

LSC Tool Bar

LSC’s tool bar buttons provide an alternative for accessing the most frequently used
LSC functions.  The tool bar is shown in Figure 3-6.

Figure 3-6: LSC Tool Bar
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Instead of choosing commands from the drop-down menus, you can choose the tool
bar buttons to perform the same tasks.  For example, to create a new ticket, you can
either choose the New Ticket command from the Ticket menu or you can choose the
New tool bar button.  Both actions display a new Ticket window.

The function of each tool bar button is described below:

View - Displays the View Tickets window which allows you to view a
list of related tickets and their corresponding actions.
Filter -  Displays the Filter Ticket List dialog box which enables you to
specify criteria of the tickets to be listed in the View Tickets window.
Sort - Displays the Select Sort Criteria dialog box in which you can
define the sort order of the tickets listed in the View Tickets window.
Refresh - Updates the display in the View Tickets window.
New - Displays a new Ticket window in which ticket information is
entered and maintained.
Edit - Displays the Ticket window associated with the highlighted ticket
in the View Tickets window.
Delete - Deletes the ticket data associated with the active ticket or a
highlighted ticket in the View Tickets window.
Print - Prints the ticket data associated with the active ticket or a
highlighted ticket in the View Tickets window.
Contact - Displays the Contact Details dialog box associated with the
active ticket or a highlighted ticket in the View Tickets window.
Previous - Displays the Ticket window of the previous ticket listed in
the View Tickets window.
Next - Displays the Ticket window of the next ticket listed in the View
Tickets window.
Investigate - Displays the Smart-Launch McAfee Applications dialog
box which provides access to other McAfee network management tools.
Action - Displays the Add Action dialog box for entering an action entry
to be associated with the active ticket or a highlighted ticket in the View
Tickets window.
Edit - Displays the Edit Action dialog box associated with the
highlighted action entry in the View Tickets window.
Delete - Deletes the highlighted action entry in the View Tickets
window.
Report - Provides access to the LSC reporting module.



50 Using LAN Support Center

Using the Keyboard

LSC can be used with or without a mouse pointing device.  To use LSC without a
mouse, perform the following standard Windows keyboard actions to navigate
throughout the program.

Each menu item on the LSC menu bar has a keyboard mnemonic.  To
choose a menu, press the <ALT> key in combination with the underlined
letter key.  For example, press the <ALT><F> keys to choose the File
menu and display its commands.
Each command also has a keyboard mnemonic.  Once the menu is
displayed (i.e., “dropped down”), press the underlined letter of the
command you want to choose.  For example, from the File menu, press
<R> to choose the Print Setup command and display the Print Setup
dialog box.  Once a menu is displayed, you can also use the <up/down
arrow> keys to move the highlight to a desired command and then press
<ENTER> to select the command.

All keyboard mnemonics for use with LSC are listed on the Quick Reference Card
included in your LSC product package.

Help Facility

LSC’s Help facility provides on-line assistance for using the LSC software.  To get
information quickly about an LSC feature or procedure, choose the Index command
from the Help menu.

Choosing the Index command displays an index list of topics.  Choose the topic for
which you require assistance.

LSC’s Help window is written in a standard Windows hypertext format.  This means
that you can jump from one topic to another simply by choosing topic names from a
list.  Several buttons display across the top of the Help window, which allow you to
both search for topics and view a list of the topics you have visited.

For detailed information on using a Windows Help facility, refer to your Windows
documentation.

LSC.INI File

When the LAN Support Center software is installed, the LSC.INI file is created and
placed in the Windows directory of the local workstation.  Each time the program is
launched, the LSC.INI file is referenced for initialization and status information.
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The file can consist of the following sections:

[ShowBrequestWarning]  - This section indicates the status of the
Brequest warning message which displays upon launching LSC when
LSC does not detect the presence of the Btrieve NLM or VAP .  This
section contains an ‘Init=‘ line which indicates whether or not the
warning is disabled (i.e., ‘Init=No’ when warning is disabled; ‘Init=Yes’
when warning is enabled).
The warning message can be disabled by checking the “Disable message
when Brequest isn’t running” field in the message window which
displays when launching LSC.  The only way to re-enable the warning
message after it has been disabled is to edit the LSC.INI file and enter
‘Init=Yes’ in this section.
[ColumnWidth]  - This section lists the widths of all columns in the
View Tickets window.  Column numbers 1 to 11 represent the columns
of the ticket list area in the window.  Column numbers B1 to B6
represent the columns in the action list area of the window.  Column
widths can be changed either by modifying these numbers manually in
the INI file or by using the mouse to drag the column separator line
directly in the View Tickets window.  (A column width of 0 indicates
that the column is hidden.)
[ShowBanner] - This section can be added manually to the INI file in
order to disable the About LAN Support Center dialog box, which
displays upon launching LSC.  To disable the About dialog box at start-
up time, enter the following:
[ShowBanner]
Init=No

[TicketScr_#] - There can be any number of these sections which
indicate the parameters and status of any open LSC windows upon
exiting the program.  Ticket window number, field contents and position
are indicated.  (The “Ticket Number = -1” entry indicates the parameters
of the View Tickets window.)

NOTE:
To restore the default LSC.INI parameters, delete the LSC.INI file and re-
launch the program.  The LSC.INI file is re-created with its default settings.
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Tutorial
This tutorial provides a general overview on the use of LSC.  It assumes that the
Blue Ribbon company uses LSC to track and maintain incoming support calls
received from their customers.  Blue Ribbon is a supplier of computer hardware.

The steps in this tutorial include the following:

1. Customizing the database labels to satisfy Blue Ribbon’s help desk
requirements.

2. Setting up accounts.
3. Defining the qualification list entries to facilitate consistency in the way

the support staff enters ticket data.
4. Creating tickets to track incoming support calls.
5. Viewing the ticket database.
6. Generating reports which keep Blue Ribbon’s management informed.

NOTES:
a - LSC must be installed before beginning the tutorial.  If you have not
already done so, please refer to Chapter 2 for installation instructions.

b - For instructions on launching LSC, please refer to page 44 in this chapter.

c - All LSC options and features mentioned in the tutorial are discussed in
detail in the subsequent chapters of this manual.

Customizing the Database

Blue Ribbon has thoroughly reviewed their support environment.  They have
determined that several default LSC database labels should be changed in order to
track required information and optimize the support provided to their customers.

Use the following procedure to modify the default LSC database labeling scheme.
(The procedure is discussed in “Database Labeling” in Chapter 5.)

1. Choose the Label Options command from the Administration menu.
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The Label Options dialog box displays, as in Figure 3-7.  This dialog box
shows the current labels for each field in the LSC ticket database.

Figure 3-7: Modifying the Database Labels

2. Customize the labels.

To change a label name, move the typing cursor into a field, delete the existing
label and then type the new label name.

Blue Ribbon wants the label changes that are listed in the table below.  Replace
the old labels with the desired new labels.

Old Label New Label

First Name Acct #

Department Company

Cross Reference PO Number

NOTE:
Press the <TAB> key to move the cursor quickly from field to field in the Label
Options dialog box.

3. Choose the OK button to save the label changes.
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The Label Options dialog box closes.  All Ticket windows will now reflect the
new labels.

Setting Up Accounts

LSC accounts can be defined to identify companies, persons or events for which
tickets are created.  Each account is assigned an ID.  Account IDs provide a means
of categorizing tickets.  They also simplify data entry because information related to
an existing account ID you selected from the drop-down list in the Ticket window is
automatically entered.

The Blue Ribbon company wants to set up an LSC account for their customers who
require support.

Use the following procedure to add a new LSC account for Blue Ribbon.  (The
procedure is discussed in “Accounts IDs” in Chapter 5.)

1. Choose the Setup Account command from the Administration menu.

The Setup Account dialog box displays, listing all accounts, as in Figure 3-8.

Figure 3-8: Setting Up Account IDs

2. To add a new account, choose the Add button.



Using LAN Support Center 55

The Add Account dialog box displays, as in Figure 3-9.

Figure 3-9: Defining Account ID Information

NOTE:
The field names in this dialog box reflect the currently assigned labels.  For
example, the previous section of this tutorial listed steps for modifying the
default labels (e.g., “First Name” was changed to “Acct #”).

3. Enter the account information for the Blue Ribbon customer named
COMPUTERS, ETC in the appropriate fields.

Enter the following information for the new LSC account:

Field Entry Description

Account ID Computers,
Etc.

This is the unique code or name to identify the
new account.  A maximum of 55 characters can
be entered.  This is the only required field in the
Add Account dialog box.

Acct # 0001 This is the account number for the customer.  A
maximum of 20 characters can be entered.
(Note that this was the default First Name field.)

Last Name Smith This is the last name of the person assigned to
the account.  A maximum of 20 characters can
be entered.

Continued...
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Field Entry Description

Phone 516-999-1212 This is the phone number of the person assigned
to the account.  A maximum of 27 digits can be
entered.

Company
ID

COMP This is the unique code or name which identifies
the contact details to be attached to all tickets
that are assigned the account ID.  A maximum of
40 characters can be entered.

NOTES:
a - Entering a Company ID in the Add Account dialog box links the account
data to the company data.  Each time the account ID is entered in a Ticket
window, all related company data is automatically entered in the ticket’s
Contact Details dialog box. Refer to the procedures in “Company IDs” in
Chapter 5 for setting up Company IDs.

b - The Company and Network fields are left blank for the purposes of this
tutorial.

4. Choose the Save button.

The Add Account dialog box closes, and the “Computers, Etc.” account ID is
listed in the Setup Account dialog box.

5. Repeat steps 2-4 to add another account for the Blue Ribbon company.

Enter the following information for Blue Ribbon’s “Paper Supply Company”
account:

Field Entry

Account ID Paper Supply

Acct # 0002

Last Name McGee

Phone 333-555-5544

Company ID Paper Supply
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Defining Qualification List Entries

LSC’s “qualification lists” act as reference lists to make data entry easier and also
maintain consistency within the data files.  Selecting an item from a drop-down list
eliminates the time required to type the entry and ensures that only the intended
entries are included in the list.  The level of detail entered in the LSC qualification
lists affects how well you can monitor and track your support efforts.

Blue Ribbon has decided that they want their support staff to select a Problem Type
from a pre-defined list instead of manually typing in a new Problem Type for each
new ticket.

NOTE:
The procedure below provides instructions for defining entries in the Problem
Type qualification list.  To prohibit a user from adding entries to a qualification
list, define the appropriate security rights for the user.  Refer to “Staff
Membership and Security” in Chapter 5 for instructions on defining staff
membership and security.

Use the following procedure to define several entries for Blue Ribbon’s Problem
Type qualification list.  (The procedure is discussed in “Qualification Lists” in
Chapter 5.)

1. Choose the Qualification Lists command from the Administration menu.

The Qualification Lists dialog box displays, as in Figure 3-10.

Figure 3-10: Displaying the Qualification List Names
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2. Select the Problem Type database from the drop-down list associated with the
Name of List field.

Choose the down arrow button next to the Name of List field to view all
qualification list names, and click on Problem Type.  When a qualification list is
selected, all items defined for that list display in the List Items area.  (If you
have not yet defined any Problem Type entries, then the List Items area will
remain empty.)

Figure 3-11 shows the Qualification List dialog box after the Problem Type list
is chosen.  Notice that items for the Problem Type qualification list can be
assigned sub-categories (called “Product Categories”).  For example, a
SOFTWARE Problem Type might have several related Product Categories,
including SPREADSHEETS and WORD PROCESSORS.

Figure 3-11: Choosing the Problem Type List

3. Define a Problem Type item by choosing the Add button to the right of the List
Items area.

The Add Item dialog box displays prompting you to specify the name of the
new item.

4. In the Add Item dialog box, type the new item name PRINTER and choose the
OK button.

The ‘PRINTER’ item is added to the List Items area and defined as a Problem
Type.
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5. Define sub-categories for the PRINTER item by choosing the Add button to the
right of the Related Product Category area.

An Add Related Item dialog box displays prompting you to specify the name of
the new sub-category.

6. In the Add Related Item dialog box, type the new item name TONER and
choose the OK button.

7. Repeat steps 3-6 to add the following Problem Types and related sub-categories
for the Blue Ribbon company.

Before defining a sub-category, first highlight the item to which the sub-
category should be related.  For example, highlight the MODEM item in the List
Items area, and then add the related items 1200 BAUD, 9600 BAUD and
INTERNAL.

Problem Types Related
Categories

Drive Floppy A

Hard Drive

Modem 1200 Baud

9600 Baud

Internal

Printer Cartridge

Drum

Toner

 8. Choose the Close button to close the Qualification Lists dialog box.

Creating Tickets

Information related to every support request that is received by Blue Ribbon is
entered as a “ticket.”  Once created, a ticket is considered “opened” and can be
assigned to a specific support staff member who is responsible for handling the
ticket.  All follow-up activity performed regarding the ticket is logged as ticket
“action.”  LSC’s ticket tracking capabilities enable Blue Ribbon to increase support
response time, identify recurring support issues and monitor all incoming requests
for support.
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Use the following procedure to create a new ticket and enter action details.  (The
procedure is discussed in “Creating Tickets” in Chapter 6.)

1. Choose the New Ticket command from the Ticket menu, or choose the New tool
bar button.

The Ticket window displays, as in Figure 3-12.  A ticket number is
automatically assigned by LSC.  It is indicated in the title bar of the Ticket
window and represents the LSC login user initials, year, month, day, hour,
minute, and second of the ticket’s creation.

Figure 3-12: A New Ticket Window

The ticket is automatically assigned to the staff member who logged in to LSC
(i.e., ‘Assigned to: LSC’ in Figure 3-12).  The ticket is automatically assigned
an ‘Urgent’ priority and its status is ‘Opened’ on the current date and time (i.e.,
the current system date and time).

2. From the Account ID field’s drop-down list, choose PAPER SUPPLY.

To display the drop-down list, click on the down arrow button associated with
the Account ID field.

Notice that when PAPER SUPPLY is selected, all related information
previously entered for the Paper Supply account is automatically entered in the
Ticket window fields.  For detailed information on the Ticket window fields,
refer to “Creating Tickets” in Chapter 6.

3. Specify additional information for this ticket.
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Enter the following information:

Field Entry

Priority Desired

Problem Type Printer

Product Category Cartridge

PO Number 123456

Problem Description Wrong model

After you enter this information, your Ticket window should look similar to
Figure 3-13.

Figure 3-13: A Completed Ticket Window

4. Choose the Add Action button in the Ticket window to enter activity performed
for this ticket.
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The Add Action dialog box displays, as in Figure 3-14.

Figure 3-14: Adding Ticket Action

5. Enter the action details.

Each field in the Add Action dialog box is defined and discussed in detail in the
table in “Maintaining Ticket Information” in Chapter 6. Enter the following
information regarding the initial action performed for this ticket:

Field Entry

Action Code TO_DO

Description Send cartridge model #2400.

Time Spent 00:10

Initial Response Yes

Note that the entry for the Action Code field can be selected from a drop-down
list.
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After you enter the action information, your Add Action dialog box should look
similar to Figure 3-15.

Figure 3-15: A Completed Ticket Action Dialog Box

6. Choose the Save button in the Add Action dialog box to save the action
information.

The Add Action dialog box closes.

7. Choose the Save button in the Ticket window to save the ticket.

The Ticket window closes.

8. For the purpose of the remaining tutorial steps, enter a second and third ticket
having the following information:

Ticket #2:

Field Entry

Account ID Paper Supply

Account # 0002

Last Name McGee

Phone 333-555-5544

Priority Urgent

Problem Type Modem

Product Category 1200 Baud

PO Number 15647
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Problem Description Modem not responding

Notice that LSC automatically completes many of the ticket fields based on the
selected Account ID.

Ticket #3:

Field Entry

Account ID Computers, Etc.

Account # 0001

Last Name Mitchell

Phone 516-999-3434

Priority Urgent

Problem Type Printer

Product Category Cartridge

PO Number 98765

Problem Description Needs instructions on
adding toner.

Notice that in ticket #3 the information for the Computers, Etc. account has
changed.  The Last Name entry changed from Smith to Mitchell, and the
account’s Phone Number changed.  Because the account information was
modified, when you try to save the ticket, a message displays asking if you want
to update the account information.  Responding Yes to this message will cause
all future tickets to reflect the new information.  Responding No to this message
will save the modified data with this ticket only and not affect any other tickets
assigned to the account.  For the purpose of this tutorial, choose the No button.

Viewing the Ticket Database

LSC’s View Tickets window lets the Blue Ribbon staff members view detailed ticket
data at a glance.  As discussed in “The View Tickets Window” in Chapter 4, the
information that displays in the View Tickets window can be customized.  Blue
Ribbon is interested in viewing only those tickets that are assigned an ‘Urgent’
priority.
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Use the following procedure to display the View Tickets window and define filter
criteria.

1. Choose the View tool bar button to display the View Tickets window.

The View Tickets window displays, listing all tickets in your current ticket
database.  Your View Tickets window should look similar to Figure 3-16.  Note
that, by default, the tickets are listed in ascending ticket number order. Also, the
URGENT ticket priorities and the TO_DO actions display in red for easy
identification.

Figure 3-16: The View Tickets Window List

2. To filter the tickets that display in the View Tickets window, choose the Filter
tool bar button.

You can also choose the Filter command from the View menu.  The Filter
Ticket List dialog box displays, as in Figure 3-17.

Figure 3-17: Filtering the View Ticket Window

3. Define the filter criteria so that only the ‘Urgent’ priority tickets will display in
the View Tickets window.
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Many of the fields in the Filter Ticket List dialog box are identical to the fields
in the Ticket window.

Blue Ribbon is interested in viewing only those tickets that are assigned an
‘Urgent’ priority.  Therefore, check only the URGENT Priority option.  (The
Priority check boxes toggle when selected.  If an item has an ‘x’ in its check
box, then select the item again to remove the ‘x’ and de-select the item.)

4. Choose the OK button.

The ticket information is filtered, and only those tickets that match the defined
criteria will display in the View Tickets window (i.e., only the tickets that have
an ‘Urgent’ priority).

Generating Reports

LSC provides pre-defined reports which accumulate and present ticket data in an
intuitive format.  These reports represent reports frequently requested by support
management and staff members.  The pre-defined reports can be customized to
accommodate individual reporting requirements.  In addition, LSC includes the
Crystal Reports software to be used for creating new reports for incorporation into
LSC.  Reporting is discussed in detail in Chapter 8 of this manual.

Blue Ribbon is interested in tracking the type of problems their customers are
experiencing.  The pre-defined “All Tickets by Problem Type” report provides Blue
Ribbon with the information needed to identify the frequency and reason for each
Problem Type.  Blue Ribbon can use this information to eliminate the problem.  For
example, if the PRINTER problem type occurs frequently, then perhaps the type of
printers being distributed by Blue Ribbon are faulty, or perhaps the customers need
more training on printer installation.

Use the following procedure to generate the “All Tickets by Problem Type” report.

1. Choose the Reports tool bar button.
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You can also choose the Choose Reports command from the Reports menu.
The Choose Report dialog box displays, as in Figure 3-18.

Figure 3-18: Choosing a Report to Generate

2. Select the “All Tickets by Problem Type” report.

3. In the Destination area of the Choose Report dialog box, select the Screen
option.

Selecting this option sends the report to a window on your screen.

4. Choose the OK button to generate the report.

The All Tickets by Problem Type report displays in a window generated by
Crystal Reports.

Your report window should look similar to Figure 3-19.  The buttons at the top
of the window from left to right can be chosen for page scroll to first page,
previous page, next page, last page, stop scroll, page magnification and
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route report to printer.  (For detailed instructions on using the Crystal Reports
software, refer to Part Two of this manual.)

Figure 3-19: A Report Window

5. Close the report window by double clicking on the system menu button.

The system menu button is shaped like a hyphen ( - ) and is located in the upper
left corner of the report window, as shown in Figure 3-19.

This ends the LSC tutorial.  There are many other features and capabilities that were
not covered.  Please refer to Part One of this manual to become familiar with the
LSC features.
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Chapter  4  Ticket Data Display

Chapter 3 provided an introduction to LAN Support Center.  This chapter provides
an overview of the various windows which display the ticket data maintained by
LSC.

Introduction
The following windows display the ticket information maintained by LAN Support
Center:

The View Tickets window  offers a general view of the tickets in the
LSC database.  Each LSC user can customize the information displayed
in this window in order to meet his or her ticket viewing requirements.
The Ticket window  displays the details of an individual ticket.  New
tickets are created and existing ticket information is edited and
maintained from within this window.

The View Tickets window and the Ticket window are introduced and discussed in
detail in this chapter.

What’s in this Chapter

The following chart describes the sections in this chapter:

SECTION DESCRIPTION

The View Tickets
Window

Provides an overview of the View Tickets window.
Discusses the window layout, scrolling procedures and
modifying the window contents.
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The Ticket
Window

Provides an overview of the Ticket window.  Discusses the
ticket numbering scheme, modifying the field labels, viewing
multiple Ticket windows and associated ticket information.

The View Tickets Window
The View Tickets window provides access to an entire database of tickets.  The
View Tickets window is displayed in any of the following ways:

Choose the View tool bar button to display a list of the open/active
tickets in your LSC database.
Choose the Current Tickets command from the View menu to display a
list of the open/active tickets in your LSC database.
Choose the Historical Tickets command from the View menu to display
a list of tickets that have been archived into an historical database file.

As illustrated in Figure 4-1, ticket information and related ticket actions can be
viewed at a glance.

Figure 4-1: Viewing a List of Tickets

View Tickets Window Layout

There are two list boxes in the View Tickets window.

Ticket List - The upper area of this window lists the tickets in the LSC
database.  Double clicking on a ticket item displays the Ticket window in
which the ticket’s information can be modified.
The information displayed in this list can be modified in the following
ways:
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- Define filter criteria to list only the tickets that match the filter
criteria.  For example, choose the Filter tool bar button and check
only the Urgent priority to view only those tickets that have been
categorized as Urgent.   Refer to “Filtering the View Tickets
Window Display” in Chapter 7 for detailed instructions.

- Define another sort method to list the tickets according to the new
sort criteria.  For example, choose the Sort tool bar button and
select Last Name as the primary sort method to view all tickets
ordered alphabetically according to the tickets’ Last Name field.
Refer to “Sorting the View Tickets Window Display” in Chapter 7
for detailed instructions.

- View a group of tickets in an historical database.   Choose the
Historical Tickets command from the View menu to access a list of
tickets that have been archived.  Refer to “Ticket Databases” in
Chapter 7 for detailed instructions.

- Resize the columns to modify their width.   By positioning the mouse
pointer directly over a column separator line, the mouse cursor
changes to a double-sided arrow.  Holding down the left mouse
button and moving the mouse to the left or right will decrease or
increase the column size.  If a user does not require a certain column
of information, then the column can be completely hidden using this
procedure.  The modified column widths are saved even when you
exit LSC!

Action List - The lower area of this window lists the actions associated
with the ticket that is highlighted in the ticket list described above.
Double clicking on an action item displays the Edit Action dialog box in
which the action details can be modified.

Scrolling Within the View Tickets Window

Horizontal and vertical scroll bars are available in both areas of the View Tickets
window.  Both areas of the window contain scroll bar buttons.  The Ticket List area
contains up/down scroll bar buttons which allow you to scroll through the ticket list,
as shown in Figure 4-2.  The Action List area contains left/right scroll bar buttons
and a thumb button, all which allow you to view the action information.
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Figure 4-2: Standard Scroll Bars
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To facilitate movement within a large number of tickets, the Ticket List area
provides additional vertical scroll bar buttons, as shown in Figure 4-3.

       
scroll up

        
scroll down

Figure 4-3: Large List Handlers

Choose the top scroll up button to display the beginning of the tic ket list.
Choose the bottom scroll down button to display the end of the ticket list.
Choose the lower scroll up button to page up through the ticket list (i.e.,
move up several tickets as opposed to one ticket item at a time).
Choose the top scroll down button to page down through the ticket list.

The Ticket Window
The Ticket window is used for creating or editing a ticket.  The information in the
Ticket window is specific to the ticket being created or edited.  The Ticket window
is displayed in any of the following ways:

Choose the New Ticket tool bar button to enter new ticket data.
Choose the New Ticket command from the Ticket menu to enter new
ticket data.
Highlight a ticket in the View Tickets window, and choose the Edit
Ticket tool bar button to edit the ticket’s existing data.
Highlight a ticket in the View Tickets window, and choose the Edit
Ticket command from the Ticket menu to edit the ticket’s existing data.
Double click on a ticket in the View Tickets window to edit the ticket’s
existing data.

As illustrated in Figure 4-4, a Ticket window contains the fields regarding a specific
“event” (e.g., a support call).



74 Using LAN Support Center

Figure 4-4: The Ticket Window

The Ticket Numbering Scheme

When a new ticket is created, LSC automatically assigns a number to the ticket.  The
ticket number displays in the title bar of the Ticket window and cannot be modified
by the LSC user.

The ticket number is generated in the format IIIYYMMDDHHMMSS, which is
determined by the following information:

III =  The LSC login staff initials of the user who created the ticket.  This
can be up to three characters.

YY = The year in which the ticket was created.
MM = The month in which the ticket was created (from 01 to 12).
DD = The day in which the ticket was created (from 01 to 31).
HH = The hour in which the ticket was created (from 00 to 23).
MM = The minute in which the ticket was created (from 00 to 59).
SS = The second in which the ticket was created (from 00 to 59).

For example, the ticket number in Figure 4-4 is KEL931221143151 which indicates
that the ticket was created on December 21, 1993 at 2:31:51 in the afternoon by the
staff member who has the initials KEL.
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Assigning Account IDs

The Ticket window has an Account ID field in which an identifying code or name
can be entered to indicate that the ticket “belongs” to a specific account.  An account
can be any entity for which a ticket is created.  For example, accounts may be
created for each customer (“Mary Jones”) or for each organization (“Blue Ribbon
Company”).  Accounts are set up using the procedures in “Accounts IDs” in Chapter
5.

The benefits of assigning account IDs to tickets are as follows:

Assigning account IDs to tickets enables you to categorize the tickets
according to an account.  For example, it might be helpful to list all
tickets that were created for the Blue Ribbon company.  By doing so,
you can determine the types of problems that Blue Ribbon is having and
develop new procedures which eliminate the problems.
Assigning account IDs to tickets facilitates data entry.  When an existing
account ID is selected from the drop-down list in the Ticket window, the
account information is automatically entered.  The fields associated with
Account ID are First Name, Last Name, Phone, Department, Network
Address and Company ID.

 Modifying the Ticket Window Labels

The fields in the Ticket window represent the individual LSC databases.  For
example, LSC maintains a database of all First Names entered in the tickets.  The
field labels can be modified to reflect the individual requirements of an organization.
Using the label “PO Number” in place of “Cross Reference” might be more
meaningful to a support environment if incoming support calls correspond to a
purchase order number.

The procedures for modifying database labels are in “Database Labeling” in Chapter
5.

Viewing Multiple Ticket Windows

Multiple Ticket windows can be open simultaneously.  This allows the user to
compare information being maintained across any number of tickets.  Additionally,
when multiple Ticket windows are open, the Edit menu commands (i.e., Cut, Copy,
Paste) facilitate cross-referencing and sharing information among tickets.  The
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process of creating a new ticket is simplified by displaying any number of existing
tickets having similar information.

For example, assume that there are several known problems that your staff should be
aware of while providing support.  As a result, you have created corresponding
“BULLETIN” tickets which outline the known problems and list their solutions
(e.g., for each Bulletin ticket, Problem Type=BULLETIN and Problem
Category=SPREADSHEET:LOTUS).  By keeping all Bulletin Ticket windows open,
your support staff can quickly reference established solutions and provide support.
Additionally, the Ticket window Cross Reference field can be used to establish a
relationship between any number of tickets.  This is discussed in “Maintaining
Ticket Information” in Chapter 6.

HINTS:
a - When multiple Ticket windows are open or iconized, use the Window menu
commands to arrange them within the LSC application window.

b - To cycle through the open Ticket windows, press the <CTRL><F6> keys or
<CTRL><TAB> keys.

c - To use the keyboard to minimize or close the active Ticket window, press
the <ALT><hyphen> keys to open the Control menu and then choose the
desired command.  (The hyphen character is ‘-’.)

Associated Ticket Information

In addition to the information that displays in the Ticket window, the following
items can be associated with a ticket:

Action entries - These entries represent the actions performed in
response to a ticket.  For example, if LSC is used to track training
sessions, then one type of action entry might be called PREPARE which
describes the preparation performed before the session.  In addition to
tracking the efforts of your support staff, the action entries can be used to
accumulate billable time spent on a ticket.  The procedures for creating
and maintaining action entries are discussed in “Maintaining Ticket
Information” in Chapter 6.
Company IDs and Contact details  - Contact information includes the
company, address, and phone number of the person to contact regarding
the ticket.  For example, if LSC is used to track requests for support, then
the contact details should be used to maintain information for the caller
requesting support.  Contact details can be associated with a company
ID.  When an existing company ID is selected from the drop-down list in
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the Contact Details dialog box, the contact information is automatically
entered.

This concludes the overview of LSC’s ticket data display.  The procedures for
setting up company IDs are discussed in “Company IDs” in Chapter 5.  The
procedures for maintaining contact details are discussed in “Maintaining Ticket
Information” in Chapter 6.  The instructions for modifying the LSC ticket views are
discussed throughout Chapter 7, “Viewing Ticket Data.”
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Chapter  5  Setup and Administration

The previous chapter provided an overview on accessing LSC ticket data.  This
chapter discusses the setup and administration of the LSC parameters.

Introduction
The LAN Support Center setup and administrative procedures require minimal effort
on the part of the LSC administrator.  For those aspects of the system which do need
to be maintained, the procedures for doing so are simple and intuitive.

LSC setup and administrative procedures include the following:

Assigning support staff logins and granting rights
Setting up account IDs
Setting up company IDs
Defining the database labeling scheme
Maintaining qualification lists
Defining the types of problems to be tracked
Archiving and restoring tickets
Printer setup and administration

NOTES:
a - LSC can be used immediately after installation.

b - There should be one LSC administrator primarily responsible for the
features discussed in this chapter.
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What’s in this Chapter

The following chart describes the sections in this chapter:

SECTION DESCRIPTION

Database Labeling Provides procedures for customizing the LSC database
labels to satisfy the requirements of your support
environment.

Staff Membership
and Security

Provides procedures for assigning LSC login names,
passwords and access rights.

Account IDs Provides procedures for setting up LSC accounts.  Also
provides procedures for editing and deleting account
information.

Company IDs Provides procedures for setting up LSC company data.
Also provides procedures for editing and deleting company
information.

Qualification Lists Provides a description of the LSC qualification databases.
Also provides procedures for adding, modifying and
deleting items in any of the database lists.

Archiving and
Restoring Tickets

Provides procedures for moving a group of selected tickets
into an historical database.  Also provides procedures for
restoring archived tickets into the current database.

Printer Setup and
Administration

Provides procedures for defining the printer on which you
want to generate LSC reports and for setting print
parameters.

Database Labeling
The LSC database labeling scheme greatly affects the way support data is entered,
retrieved and compiled during report generation.  The database labels are used to
categorize the ticket information, and as a result, database planning and labeling
becomes an important factor in your installation and use of LSC.
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Planning the LSC database labels should begin with a review of your organization’s
current support procedures.  For example, after the evaluation, you might discover
that a label or field called COMPANY is more applicable then the default label
called DEPARTMENT.  Further, you might find that SITE should be used in place
of the FIRST NAME field.

NOTES:
a - Before modifying the database labels, review several of the pre-defined
reports supplied with LSC.  Reviewing the reports will help you determine if
your organization requires database label changes.  Chapter 8 of this manual
presents the procedures for generating and customizing LSC reports.  Also
refer to the section entitled “Sample Reports” in Chapter 8 to view several
illustrations of the pre-defined LSC reports.

b - Any changes made to the database labels are also reflected in the reports.

LSC provides a default labeling scheme which can either be tailored to satisfy the
requirements of your support environment or can be used without any modification.
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Figure 5-1 illustrates LSC’s default database labels which serve as categories of
information under which ticket data is stored.

Figure 5-1: The Default Database Labels

After careful planning, the labels in the Label Options dialog box can be modified to
reflect your support tracking requirements.

NOTES:
a - The fields which have a down arrow button represent LSC “qualification
lists” (discussed in detail on page 97).  Changing the name of one of these fields
also changes the name of the associated qualification list.

b - In all qualification lists except Priority, entries can be added, removed or
modified.  (Even if the Priority label is changed, the pre-defined Priority-type
names can only be edited.)

Customizing Database Labels

Use the following procedure to customize the ticket label names.

1. Choose the Label Options command from the Administration menu.

The Label Options dialog box displays, showing the currently defined labels for
each field in the LSC ticket database, as shown in Figure 5-2.
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Figure 5-2: The Current Database Labels

2. Make the appropriate changes to the labels.

To change a label name, move the typing cursor into a field, delete the existing
label and then type the new label name.

NOTES ON MODIFYING LABELS:
a - Press the <TAB> key to move the cursor quickly from field to field in the
Label Options dialog box.

b - Labels can consist of any typed characters.  The new label name must fit in
the field space provided (i.e., the fields do not scroll).

c - The following fields are linked to the Account ID field: First Name, Last
Name, Phone, Department and Network Address.  For example, assume that the
following information is entered for a new ticket: Account ID=BLUE RIBBON,
First Name=MARY, Last Name=JONES, and Department=SALES.  In this
case, the next time that BLUE RIBBON is entered into the Account ID field,
then MARY, JONES and SALES will automatically display in the First Name,
Last Name and Department fields, respectively. These fields remain linked even
if their label names are changed. (Accounts are set up using the procedures on
page 88.)
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d - The Product Category field is a sub-field of Problem Type.  For example, a
Problem Type might be entered as “Software.”  Related Product Categories
might then be entered as “Spreadsheets” and “Word Processors.”  These fields
remain linked even if their label names are changed. (Product Categories are
defined using the procedures on page 103.)

3. Choose the OK button to save the changes.

The Label Options dialog box closes, and all Ticket windows will reflect the
new labels.

NOTE:
Labels can be modified after issuing and saving tickets; however, all ticket data
reflects the database labels that are present when the ticket is saved.  For
example, if a ticket is saved with JOHN in the First Name field and the First
Name label is later changed to Company, then the same ticket will have JOHN
in the new Company field.

Staff Membership  and Security
Every LSC support staff user must be assigned a unique ID and password which
defines the LSC activities he or she can perform.  The unique ID also determines the
first three characters of all tickets created by the user.  (For more information on the
ticket numbering scheme, refer to “The Ticket Window” in Chapter 4.)

Before LSC is launched, the user must provide a valid user name and password
combination.  When a user successfully logs into LSC, the LSC application window
displays.

Defining LSC staff users and assigning unique IDs and passwords is an on-going
action performed by the LSC administrator.  In addition to adding and removing
users, the LSC administrator is responsible for granting user rights and modifying
those rights if the users’ support responsibilities change.

NOTES:
a - The commands available from the Administration menu are enabled only
for those users who are granted the appropriate rights. For example, if Dan is
not given the right to Setup Staff, then the Setup Staff command on Dan’s
Administration menu is disabled.

b - Changing the default LSC login name and password (i.e., LSC and LSC) is
highly recommended.
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Adding Support Staff

Use the following procedure to add new support staff members and define their
rights within the LSC environment.

1. Choose the Setup Staff command from the Administration menu.
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The Setup Staff dialog box displays listing the initials of the defined LSC staff
members, as shown in Figure 5-3.

Figure 5-3: The LSC Staff List

2. To add a new staff member, choose the Add button.

The Add Staff dialog box displays, as in Figure 5-4.

Figure 5-4: Adding a New Staff Member

3. Enter the new staff member’s information.
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Enter the following information for the new LSC user:

Staff Initials - Enter a unique code for the new user’s LSC login
name.  A maximum of 3 characters can be entered.
Full Name - In the field space provided, enter the new user’s full
name.  This is an optional field.
Enter New Password  - Enter the new user’s 8 character password.
This is an optional field.  The typed information displays as asterisks
for password protection.
Verify New Password  - Verify the 8 character password entered in
the above field by re-entering the new user’s password.  This must
exactly match the password entered in the Enter New Password field.
The typed information displays as asterisks for password protection.
Rights Granted For Qualification Lists  - Place a checkmark next
to each qualification list the user is able to modify.  For example, if a
new user is to be restricted from modifying any of the qualification
lists, then do not check any of the qualification list items in the Add
Staff dialog box.

NOTE:
When a user is restricted from modifying a qualification list, the user is unable
to add/edit entries via the Qualification Lists dialog box or the Ticket window.
For example, if Dan is not given the right to modify the Problem Type list, then
he cannot edit the Problem Type qualification list entries (via the
Administration/Qualification Lists command).  Dan also cannot enter a new
problem type into the corresponding field of a Ticket window.  In this case, Dan
can only select existing entries from the Problem Type field drop-down list.

Rights Granted For Actions  - Place a checkmark next to each LSC
action the user is allowed to perform.  Rights for the Edit Tickets and
Delete Actions options can be further defined to include one of the
sub-categories.  For example, a new user might be allowed to edit
only the tickets assigned to him or her.

NOTES:
a - Having only one “LSC Administrator” who is given the right to Setup Staff
and Define Label Options is recommended.

b - By default, all rights are enabled when adding a new user.

4. Choose the OK button.
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The Add Staff dialog box closes, and the initials entered for the new staff
member are listed in the Setup Staff dialog box.

Maintaining Support Staff

As staff positions and responsibilities change, the LSC support staff information
must be maintained.  For example, assume that Mary receives a promotion to
Support Manager.  As a result of Mary’s promotion, her LSC rights may be
modified to allow for ticket deletion, report generation and archiving/restoring ticket
databases.

Use the following procedure to delete or edit an existing support staff member’s
information.

1. Choose the Setup Staff command from the Administration menu.

The Setup Staff dialog box displays, listing the initials of the defined LSC staff
members.

2. To delete a staff member, highlight the staff member’s name in the Setup Staff
dialog box and choose the Delete button.

The message “Delete the Staff selected?” displays.  Choose the Yes button to
delete the staff member.

3. To edit a staff member’s information, highlight the staff member’s name in the
Setup Staff dialog box and choose the Edit button.

The Edit Staff dialog box displays, as in Figure 5-5.
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Figure 5-5: Editing Staff Member Information

4. Edit the staff member’s information.

This box is identical in form and usage to the Add Staff dialog box with the
exception that the operations are performed for an existing LSC user rather than
for creating a new user.

5. Choose the OK button.

The Edit Staff dialog box closes.

Accounts IDs
LSC accounts can be defined to identify companies, persons or events for which
tickets are created.  The benefits of assigning account IDs to tickets are as follows:

Assigning account IDs to tickets enables you to categorize the tickets
according to an account.   The Ticket window has an Account ID field
in which the account’s identifying code or name can be entered to
indicate that the ticket “belongs” to a specific account.  For example, it
might be helpful to list all tickets that were created for the Blue Ribbon
company.  By doing so, you can determine the types of problems that
Blue Ribbon is having and incorporate new procedures to eliminate the
problems.
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Assigning account IDs to tickets facilitates data entry.   When an
existing account ID is selected from the drop-down list in the Ticket
window, the related account information is automatically entered.
Related account information includes an Account ID, First Name, Last
Name, Phone, Department, Network Address and Company ID.

NOTE:
Assigning a Company ID to the account links the company data with the
account data.  Each time an account ID is entered on a ticket, the ticket’s
contact details information is automatically populated with the company data.

Accounts are set up and maintained using the procedures in this section.

Adding Accounts

Use the following procedure to add new LSC accounts.

1. Choose the Setup Account command from the Administration menu.
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The Setup Account dialog box displays listing all accounts, as in Figure 5-6.

Figure 5-6: A List of LSC Accounts

2. To add a new account, choose the Add button.

The Add Account dialog box displays, as in Figure 5-7.

Figure 5-7: Adding a New Account
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3. Enter the new account information.

Enter the following information for the new LSC account:

Account ID - Enter a unique code or name to identify the new
account.  A maximum of 55 characters can be entered.  For example,
enter “Blue Ribbon” to identify the Blue Ribbon company account,
or enter #3456 to identify the customer having account #3456.  This
is the only required field in the Add Account dialog box.
First Name - Enter the first name of the person assigned to the
account.  A maximum of 20 characters can be entered.
Last Name - Enter the last name of the person assigned to the
account.  A maximum of 20 characters can be entered.
Phone - Enter the phone number of the person assigned to the
account.  A maximum of 27 digits can be entered.
Department - Enter the department in which the person assigned to
the account belongs.  A maximum of 30 characters can be entered.
Network - Enter the network address of the person assigned to the
account.  A maximum of 20 digits can be entered in the following
format: 8 digits:12 digits (the colon is required).
Company ID - Enter the unique code or name which identifies the
contact details to be attached to all tickets that are assigned the
account ID.  A maximum of 40 characters can be entered.

NOTES ON ENTERING ACCOUNT INFORMATION:
a - Entering a company ID in the Add Account dialog box links the account
data to the company data.  Each time the account ID is entered in a Ticket
window, all related company data is automatically entered in the ticket’s
Contact Details dialog box.  Refer to the procedures on page 93 for setting up
Company IDs.

b - If you have changed the database labels for First Name, Last Name, Phone,
Department or Network, then the changed labels will be reflected in the Add
Account dialog box.

c - The information entered in the First Name, Last Name, Phone, Department
and Network fields is only added to the corresponding qualification list when
the account is used in a ticket.  For example, if the “ABC” account is set up with
“Smith” in the Last Name field, then Smith is only added to the Last Name
qualification list when a ticket is created for account ABC.

4. Choose the Save button.
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The Add Account dialog box closes, and the new account ID is listed in the
Setup Account dialog box.

Maintaining Accounts

Use the following procedure to delete or modify the information for an existing
account.

NOTE:
Account ID data can also be modified from within the Ticket window.  When
account information is changed in the Ticket window and the ticket is then
saved, a prompt displays giving you the option to update the account
information.

1. Choose the Setup Account command from the Administration menu.

The Setup Account dialog box displays listing all accounts.

2. To delete an account, highlight the account name in the Setup Account dialog
box and choose the Delete button.

The message “Do you wish to delete this entry?” displays.  Choose the Yes
button to delete the account.

3. To edit account information, highlight the account name in the Setup Account
dialog box and choose the Edit button.

The Edit Account dialog box displays, as in Figure 5-8.

Figure 5-8: Editing Account Information
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4. Edit the account information.

This box is identical in form and usage to the Add Account dialog box with the
exception that the operations are performed for an existing LSC account rather
than for creating a new account.

5. Choose the Save button.

The Edit Account dialog box closes.

Company IDs
Company IDs are unique names which identify the contact details of a company.
Details include the company’s address, fax number and Email information.

Assigning company IDs facilitates data entry in the Contact Details dialog box.
When an existing company ID is selected from the drop-down list, the related
company information is automatically entered.  Furthermore, a Company ID can be
linked to an Account ID (refer to page 88).  Each time an account ID is entered in a
Ticket window, the ticket’s contact details information is automatically populated
with the company data.

Company IDs are set up and maintained using the procedures in this section.

Adding Company IDs

Use the following procedure to add new company IDs.

1. Choose the Setup Company command from the Administration menu.

The Setup Company dialog box displays, listing all companies that have been
assigned IDs, as in Figure 5-9.
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Figure 5-9: A List of LSC Company IDs

2. To add a new company ID, choose the Add button.
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The Add New Company dialog box displays, as in Figure 5-10.

Figure 5-10: Adding a New Company

3. Enter the new company information.

Enter the following information for the new LSC company:

Company ID - Enter a unique code or name to identify the new
company.  A maximum of 40 characters can be entered.  For
example, enter “Blue Ribbon-TX” to identify Blue Ribbon’s Texas
office site.  This is the only required field in the Add New Company
dialog box.
Address Line 1 & 2  - Enter the address of the company.  A
maximum of 30 characters can be entered.
City - Enter the city in which the company is located.  A maximum
of 20 characters can be entered.
State - Enter the state in which the company is located.  A maximum
of 10 characters can be entered.
Zip - Enter the zip code of the company.  A maximum of 10
characters can be entered.
Country - Enter the country in which the company is located.  A
maximum of 15 characters can be entered.
Fax - Enter the company’s fax number.  A maximum of 20
characters can be entered.
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Email - Enter the company’s Email information.  A maximum of 50
characters can be entered.

4. Choose the Save button.

The Add New Company dialog box closes, and the new company ID is listed in
the Setup Company dialog box.

HINT:
An account is only linked one company ID.  Therefore, for a company that has
several locations, link the most frequently used location to the account ID.

Maintaining Company IDs

Use the following procedure to delete or modify the information for an existing
company.

NOTE:
Company ID data can also be modified from within the Contact Details dialog
box.  When company information is changed in the Contact Details dialog box
and the Save button is chosen, a prompt displays giving you the option of
updating the company information.

1. Choose the Setup Company command from the Administration menu.

The Setup Company dialog box displays listing all companies.

2. To delete a company, highlight the company name in the Setup Company dialog
box and choose the Delete button.

The message “Do you wish to delete this entry?” displays.  Choose the Yes
button to delete the company.

3. To edit company information, highlight the company name in the Setup
Company dialog box and choose the Edit button.
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The Edit Company dialog box displays, as in Figure 5-11.

Figure 5-11: Editing Company Information

4. Edit the company information.

This box is identical in form and usage to the Add New Company dialog box
with the exception that the operations are performed for an existing LSC
company rather than for creating a new company.

5. Choose the Save button.

The Edit Company dialog box closes.

Qualification Lists
The LSC database is made up of several lists which maintain and categorize ticket
information.  Most ticket information is obtained from or written to a “qualification
list,” which is used for data validation and for compiling ticket records.

Qualification lists cannot be added to LSC; however, individual entries in most
qualification lists can be added, modified and/or removed to reflect your own
support environment.  For example, by default LSC includes the entries INFO and
PRODSTAT in the Issue Type qualification list.  Your support environment may
also require an Issue Type called REFERENCE.
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Many qualification lists directly correspond to the fields in the Ticket window.  For
example, there is a Priority qualification list which corresponds to the Priority field.
When creating or editing tickets, the fields with a drop-down list let you select
existing entries from the corresponding qualification list.  This feature is important
to maintaining the integrity and consistency of the LSC ticket data.

Many of the qualification lists are populated with information upon the installation
of LSC.  The following table describes the contents and intent of each qualification
list.

Qualification
List

Description Default Entries

Action Code Code used to indicate the action
taken on a ticket.
The TO_DO default entry name
cannot be edited or deleted.

REROUTED
SOLVED
TELEPHONED
TO_DO

Department Departments or areas in which
callers work (e.g., ACCOUNTING,
SALES or COST_CENTER#1,
ABC CO).

ACCOUNTING
ADMIN
INT’L SALES
MARKETING
SALES
TRAINING

First Name First names of the callers.

Issue Type Type of ticket for categorization
purposes (e.g., BUG, INFO).

INFO
PRODSTAT

Continued...
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Qualification
List

Description Default Entries

Last Name Last names of the callers.

Network Address Network addresses of the callers.

Priority Priorities that can be assigned to a
ticket.  The entry names in the
Priority list can only be edited: new
entries cannot be added and
existing entries cannot be deleted.
This is true even if the Priority label
is changed.
Further, the color display of the
default priorities in the View
Tickets window is as follows:
Urgent=red; Important=pink;
Necessary=green; Desired=brown.
This is true even if the Priority
entry names are changed.

URGENT
IMPORTANT
NECESSARY
DESIRED

Problem Type Names used to describe and
categorize the type of problems the
callers are experiencing.  This
database has related sub-categories.
Refer to the discussion on page 103
entitled “Managing Problem Type
Sub-categories.”

NOTES ON THE QUALIFICATION LIST TABLE:
a - The default qualification list names are listed in the table above.  If you
change the LSC database labels, your qualification list names also change.

b - The term “caller” is used to represent the person for whom the ticket is
created (e.g., the person requesting support, the person requiring a training
class).

c - The Assigned To category is not considered a qualification list because the
entries that display in this drop-down field in the Ticket window are driven by
the support staff users’ initials listed in the Setup Staff dialog box.  Similarly,
the Account ID category is not a qualification list the entries that display in
this drop-down field in the Ticket window are driven by the IDs listed in the
Setup Account dialog box.
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Modifying Qualification Items

The qualification list items provided with LSC can be customized to apply
specifically to your organization.  For example, you might want to modify the items
in the Departments list so they specifically apply to your support environment.  In
addition to the Department names provided by LSC, you might want to categorize
support calls by mail stops or cost centers.

NOTES:
a - Users are only able to modify the qualification lists that are checked in their
user profile (i.e., the rights they were granted via the Administration/Setup Staff
command).

b - If a user is given the right to modify a qualification list, then the user can
add entries to the list by entering the information directly into the
corresponding fields of a Ticket window.  When the ticket is saved, the new
entry is added to the appropriate qualification list.  For example, if user Helen
has the right to modify the Department list, then Helen can save a ticket having
QA in the Department field.  Doing so will add QA to the Department
qualification list without having to perform the procedure below.

Use the following procedure to modify a database item.

1. Choose the Qualification Lists command from the Administration menu.

The Qualification Lists dialog box displays, as in Figure 5-12.
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Figure 5-12: Displaying the Qualification List Names

2. Select a name from the drop-down list associated with the Name of List field.

Choose the down arrow button next to the Name of List field to view all
qualification list names.  When a qualification list is selected, its items display
in the List Items field.  In Figure 5-13, the Action Code database has been
selected, and its items consist of the following: REROUTED, SOLVED,
TELEPHONED and TO_DO.  These items represent the type of actions that can
be assigned to a ticket.
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Figure 5-13: Displaying the Items in the Action Code List

3. Modify the qualification list item information.

Possible modifications include the following:

Adding an item - To add a new item to a list, choose the Add
button.  An Add Item dialog box displays prompting you to specify
the name of the new item.  Type the name and choose the OK button.
The new item is added to the qualification list.
Editing an item - To edit an existing item in a list, highlight the item
and choose the Edit button.  An Edit Item dialog box displays with
the selected item name.  Make changes to the name and choose the
OK button.  The item name is updated.
Deleting an item  -  To delete an existing item from a list, highlight
the item in the list and choose the Delete button.  The item name is
removed from the list.

NOTES:
a - The Priority qualification list items can only be edited: new entries cannot
be added and existing entries cannot be deleted.

b - Items for the Problem Type qualification list can be assigned sub-
categories.  For example, you might want to track the support calls related to
printer problems.  Related PRINTER sub-categories might include DRUM and
CARTRIDGE.  Refer to the discussion below entitled “Managing Problem Type
Sub-categories.”
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c - The TO_DO Action item is a special default item and cannot be edited or
deleted.

4. To close the Qualification Lists dialog box, choose the Close button.

Managing Problem Type Sub-categories

The Problem Type qualification list categorizes the types of problems monitored by
LSC.  To further categorize problem types and track your support efforts, detailed
sub-categories can be assigned to the items in this list.  These sub-categories
comprise the Product Category list available from the Ticket window.

For example, your support environment might monitor SOFTWARE problems.
Monitoring the SOFTWARE problem type is helpful; however, creating a sub-
category named WORD would allow you to monitor specific software problems
concerning the Word program.  Tracking the Word Software problem type might
result in discovering a problem in the way in which the Word program is being
installed across your network.  It might also result in discovering that your users
require more training in using the Word software.

The level of detail entered in the Problem Type list and the related sub-categories
affects the integrity and consistency of your LSC data.  This list requires careful
planning and attention.

HINTS:
a - To avoid having the support staff define sub-categories while creating
tickets, define detailed problem type sub-categories.

b - To track unusual/unidentified problems, create a problem type named
UNDETERMINED.  You can run a report listing all tickets assigned the
UNDETERMINED problem type and update the field when the problem is
identified.

Use the following procedure to manage the Problem Type sub-categories (i.e., the
related Product Categories).

1. Choose the Qualification Lists command from the Administration menu.

The Qualification Lists dialog box displays.

2. Select the Problem Type database from the drop-down list associated with the
Name of List field.

The Qualification Lists dialog box shown in Figure 5-14 displays.  The Related
Product Category field displays listing the sub-category items that pertain to the
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highlighted list item.  For example, in Figure 5-14 the PRINTER item is
highlighted, and the sub-categories defined for PRINTER are listed in the
Related Product Category field (i.e., CARTRIDGE, DRUM, TONER).

Figure 5-14: Defining Items and Related Problem Type Categories

3. Define or modify the Related Product Category information.

Adding a Sub-Category  - To add a sub-category to the highlighted
problem type, choose the Add button in the lower area of the
Qualification Lists dialog box.  The Add Related Item dialog box
displays, prompting you to specify the name of the new sub-
category.  Enter the name and choose the OK button.  The new sub-
category is added to the Related Product Category list.
Editing a Sub-Category - To edit an existing sub-category in the
highlighted problem type, highlight the related product category item
and choose the Edit button in the lower area of the Qualification
Lists dialog box.  The Edit Related Item dialog box displays with the
selected sub-category name.  Make changes to the name and choose
the OK button.  The sub-category name is updated.
Deleting a Sub-Category -  To delete an existing sub-category from
the Related Product Category list, highlight the sub-category name
and choose the Delete button in the lower area of the Qualification
Lists dialog box.  The sub-category name is removed from the list

4. To close the Qualification Lists dialog box, choose the Close button.
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Archiving and Restoring Tickets
As the LAN Support Center program is used, the number of tickets in the database
continues to increase.  To use disk space more efficiently, you might want to remove
a group of selected tickets from the “current ticket database” and place them into an
“historical ticket database.”

The above database terms are defined as follows:

Current Ticket Database  - the group of tickets to which new tickets are
added.  The current ticket database is used on a daily basis and should
consist of primarily active/open tickets.  There is only one current
database at any time.
Historical Ticket Database  - a group of tickets that have been removed
from the current database.  These archived tickets can be loaded into
LSC for reference purposes; however, changes to the historical database
tickets should not be made.  There can be any number of historical
databases.

The process of archiving tickets moves the selected group of tickets into a user-
defined historical database file.  The information is still accessible from within LSC.
By default, the LSC user works with tickets in the “current database.”  However,
when researching and investigating support issues, it may become necessary to
access tickets residing in an historical database.  This procedure is discussed in detail
in the section entitled “Viewing Historical Tickets” in
Chapter 7.

In addition to simply accessing archived tickets, LSC provides the ability to restore
an entire historical database file.  The process of restoring the file moves the entire
group of archived tickets back into the current LSC ticket database.

The procedures for archiving and restoring tickets are discussed in this section.

Archiving Tickets

When identifying a specific group of tickets to be archived into an historical
database, filter criteria can be specified.  The filter criteria defines the group of
tickets to be archived.  For example, if your support environment only works with
open tickets from within the last two months, then you might want to archive all
closed tickets that are older than two months.  If the current date is December 31,
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1993, then the filter criteria of the tickets to be archived might include all Closed
Tickets to 10/31/1993.

In addition to defining the group of tickets to be archived, you have the option to
either add the tickets to an existing historical database file or create a new historical
database file.

NOTE:
For increased speed and database performance, keeping the number of tickets
in an LSC  database (i.e., current or archived) be fewer than 20,000 is
recommended.

Use the following procedure to remove selected tickets from the current ticket
database.

1. Choose the Archive Tickets command from the Administration menu.

The Archive Tickets dialog box displays, as in Figure 5-15.

Figure 5-15: Archiving Tickets to an Historical Database

2. Choose the Filter button to define the group of tickets to be archived.

The Filter Ticket List dialog box displays, as in Figure 5-16.  Entering specific
filtering criteria defines the tickets to be archived.  Only those tickets
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that match the filter criteria will be archived into the historical ticket database.

Figure 5-16: Defining the Tickets to be Archived

3. Define the filter criteria of the tickets to be archived.

In the fields provided, specify the information of the tickets to be archived.  For
example, to archive all tickets that have been resolved, choose the SOLVED
entry from the Action Code field’s drop-down list; to archive one specific ticket,
enter the ticket number in the Ticket # field.

NOTE:
When archiving a group of tickets, enter specific filtering information in order
to archive the desired tickets.  Wildcards are not allowed.

4. Choose the OK button to accept the filter criteria.

The Filter Ticket List dialog box closes, and you are returned to the Archive
Tickets dialog box.

5. Choose the Browse button to specify the historical database file name.

The Browse dialog box displays prompting you to enter the File Name and
destination of the file which will maintain the archived tickets.

You can either:

Add the selected tickets to an existing historical database file  -
Enter the full path name of the historical database file in the File
Name field.  (If you do not know the file name and path, choose
entries in the Directories and Drives lists to search for the archive
file.  From the list of file names which displays under the File Name
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field, click on the file name into which you want to add the new
archived tickets.)
Create a new historical database file  - Enter the full path name of
the new historical database file in the File Name field.  (You can also
choose entries from the Directories and Drives lists to define the full
path into which you want to place the new archived ticket file.)

NOTES:
a - LSC historical database file names are assigned the extension .ARC.

b - If the path is not specified when creating a new database file, then the file is
placed into the current directory (as indicated under the Directories field in the
Browse dialog box).

c - If the file already exists when attempting to create a new database file, then
the selected tickets are added to the end of the existing file.  If the existing file is
not in an LSC archival file format, then you are prompted to overwrite the file
contents.

6. Choose the OK button to accept the archive file name.

The Browse dialog box closes, and you are returned to the Archive Tickets
dialog box.  This dialog box now displays the destination directory and archive
file name.

7. Choose the OK button to initiate the archival process.

The selected ticket information is moved into the historical database file.  Upon
completion, the following files are created to maintain information regarding the
archived tickets:

the .ARC file maintains the historical database
the .ACT file maintains the ticket actions
the .DES file maintains the ticket problem descriptions
the .DEA file maintains the action descriptions

Restoring Tickets

Archived tickets are accessible to the LSC user by restoring the historical ticket
database.  When researching and investigating problems, it may become necessary
to restore a selected database.

NOTE:
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The restore process moves the entire historical file back into the current LSC
database.  A single ticket cannot be tagged and restored.

Use the following procedure to restore an entire historical database file.

1. Choose the Restore Tickets command from the Administration menu.

The Restore Tickets dialog box displays, as in Figure 5-17.

Figure 5-17: Restoring an Historical Database

2. Choose the Browse button to specify the historical database file name to be
restored.

The Browse dialog box displays prompting you to enter the File Name of the
database to be restored.

3. Enter the full path name of the historical database file (i.e., the .ARC file) in the
File Name field.

Choose entries in the Directories and Drives lists to search for the archived
database file.  From the list of file names which displays under the File Name
field, click on the desired file name.

4. Choose the OK button to accept the file name.

The Browse dialog box closes, and you are returned to the Restore Tickets
dialog box.  This dialog box now displays the full path name of the file to be
restored.

5. Choose the OK button to initiate the restore process.

All tickets and their associated actions and descriptions in the selected historical
database are moved into the current database.
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Printer Setup and Administration
Printer control information identifies the printer parameters and controls the printing
of all reports associated with LSC activity and administration.  Before printing LSC
reports, you should review the printer configuration to be sure it reflects the printer
settings that you require.  Printer settings include:

Printer destination
Page orientation (portrait/landscape)
Paper size and source
Graphics resolution

The procedures for customizing the contents of individual LSC reports are discussed
in Chapter 8, “LSC Reports.”  This section briefly presents the procedures for
viewing and changing the global print settings (e.g., target printer, paper size) for
Windows.

Changing Print Settings

Use the following procedure to review and change your print settings.

1. Choose the Print Setup command from the File menu.

The Print Setup dialog box displays, as in Figure 5-18.

Figure 5-18: Defining Print Parameters

2. Select the printer you want to use for printing LSC reports.

The printer defined in your Windows printer control is selected as the default.
To use another printer, select a Specific Printer from the drop-down list
associated with this field.
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3. Select the desired orientation and paper parameters.

Choose either the Portrait (long) or Landscape (wide) Orientation setting.  Use
the drop-down lists to define the Paper Size and Paper Source settings.

4. To make additional changes to the selected printer configuration, choose the
Options button.

Additional settings include dithering and intensity control.

5. Choose the OK button in the Print Setup dialog box to save the print settings.

NOTE:
These print settings are global throughout your Windows environment.  Please
refer to your Windows manual for detailed procedures on modifying the above
print settings.

This ends the chapter on setting up and administering the LAN Support Center
parameters.   Refer to the following chapter for procedures for creating and
maintaining work tickets.
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Chapter 6  Work Tickets

The previous chapter discussed the LSC setup and administrative procedures.  This
chapter describes the procedures for creating and maintaining work tickets.

Introduction
A work ticket is a collection of related information regarding an event.  The “event”
is the incident for which information is maintained and tracked.  Tickets can track
virtually any number of event types.  Consider creating tickets for any of the
following events:

Support requests and issues
Installation scheduling
Training sessions
Enhancement or upgrade requests

This chapter discusses the procedures for creating and maintaining work tickets.
Throughout the chapter, examples are used to illustrate methods for tracking various
event types.

What’s in this Chapter

The following chart describes the sections in this chapter:

SECTION DESCRIPTION

Creating Tickets Provides procedures for creating, deleting and printing
tickets.
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Maintaining
Ticket Information

Provides procedures for managing associated ticket action
and contact detail information.  Also discusses the
procedures for cross-referencing tickets and editing date
field entries.

Investigating Provides procedures for accessing other McAfee products
from within LSC for investigative and problem resolution
purposes.

Creating Tickets
The process of creating tickets is the essence of LSC.  All information maintained
and tracked by LSC is done so via a ticket.

Depending on the responsibilities assigned to your support staff and the flow of
information within your organization, one staff member or all staff members might
create tickets.  For example, Mike answers phones for the support desk staff at the
Blue Ribbon company.  For each incoming phone call, Mike creates a ticket with the
caller’s information and problem.  Throughout the day, the support desk supervisor
assigns the tickets to specific staff members.  The staff members are responsible for
handling the tickets they have been assigned.

Ticket Window Fields

All information regarding an “event” is entered into a Ticket window.  An “event” is
defined as the item being tracked by LSC.  For example, an event might be a support
call or it might be a scheduled installation.  A Ticket window is illustrated in Figure
6-1.
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Figure 6-1: A Ticket Window

When a new ticket is created, LSC automatically assigns a number to the ticket.  The
ticket number displays in the title bar of the Ticket window and cannot be modified
by the LSC user.

Each ticket number is determined by the following information:
IIIYYMMDDHHMMSS, where III=staff initials, YY=year, MM=month, DD=day,
HH=hour, MM=minute and SS=second.  For example, the ticket number in Figure
6-1 indicates that this ticket was created on February 9, 1994 at 1:39:04 in the
afternoon by the staff member that has the LSC login initials ‘CF’.

Each field in the Ticket window is defined and discussed in the table below.

NOTES:
a - If your LSC database labels have been modified, the field names and
definitions for your Ticket window may be different.  For more information on
labeling, refer to “Database Labeling” in Chapter 5.

b - Multiple Ticket windows can be open simultaneously.

Field Description Type
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Account ID The account to which this ticket belongs.  Each
Account ID must be unique.  Every account has
an associated First Name, Last Name, Phone,
Department, Network Address and Company ID
field.  Entering an existing Account ID will
automatically populate all associated fields.
Account IDs can be set up directly from within
the Ticket window or by choosing the Setup
Account command from the Administration
menu.  Refer to “Accounts IDs” in Chapter 5 for
detailed instructions on setting up accounts.

55 chars

First Name The first name of the person/customer associated
with the account entered in the Account ID field.

20 chars

Last Name The last name of the person/customer associated
with the account entered in the Account ID field.

20 chars

Department The department of the person/customer associated
with the account entered in the Account ID field.

30 chars

Phone The phone number of the person/customer
associated with the account entered in the
Account ID field.

27 digits

Assigned
To

The code/name of the LSC staff member assigned
to handle the ticket.  This field defaults to the
initials supplied by the user who logged in to
LSC.

3 chars

Continued...
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Field Description Type

Issue Type The code/name which indicates the type of ticket
being issued.

10 chars

Priority The priority assigned to the ticket.  (The color
display of each priority is as follows: Urgent=red;
Important=pink; Necessary=green;
Desired=brown.)

10 chars

Problem
Type

The type of problem being reported.  The item
entered in this field determines the items that can
be selected from the related Product Category
drop-down list.

15 chars

Product
Category

The category of the problem being reported.  The
entries available from this drop-down list are
determined by the entry in the Problem Type
field.  For example, if DRIVE is entered as the
Problem Type, then available product categories
may be ANY MASS STORAGE DEVICE and
DISK DRIVE A.

30 chars

Network
Address

The network address of the person/customer
associated with the account entered in the
Account ID field.

20 digits + a
colon (8
digits:
12 digits)

Cross
Reference

Any information which can be used to cross
reference the ticket to another item (e.g., another
ticket or another application).

Press the <ALT><Z> keys to paste the ticket
number of the highlighted ticket in the View
Tickets window into the active Ticket window’s
Cross Reference field.

15 alphanum

Status Mutually exclusive radio buttons that indicate the
status of the ticket.  Each button is associated
with a date and time field.  By default, the current
system date displays for the Opened On date.
(Refer to the section on page 129 for procedures
on editing date values.)

N/A

Problem
Description

A detailed description of the problem which can
be up to approximately 2 full pages of text.

4K
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Many of the fields in the Ticket window have drop-down lists from which items can
be selected.  For example, choosing the Product Category field’s drop-down list
displays a list of entries that have been defined for the Product Category
qualification list (refer to the partial Ticket window shown in Figure 6-2).  Clicking
on an entry in the drop-down list places the chosen entry in the selected field.

Figure 6-2: The Product Category Drop-Down List

For those fields which have drop-down lists, typing in new entries adds the new
entry to the associated qualification list.  For example, if the name ACCOUNTING
is not listed in the Department drop-down list, then entering the name
ACCOUNTING into the Department field and saving the ticket will add the name to
the Department qualification list.

NOTES:
a - Users are only able to type new entries in a Ticket window field if they are
granted the appropriate rights in their staff member profile.  Refer to “Staff
Membership and Security” in Chapter 5 for instructions on setting up staff
members and defining security rights.

b - Refer to “Qualification Lists” In Chapter 5 for a discussion on LSC’s
qualification lists.

The procedures for creating and maintaining tickets are discussed in this chapter.

Creating New Tickets

Inquiries, events and issues are tracked via a ticket number.  To assign a ticket to a
specific customer account, an account ID can be specified on the ticket.  The steps
required for creating new tickets involve entering information regarding the ticket’s
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initial purpose.  For example, when a customer requests support, a new ticket is
created which documents the caller’s account, name, company and phone
information, as well as documents the caller’s request.

The process of trying to solve the caller’s problem is referred to as “action.”
Logging ticket action is discussed in the section of this chapter entitled “Maintaining
Ticket Information.”

NOTE:
New tickets are placed in the ticket database that is loaded at the time the new
ticket is saved.  To add the new tickets to the current LSC ticket database, make
sure that the current database is being viewed (as opposed to the View
Historical Tickets window).

Use the following procedure to create a new ticket.

1. Choose the New Ticket command from the Ticket menu, or choose the New tool
bar button.

The Ticket window displays, as in Figure 6-3.  A ticket number is automatically
assigned by LSC.  It is indicated in the title bar of the Ticket window and
represents the LSC login user initials, year, month, day, hour, minute, and
second of the ticket’s creation.

Figure 6-3: A New Ticket Window

2. Enter the ticket information.
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For detailed information on the Ticket window fields, refer to the table on page
114.

NOTES:
a - Selecting an Account ID from the drop-down list associated with this field
will automatically enter the information defined for the account (i.e., First
Name, Last Name, Department, Phone, and Network Address).

b - New accounts can be set up from within the Ticket window by typing in the
new account information.  Upon saving the ticket, the new account information
is also saved.

c - Existing accounts can be updated from within the Ticket window by
modifying the account information and saving the ticket.  Upon saving the
ticket, a prompt displays asking whether you want to update the account
information.  Answering Yes to this prompt will update the account data and all
new tickets that are assigned to the account will reflect the updated information.
Answering No will save the modified account data with this ticket only.

d - Ticket action can also be entered at this point by choosing the Add Action
button.  Refer to the procedure on page 122.

3. Choose the Save button.

If you have selected an account from the Account ID drop-down list and then
modified the account data, a prompt displays asking whether you want to update
the account information.  Answering Yes to this prompt will update the account
data.  Answering No will save the modified account data with this ticket only.

The ticket is saved into the current ticket database.

Cross-Referencing Tickets

The Ticket window’s Cross Reference field can be used to build a knowledge base
of information regarding a specific issue or problem type.  For example, new tickets
can be cross-referenced to “TECHNICAL” Issue Type tickets which outline known
problems and their solutions.  Either from an LSC report or the View Tickets
window, the LSC Administrator then has access to all tickets related to the specific
Technical ticket that has ticket number ‘x’.  In this example, a report query can be
created which includes only ticket number ‘x’, or a filter can be applied to the View
Tickets window which only displays the tickets having ticket number ‘x’ in the
Cross Reference field.

HINTS:
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a - LSC’s extensive short-cut keys facilitate the cross-referencing of tickets to
one-another.  Pressing the <ALT><Z> keys in a Ticket window will paste the
ticket number of the highlighted ticket in the View Tickets window into the
active Ticket window’s Cross Reference field.

b - Use the Edit menu commands to cut, copy and paste information between
open Ticket windows.

In addition to cross-referencing among LSC tickets, the Cross Reference field can be
used to track information external to LSC.  For example, if LSC tickets are created to
track installations, entering a Purchase Order number in the Cross Reference field
can track the PO number of each installed equipment component.  This information
might be useful in tracking equipment movement from purchase to installation, as
well as assessing future equipment purchase requirements.

Deleting Tickets

In some instances, it might become necessary to delete a ticket and all of its
associated information.

Use the following procedure to delete a ticket from the ticket database.

1. From the View Tickets window, highlight the ticket to be deleted.

To display the View Tickets window, choose either the Current Tickets or
Historical Tickets command from the View menu, depending on where the
ticket is located.

If necessary, use the scroll bars in the View Tickets window to find the ticket to
be deleted.

2. Choose the Delete Ticket command from the Ticket menu, or choose the Delete
tool bar button.

You are prompted to confirm the ticket deletion.  Choose the Yes button to
delete the selected ticket, or choose the No button to cancel the delete action.

The deleted ticket is removed from the LSC ticket database and will no longer
display in the View Tickets window.

NOTE:
A ticket can also be deleted while its Ticket window is open.  To do so, choose
the Delete tool bar button.  You are prompted to confirm the delete action.
Choose the Yes button to delete the ticket displayed in the open Ticket window.

WARNING:
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Use the delete action with caution as all references to deleted tickets are completely
removed from the LSC database.

Printing Tickets

All printing is performed using the currently defined print parameters.  To modify or
verify the current print parameters, choose the Print Setup command from the File
menu.

Use the following procedure to print a selected ticket.

1. From the View Tickets window, highlight the ticket to be printed.

2. Choose the Print Ticket command from the Ticket menu, or choose the Print
tool bar button.

The ticket data is sent to the printer.

NOTE:
A ticket can also be printed while its Ticket window is open.  To do so, choose
the Print tool bar button.  The ticket data is sent to the printer.

Maintaining Ticket Information
Creating a ticket is the first step towards solving a support issue and/or scheduling
timed events.  For example, the tickets in your LSC database may represent requests
for support, or they may represent installations to be performed.  In either case,
ticket maintenance is required to keep the ticket database information accurate and
up-to-date.

Ticket maintenance is also referred to as “ticket action.”  For example, if a ticket is
created in order to solve a user’s printing problem, all of the events that take place to
solve the problem are regarded as action performed on the ticket.  Each time an
action is performed in response to a ticket, the action should be entered on the ticket.
In addition to tracking the efforts of your support staff, the action entries can be used
to accumulate billable time spent while trying to solve a client’s problem.

Contact details can also be associated with a ticket.  Contact details include
information regarding the person/company for whom the ticket is issued.

The procedures regarding ticket maintenance are discussed in this section.

NOTE:
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To support multiple users, LSC locks the ticket (window) as soon as it is opened
by a user.  This ensures that only one person can save changes to a ticket at
anytime.  When users attempt to edit the same ticket simultaneously, only the
changes made by the “first” user will be effective (the user who locks the ticket).
All other users will be alerted with a message informing them to edit the ticket
later.

Adding Ticket Action

Each time an action is performed in response to a ticket, the action should be entered
for problem tracking and ticket maintenance purposes.  Each new ticket action is
entered into the Add Action dialog box.

Use the following procedure to enter ticket action items.

1. Display the Add Action dialog box.

Use any of the following methods to display the Add Action dialog box, as in
Figure 6-4.

Choose the Add Action button in an open Ticket window to add an
action item to the ticket.
Highlight a ticket in the View Tickets window, and choose the
Action tool bar button to add an action item to the selected ticket.
Highlight a ticket in the View Tickets window, and choose the Add
Action command from the Ticket menu to add an action item to the
selected ticket.
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Figure 6-4: Adding Ticket Action

2. Enter the action details.

Each field in the Add Action dialog box is defined and discussed in the table
below.

Field Description

Action Code Enter the code for the action performed (e.g., CALLBACK,
INVESTIGATE, TO_DO).  An action can be selected from
the drop-down list associated with this field, or one can be
typed in directly if you have been given sufficient user rights
to do so.  (Typing in a new action will add the new entry to
the Action qualification list.)

Person Enter the initials of the LSC staff member performing the
action.  The initials of the user logged in to LSC will display
as the default.  The initials can be selected from the drop-
down list associated with this field, or they can be typed in
directly if you have been given sufficient user rights to do so.

Description Enter a detailed description of the action performed.
Approximately 2 full pages of text can be entered.

Continued...
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Field Description

Date Select the date on which the action is performed.  The current
system date is automatically entered as the default which can
be changed by the user.  The date is entered in
YYYY/MM/DD format where Y=year, M=month and
D=day.  (Refer to the section on page 129 for procedures on
editing date values.)

Time Select the time at which the action is performed.  The current
system time is automatically entered as the default which can
be changed by the user.  The time is entered in HH:MM
format where H=hour and M=minute.  Use the up/down
arrow buttons to scroll to a new desired time, or directly type
in a new time.

Time Spent Enter the time taken to perform the action.  The time is
entered in HH:MM format where H=hour and M=minute
(e.g., 1:23 indicates 1 hour and 23 minutes).  Use the
up/down arrow buttons to scroll to a desired time, or directly
type in the amount of time spent.

Initial
Response

Select the Yes or No button to indicate whether or not the
action being entered is the first action performed for the
ticket.  By default, the Initial Response button is set to No.

NOTES ON THE ADD ACTION DIALOG BOX FIELDS:
a - The hours and minutes entered in the Time Spent field are automatically
accumulated by generating the Daily Action Listing By Person report.  Refer to
Chapter 8 for instructions on generating LSC reports.

b - The Initial Response option is set to ‘No’ by default.  Set this option to ‘Yes’
when entering new actions to determine the amount of time taken to respond to
a ticket.  Generating the Average Initial Response Time reports will
automatically calculate the average time between when the ticket(s) has been
opened and when the inital response(s) has been performed.

HINT:
Create Action entries which maintain various types of information regarding
the ticket.  For example, create an action named CONFIG to be used to describe
a caller’s workstation configuration.  By entering the configuration information
in the Description field, you can then filter the ticket list using the Keyword
Search in Action Description option (e.g., filter all “386” machines).
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3. Choose the Save button.

The new action does not immediately display in the action items area of the
View Tickets window.  Click on the highlighted ticket in the View Tickets
window to update the action items for the selected ticket.

Editing Ticket Action

Existing ticket action entries are edited using the Edit Action dialog box.

Use the following procedure to edit an existing ticket action item.

1. Display the Edit Action dialog box.

Use any of the following methods to display the Edit Action dialog box, as in
Figure 6-5.

Double click on an entry listed in the action items area of the View
Tickets window to edit an action item for the highlighted ticket.
Highlight a ticket in the View Tickets window, and choose the Edit
Action tool bar button.
Highlight a ticket in the View Tickets window, and choose the Edit
Action command from the Ticket menu.

The Edit Action dialog box displays the information entered for the existing
action item.

Figure 6-5: Editing Ticket Action

2. Modify the action details.
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The fields in the Edit Action dialog box are identical to those in the Add Action
dialog box.  Refer to the table on page 123 for details on each field.

To modify the information entered in a field, move the typing cursor into the
field and enter the new information.  Selecting a new item from a drop-down list
will automatically enter the new item into the field.

Pressing the <TAB> key will move the cursor from field-to-field within this
dialog box.

3. Choose the Save button.

The modified action information displays in the action items area of the View
Tickets window.

Deleting Ticket Action

Use the following procedure to delete an existing ticket action item.

1. From the action items area of the View Tickets window, highlight the action
entry to be deleted.

2. Choose the Delete Action command from the Ticket menu, or choose the Delete
Action tool bar button.

You are prompted to confirm the deletion.  Choose the Yes button to delete the
selected action entry, or choose the No button to cancel the delete action.

The deleted action entry is removed from the LSC ticket database and is no
longer listed in the action items area of the View Tickets window.

Maintaining Contact Details

Contact details can be entered and associated with a ticket.  For tickets that are
created in response to a customer problem or issue, a contact name and number
becomes vital to the quality of the support provided by your staff.

Contact details include the address, fax and Email information for a specific
Company ID.  For example, assume that you frequently create tickets for the Blue
Ribbon company which has three office locations.  Three Company IDs are set up:
Blue Ribbon-NY, Blue Ribbon-NJ, and Blue-Ribbon-CT.  By simply selecting one
of the Blue Ribbon company IDs, the desired contact information is associated with
the ticket.

NOTES:
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a - Company IDs are set up by choosing the Setup Company command from
the Administration menu (refer to the detailed procedures in “Company IDs” in
Chapter 5.

b - Changing the information in the Contact Details dialog box will update the
Company ID data throughout the LSC database.  All existing and future tickets
will reflect the updated information.

Use the following procedure to enter and maintain contact details to be associated
with a ticket.

1. Highlight a ticket in the View Tickets window, or open a Ticket window for
which contact details are to be entered.

2. Choose the Contact tool bar button, or choose the Contact Details command
from the Ticket menu.

The Contact Details dialog box displays, as in Figure 6-6.  Any contact
information previously entered for the selected ticket will also display.

Figure 6-6: Entering Contact Details for a Ticket

3. Enter or modify the contact information to be associated with the selected ticket.

The fields in this dialog box correspond to a Company ID.

Select an existing Company ID to automatically fill in the address
and phone information that has been defined for the selected
Company ID.
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Enter new company information (new Company ID, address and
phone) to create a new Company ID.
Modify the field data to update the Company ID information.

All fields are optional.

NOTE:
The Company ID field is linked to the Account ID entered in the Ticket window.
For example, assume that the “Blue Ribbon” account is set up with “Blue
Ribbon-NY” as its Company ID.  In this case, when “Blue Ribbon” is entered in
the Account ID field in the Ticket window, all contact information for “Blue
Ribbon-NY” will automatically display in the ticket’s associated Contact Details
dialog box.  Refer to Figure 6-7.

Figure 6-7: Contact Details for the Blue Ribbon Account

4. Choose the Save button.

If you have made changes to existing Company ID information, you are
prompted to save the modified information to the Company ID.  Choose the Yes
button to save the changes, or choose the No button to cancel any changes you
have made.

NOTE:
Choosing the Yes button in response to this prompt will update the contact
details information for the Company ID.  The contact details for all new and
existing tickets will reflect the updated information.
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Editing Dates

Throughout LSC, there are several places where the user is able to enter or edit a
date.  In every date field, a pop-up dialog box can be displayed by double clicking in
the field.  These date fields include:

the Ticket window’s “Opened On” and “Closed On” fields
the Add Action and Edit Action dialog box “Date” field
the Filter Ticket List dialog box “Open Tickets From/To” and “Closed
Tickets From/To” fields

Scrolling to a New Date or Time

Every date and time field has “spin” buttons that can be used to change the value
entered in the field.  These spin buttons look similar to scroll buttons and are useful
when you want to change the existing value to one that is already close to the
desired value.  For example, if “1994/01/15” is entered in the date field, click on
“1994”, and then choose the up scroll button to quickly change the date to
“1995/01/15.”

Remember, first click on the part of the value to be changed (e.g., year/month/day or
hour/minute), and then choose the desired spin direction (either up or down).
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Moving to a New Date

Double clicking in a date field displays a calendar similar to Figure 6-8.

Figure 6-8: Modifying a Date Field

If there is a date value in the field when you double click, then that date will be
reflected in the dialog box.  For example, when the calendar in Figure 6-8 was
displayed, the value “1993/11/05” was entered in the Date field.  If there is no date
value in the field when you double click, then the current system date will be
reflected in the calendar.

Use the following procedure to change a date value using the calendar.

1. Double click in the Date field.

The calendar displays, as in Figure 6-8.

2. Modify the Year, Month or Day.

To modify the year value, choose the left or right arrow buttons next
to the year date.  (In Figure 6-8, the year date is “1993” displayed at
the top of the dialog box.  Choose the left arrow button to change the
year to 1992; choose the right arrow button to change the date to
1994.)
To modify the month value, choose the left or right arrow buttons
next to the indicated month.  (In Figure 6-8, the month is
“NOVEMBER.”  Choose the left arrow button to change the month
to OCTOBER; choose the right arrow button to change the month to
DECEMBER.)
To modify the date, choose a new date by clicking on a new date
number.  (In Figure 6-8, the currently selected date is “5.”)

3. Choose the OK button.
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The calendar closes, and the selected date value is entered into the Date field.

Investigating
LAN Support Center provides the capability for extensively tracking and managing
various types of events.  In some instances, investigation may be required to obtain
additional information to resolve a problem or handle a support call.  LSC lets you
smart-launch into other McAfee applications installed on your network to take
advantage of the applications’ network management capabilities.

The McAfee products accessible from within LSC are:

BrightWorks - McAfee’s software management solution which
integrates SiteMeter software metering with LAN Inventory asset
management and adds software distribution capabilities.
SiteMeter Administration  - McAfee’s software metering and virus
protection program which maximizes the legal and productive use of
your software.
SiteMeter Usage Monitor  - SiteMeter’s Usage Monitor which displays
information regarding an application’s current use.
SiteMeter Reports  - SiteMeter’s Reporting module which lets you
generate reports containing information regarding software metering and
the virus protection established for your network.
LAN Inventory - McAfee’s asset management program which collects
and manages detailed inventory data for your local area network(s).
(Workstation hardware and software configuration information can be
accessed to help troubleshoot problems.)
NetRemote - McAfee’s remote control program which enables control
over another user’s workstation for the purpose of performing
diagnostics.

NOTES:
a - For detailed information on the individual McAfee products, refer to the
documentation provided in each product package.

b - The Investigate option requires that a search path be established to all of
the McAfee products.
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Smart-Launching

Use the following procedure to smart-launch into another McAfee application.

1. Choose the LSC Investigate tool bar button.

You can also choose the Investigate command from the Ticket menu.  In either
case, the Smart-Launch McAfee Applications dialog box displays.

Only the applications that are in your search path are accessible from the Smart-
Launch dialog box.  All other application options are disabled.

The Context area of the Smart-Launch dialog box displays the username and
network address of the currently open and active LSC Ticket window.  The
Username is obtained from the ticket’s First Name field, and the Station Address
is obtained from the ticket’s Network Address field.

2. Select a McAfee application, and choose the OK button.

The selected application launches, as follows:

BrightWorks - BrightWorks is launched and displays the
administration console.  Use the BrightWorks console to perform
software metering, asset management and software distribution.
SiteMeter Administration  - SiteMeter is launched and displays the
administration console.  Use the SiteMeter console to investigate
software usage activity and detect corrupted files.
SiteMeter Usage Monitor  - SiteMeter is launched and displays the
SiteMeter Usage Monitor for the file server associated with the
Network Address in the currently active LSC Ticket window.  If the
active Ticket window does not contain the network address of a
server, then the SiteMeter administration console displays.  Use the
SiteMeter Usage Monitor to see which users are using which
applications.
SiteMeter Reports  - The SiteMeter reporting module displays in a
DOS box.  Use SiteMeter Reports to generate reports with
information regarding software metering and the virus protection
established for your network.
LAN Inventory - LAI is launched and displays the inventory details
associated with the First Name and Network Address fields in the
currently active LSC Ticket window.  Use LAI to investigate the
hardware and software configuration of a workstation to determine
the cause of a problem.
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NetRemote - NetRemote is launched and positioned to call the
workstation associated with the Network Address in the currently
active LSC Ticket window.  Use NetRemote to take control over a
workstation experiencing problems.

3. Use the McAfee application to investigate the problem.

For instructions on using the application, refer to the manual included in each
product package.

4. Exit the application.

For instructions on exiting the application, refer to the manual included in each
product package.

Upon exiting the application, you are returned to LSC.

This ends the chapter on creating and maintaining LSC work tickets.  Refer to
the next chapter for procedures on viewing ticket data.
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Chapter 7  Viewing Ticket Data

The previous chapter discussed the procedures for creating and managing ticket
information.  This chapter discusses the various methods available for viewing ticket
information.

Introduction
LAN Support Center provides various methods for viewing ticket information.  An
entire database of ticket information and the tickets’ actions can be viewed via the
View Tickets window; additionally, specific ticket information can be viewed via the
Ticket window.  (Refer to the overview of these windows in “The View Tickets
Window” in Chapter 4.)

To accommodate users who are responsible for working on a particular type of
ticket, the information displayed in the View Tickets window can be filtered to
display only the tickets matching specific filter criteria.  For example, if Sue is only
responsible for the tickets that have an URGENT priority, then Sue may only want
those tickets to display in her View Tickets window.  Similarly, if Anna is
responsible for scheduling training classes, then Anna may only want to view the
tickets which pertain to the Training Department.

The various methods for managing the LSC ticket data display are discussed in this
chapter.

What’s in this Chapter

The following chart describes the sections in this chapter:

SECTION DESCRIPTION
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Filtering the View
Tickets Window
Display

Provides procedures for applying filter criteria against
the View Tickets window.

Sorting the View
Tickets Window
Display

Provides procedures for defining the order in which the
tickets are listed in the View Tickets window.

Custom Ticket Views Provides procedures for creating customized views of
the information which displays in the View Tickets
window.

Ticket Databases Provides procedures for viewing either the current
ticket database or an historical ticket database.

Filtering the View Tickets Window  Display
Applying filter criteria to the View Tickets window causes LSC to display only
those tickets that match the defined filter information.  When no filter criteria is
defined, all tickets in the LSC database are listed in the View Tickets window.

Filtering the Ticket List

Use the following procedure to define filter criteria and narrow down the number of
tickets that display in the View Tickets window.  Filter criteria can be applied to the
current and historical ticket databases.

1. Choose the View tool bar button to display the View Tickets window.

The View Tickets window must be open to define filter criteria.

2. Choose the Filter tool bar button.

You can also choose the Filter command from the View menu.  The Filter
Ticket List dialog box displays, as in Figure 7-1.  If filter criteria have already
been applied to the View Tickets window, then the defined criteria will display
in the Filter Ticket List dialog box.
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Figure 7-1: The Filter Criteria Applied Against the View Tickets Window

NOTE:
If your LSC database labels have been modified, the field names and definitions
for your Filter Ticket List dialog box will be different.  For more information on
labeling, refer to “Database Labeling” in Chapter 5.

3. Define the filter criteria.

Many of the fields in the Filter Ticket List dialog box are identical to the fields
in the Ticket window.  For example, entering KELLY in the First Name field of
the Filter Ticket List dialog box will instruct LSC to include all tickets that have
KELLY in the First Name field of the Ticket window.  Similarly, many fields
have drop-down lists from which items can be selected.  For example, choosing
the Product Category field’s drop-down list displays a list of entries that have
been defined for the Product Category qualification list.  Clicking on an entry in
the drop-down list places the chosen entry in the selected field.

Field Description Corresponding
Field Location

Account ID From the drop-down list, select one
Account ID.

Add/Edit Account
dialog box; Ticket
window

Ticket # Enter a specific ticket number. Ticket window title
bar
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First Name From the drop-down list, select one
first name.

Ticket window

Last Name From the drop-down list, select one
last name.

Ticket window

Department From the drop-down list, select one
department.

Ticket window

Phone Enter a specific phone number. Ticket window

Assigned to From the drop-down list, select one
staff member to whom tickets were
assigned.

Ticket window

Issue Type From the drop-down list, select one
ticket issue type.

Ticket window

Action
Code

From the drop-down list, select one
action code.

Add/Edit Action
dialog box

Continued...
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Field Description Corresponding
Field Location

Network
Address

From the drop-down list, select one
network address.

Ticket window

Problem
Type

From the drop-down list, select one
problem type.

Ticket window

Product
Category

From the drop-down list, select one
product category.

Ticket window

Cross
Reference

Enter specific cross reference
information.

Ticket window

Company
ID

From the drop-down list, select one
company ID.

Add/Edit Company;
Contact Details
dialog box

Priority Place a checkmark in the priorities to
be included in the filtered view.  (At
least one Priority must be selected.)

Ticket window

Keyword
search in
Problem
Description

Enter a word or phrase to use in a
context sensitive search in the
Problem Description field of the
Ticket window.  Wildcards searches
cannot be performed.

Ticket window

Keyword
search in
Action
Description

Enter a word or phrase to use in a
context sensitive search in the
Description  field of the Add/Edit
Action dialog box.  Wildcards
searches cannot be performed.

Add/Edit Action
dialog box

Open
Tickets
From/To

Enter an optional date range to restrict
the number of tickets which apply.
(Refer to “Maintaining Ticket
Information” in Chapter 6 for
procedures on editing date values.)

Ticket window
(tickets having an
Open Status)

Closed
Tickets
From/To

Enter an optional date range to restrict
the number of tickets which apply.
(Refer to “Maintaining Ticket
Information” in Chapter 6 for
procedures on editing date values.)

Ticket window
(tickets having a
Closed Status)
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NOTES ON THE FILTER TICKET LIST DIALOG BOX:

a - The <All> entry causes the field to be ignored in the filter definition.

b - The <Blank> entry includes those tickets having blank corresponding fields.

c - Wildcards are not allowed in any of the filtered fields.

d - When entering a date range, the To date must be equal to or later than the
From date.

e - At least one Priority must be selected.

4. Choose the OK button.

The ticket information is filtered, and only those tickets that match the defined
criteria will display in the View Tickets window.

The View Tickets window in Figure 7-2 illustrates the application of a filter
which specified the entry ‘LEECH’ in the Last Name field.

Figure 7-2: A Filtered List of Tickets

Sorting the View Tickets Window  Display
Defining a sort order for the tickets in the View Tickets window instructs LSC to list
the tickets according to a new sort order method.  Depending on the selected sort
order, up to three sort criteria can be defined.  For example, if the primary sort key is
defined as Assigned To, then the tickets can be further sorted according to Priority
and then Problem Type.  Given this sort order definition, the tickets in the View
Tickets window would be sorted as in Figure 7-3 below.
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In Figure 7-3, tickets are first listed according to the alphabetic order of the Assigned
To field.  The tickets are then sorted according to Priority (see note below) and
finally sorted according to the alphabetic order of the Problem Type field.

Figure 7-3: A Re-Sorted List of Tickets

NOTES:
a - Sorting by Priority will result in the tickets appearing in the following
order: URGENT, IMPORTANT, NECESSARY, DESIRED.

b - Sorting by Date will result in the tickets being listed in ascending date order
(i.e., older dates are listed first).

Sorting the Ticket List

Use the following procedure to define the sort order of the tickets in the View
Tickets window.

1. Choose the View tool bar button to display the View Tickets window.

The View Tickets window must be open to define a sort order.

2. Choose the Sort tool bar button.

You can also choose the Sort command from the View menu.  The Select Sort
Criteria dialog box displays, as in Figure 7-4.  If a sort order has already been
applied to the View Tickets window, then the defined sort criteria will display in
the Select Sort Criteria dialog box.
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Figure 7-4: Selecting Sort Criteria

NOTE:
If your LSC database labels have been modified, the sort order names in your
Select Sort Criteria dialog box will be different. For more information on
labeling, refer to “Database Labeling” in Chapter 5.

3. Define the sort order.

Each Sort # field has a drop-down list from which the sort criteria can be
selected.  Depending on the selected sort order, up to three sort criteria can be
defined.

The following table lists the fields that can be sorted and describes the sort
result.

Sorted Field Sort Method

Assigned To Alphabetical - from A to Z

Closed Date Numerical - increasing date order

Department Alphabetical - from A to Z

Issue Type Alphabetical - from A to Z

Last Name Alphabetical - from A to Z

Opened Date Numerical - increasing date order

Priority Ordered according to: URGENT, IMPORTANT,
NECESSARY, DESIRED

Continued...
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Sorted Field Sort Method

Problem Type Alphabetical - from A to Z

Product Category Alphabetical - from A to Z

Ticket # Alphanumerically - from A to Z for the first three
characters and then from 1 to xxx

4. Choose the OK button.

The tickets in the View Tickets window are sorted according to the defined sort
order.

Custom Ticket Views
A custom ticket view is a cross section of the tickets in the LSC database.  Custom
ticket views selectively display tickets that meet specific filter criteria, and as a
result, they narrow down the number of tickets that display in the View Tickets
window.  Creating a custom ticket view is identical to applying filter and sort
criteria; however, a custom view is saved and can be added to the View menu.

LSC provides several pre-defined ticket views which cannot be modified or deleted.
Choosing the View menu displays the following pre-defined view options:

Opened Assigned Tickets by Date
Opened Assigned Tickets by Priority
All Opened Tickets by Date
All Opened Tickets by Priority
All Closed Tickets by Date
All Tickets by Date

Choosing a view option filters the View Tickets window data and displays only
those tickets that apply to the selected view option.

LSC also allows users to create their own customized views of the ticket data.
Ticket views are created by defining filter criteria and a sort order to be applied to
the tickets listed in the View Tickets window.  For example, assume that Karen only
wants to view the tickets that have been assigned to her.  Furthermore, Karen wants
the tickets to be listed in ascending date order.  In this case, Karen would define a
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filter which included only the tickets that have KRN in the ‘Assigned To’ Ticket
window field (i.e., Karen’s login initials), and she would specify ‘Opened Date’ as
the primary sort order.  Karen would then save her customized view as “Karen’s
View.”

Creating Custom Ticket Views

Creating a custom ticket view narrows down the number of tickets that display in the
View Tickets window, thereby, allowing the support staff to view only the tickets
that pertain to them.

The procedure for creating a custom ticket view incorporates the procedures for
“Filtering the Ticket List” and “Sorting the Ticket List” discussed on pages 135 and
140, respectively.

NOTE:
To accommodate the limited length of a pop-up menu, the maximum number of
custom views that can appear on the View menu is ten (10).

Use the following procedure to create a custom ticket view.

1. Choose the Custom View Settings command from the Administration menu.

The Custom View Settings dialog box displays, as in Figure 7-5.  This dialog
box list any custom views that have already been defined.

NOTE:
Because the pre-defined LSC custom views cannot be edited or deleted, they are
not listed in this dialog box.

Figure 7-5: The List of Custom Views
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2. To define a new custom view, choose the Add button.
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The Add View Name dialog box displays, as in Figure 7-6.

Figure 7-6: Defining the New View

3. In the View Name field, type the name to be assigned to the new view.

All typed characters are valid.  The view name is automatically entered as
uppercase.

4. To define the filter criteria for the new view, choose the Filter button.

The Filter Ticket List dialog box displays, as in Figure 7-7.

Figure 7-7: Defining Filter Criteria for a Custom View

5. Define the filter criteria, and choose the OK button.

Detailed procedures for defining filter criteria are discussed on page 135.  Upon
pressing the OK button, you are returned to the Add View Name dialog box.

6. To define the sort order for the new view, choose the Sort button.
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The Select Sort Criteria dialog box displays, as in Figure 7-8.

Figure 7-8: Defining Sort Criteria for a Custom View

7. Define the sort order, and choose the OK button.

Detailed procedures for defining sort order are discussed on page 140.  Upon
pressing the OK button, you are returned to the Add View Name dialog box.

8. To include the new view name on the LSC View menu, check the Include on
Menu option.

Click in the option box to place a checkmark in the box and enable the option.
Including the view name on the View menu allows for quick access to the view.

In Figure 7-9, KAREN’S VIEW has been included on the View menu.

Figure 7-9: A Custom View Added to the View Menu

NOTE:
Selecting the Include on Menu option will cause the view name to display on all
LSC users’ View menus.

9. Choose the OK button.

The new view is added to the list of views in the Custom View Settings dialog
box.
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Maintaining Custom Ticket Views

Custom ticket views can be edited and/or deleted.  Because support staff job
responsibilities and requirements often change, the filter and sort criteria of the
custom views may need to be modified.

Use the following procedure to delete and/or modify custom ticket views.

1. Choose the Custom View Settings command from the Administration menu.

The Custom View Settings dialog box displays listing the custom views that
have been defined.

2. To delete a custom view, highlight the view name and choose the Delete button.

A prompt displays asking you to confirm the delete action.  Choose the Yes
button to delete the selected view.  (Choose the No button to cancel the delete
action.)

The custom view is deleted from LSC.  The view name is removed from the list
of views in the Custom View Settings dialog box, and it will no longer display
on the View menu.

3. To edit custom view settings, highlight the custom view name and choose the
Edit button.
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You can also double click on the view name to be edited.  The Edit View Name
dialog box displays, as in Figure 7-10.  The name of the selected view is
automatically entered into the View Name field.

Figure 7-10: Editing a Custom View

4. Edit the view criteria.

The View Name, Filter criteria, Sort order and Include on Menu definitions can
be modified.

a - To edit the view name, move the typing cursor into the View Name field
and enter a new name for the custom view.  (When the Edit View Name dialog
box first displays, the entry in the View Name field is highlighted.  Typing a
new name will erase the highlighted name and enter the characters you type.)

b - To edit the filter definition, choose the Filter button.  The Filter Ticket List
dialog box displays showing the view’s defined filter criteria.  Make any
changes to the filter definition, and choose the OK button.

c - To edit the sort order, choose the Sort button.  The Select Sort Criteria
dialog box displays showing the view’s defined sort order.  Make any changes
to the sort order, and choose the OK button.

d - To include/exclude the view name from the View menu, select/deselect the
Include on Menu option.  This option box toggles on and off when selected.

5. After all modifications are made, choose the OK button.

You are returned to the Custom View Settings dialog box.  Any changes to the
view name are reflected in the View Names list.

6. To apply the edited view to the View Tickets window, choose the View button.

The View Tickets window displays with the selected view.
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Ticket Databases
To facilitate efficient disk space usage, LSC lets you archive tickets.  Based on any
number of filtering criteria, tickets can be tagged and moved out of the current
database file and into an “historical” database file.  (The procedure for archiving
tickets is discussed in “Archiving and Restoring Tickets” in Chapter 5.)

Historical database files are not compressed, and therefore, support staff members
can access tickets that are maintained in either the “current database” or an
“historical database.”  The database used during the support staff’s daily operation is
the current database.  New tickets are added to the current database, and open or
active tickets are maintained in the current database.  A historical database may be
referenced for investigative or problem research purposes.

The procedures for loading an historical database and the current database are
discussed in this section.

Viewing Historical Tickets

Use the following procedure to access the tickets maintained in an historical ticket
database file.

NOTES:
a - Historical database files are created upon ticket archiving.  Therefore, the
following procedure can only be performed if you have already archived tickets.
Refer to “Archiving and Restoring Tickets” in Chapter 5.

b - LSC allows you to view either the current or a historical database.  Before
you switch from one to the other, you need to close all ticket windows to prevent
database corruption.

1. Choose the Historical Tickets command from the View menu.
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The Choose Historical Database to View dialog box displays, as in
Figure 7-11.

Figure 7-11: Loading an Historical Database

2. Make selections from the Directories and Drives lists to find the archived file to
view.

For example, choose the Drives down arrow button, and click on Drive G: to
display the directories on drive G.   Then click on a directory name to display
the list of files it maintains.

By default, *.ARC will display in the File Name field, thereby instructing LSC
to list all files in the selected directory that have the extension *.ARC.  You can
modify this field entry if you have saved the historical file with a different
extension (e.g., *.old).

3. Select a file from the File Name list.

Click on a file name to enter the name into the File Name field.

4. To mark the historical file as Read Only, enable the Read Only option.

Placing a checkmark in this field will prohibit any changes to be made to the
tickets in the historical file.

NOTE:
To avoid inadvertently making changes to a historical database file, it is highly
recommended that you mark the file as Read Only when selecting the historical
file to be viewed.

5. Choose the OK button.

The tickets in the selected historical database file are listed in the View
Historical Tickets window, as in Figure 7-12.
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NOTE:
The historical ticket information will display according to the currently defined
filter criteria and sorting options.  To view all tickets in the historical database
file, make sure that filter criteria is not applied to the View Tickets window.

Figure 7-12: Viewing an Historical Ticket Database

Viewing Current Tickets

After viewing tickets in a historical database file, choose the Current Tickets
command from the View menu to view the tickets in the current LSC database.  The
tickets in the current database will display in the View Tickets window.

NOTES:
a - The current ticket information will display according to the currently
defined filter criteria and sorting options.  To view all tickets in the current
database file, make sure that filter criteria is not applied to the View Tickets
window.

b - LSC allows you to view either the current or a historical database.  Before
you switch from one to the other, you need to close all ticket windows to prevent
database corruption.

This ends the chapter on viewing ticket information.  Refer to the next chapter for
instructions on generating reports based on the ticket information being maintained
by LSC.
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Chapter 8  LSC Reports

The previous chapter explained the various methods available for viewing ticket
information.  This chapter discusses LSC’s reporting module and presents
instructions for generating reports based on the ticket information being maintained.

Introduction

What’s in this Chapter

LSC is shipped with several pre-defined reports called “style sheets.”  The style
sheets represent frequently requested reports which can also be customized to
accommodate a specific need.  By performing a “query,” the information included in
a report can be filtered according to virtually any combination of data values. For
example, generating a report based on the All Tickets List by Date style sheet
includes all tickets being maintained in the current LSC database. The information
contained in the report can be filtered to include only the open tickets regarding
printing problems specific to the Lotus spreadsheet.  Queries can be saved and
attached to any number of style sheets.

In addition to customizing the pre-defined style sheets, reports that are created using
the Crystal Reports software can be added into the LSC system.  These added reports
can be customized, renamed and/or deleted.

NOTE:
The Crystal Reports software is installed using the LSC install procedure.  A
Crystal Reports program icon is added to the McAfee Program Manager
group.  Procedures for using Crystal Reports are presented in Part Two of this
manual.

The following chart describes the sections in this chapter:

SECTION DESCRIPTION

Using Pre-defined
Report Style Sheets

Provides the procedures for generating pre-defined reports
and selecting an output option.
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Using Queries to
Customize Reports

Provides the procedures for creating queries to filter report
data, applying queries to reports and saving the report
under a new name.

Adding New
Reports

Provides the procedures for adding and managing new
reports.

Sample Reports Describes the contents of the pre-defined LSC reports and
provides an illustration of each report type.

Using Pre-defined Report Style Sheets
The pre-defined style sheets supplied with LSC represent frequently requested
reports.  A pre-defined report can be generated “as is,” or it can be customized by
applying queries which further define the data to be included in the report.

This section lists the procedures for generating the reports listed in the Choose
Reports dialog box.  (The procedures for creating, applying and managing queries
are discussed in the next section of this chapter.)

NOTES:
a - The pre-defined LSC report style sheets cannot be renamed or deleted.

b - If you have modified the LSC database labels, the report names listed in the
Choose Report dialog box will reflect the current labels.

Printing  Reports

Use the following procedure to generate the reports listed in the Choose Reports
dialog box.  (Refer to the other sections in this chapter for procedures on
customizing the reports.)

1. Choose the Reports tool bar button.

You can also choose the Choose Reports command from the Reports menu.
The Choose Report dialog box displays, as in Figure 8-1.
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Figure 8-1: Choosing a Report to Print

2. From the list of Report Names, select the report you want to generate.

Your selection is highlighted. The default selection is the first report name in the
list.

3. Select the report’s destination.

The following destinations are available:

Printer - Sends the report to the printer and uses the currently
defined Printer Setup parameters.  (Refer to “Printer Setup and
Administration” in Chapter 5 for instructions on administering your
print setup.)
Screen - Sends the report to a window on your screen.  Use the
scroll bars to scroll through the report contents.  If desired, choose
the Print Report command from the File menu to send the report to
the printer.  Double click on the control menu button in the report
window to close the window when you are finished.
File - Sends the report to a file.  When this option is selected, the File
Format options become available.  The format options are:

- Text - output file is saved in ASCII format.
- Comma Delimited  - output file is saved in a comma delimited

format in which commas are used to separate the fields.
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4. Choose the OK button to initiate the creation of the report.

A Printing dialog box displays indicating the status of the report generation.

NOTES ON PRINTING:
a - If the report is sent to a file, you are prompted to enter a file name.  Enter
the file name and destination, and choose the OK button.  The Printing dialog
box displays even if the report is being sent to a file.

b - If the report is sent to the screen, the resulting report displays in a Crystal
Reports dialog box.  The buttons at the top of the dialog box from left to right
can be chosen for page scroll to first page, previous page, next page, last page,
stop scroll, page magnification and route report to printer.  For detailed
instructions on using the Crystal Reports software, refer to Part Two of this
manual.

c - After a report has been sent to the screen, choose the Print Report command
from the File menu to send the report to the printer.  (The report window must
be open or minimized for the command to work.)

d - If the report is sent to the printer, a “background report“ is automatically
printed after the selected report.  The background report lists the queries that
have been applied to the selected report.

e - Temporary files are created when reports are generated and routed to the
screen or to a printer.  As a result, if you have limited system resources (e.g.,
disk space or system memory), it is recommended that you apply a query to the
report to narrow down the number of applicable records.  Refer to the
procedures on page 156 for instructions on applying a query to a report.

f - You must be captured to a queue when printing on a network.

Using Queries  to Customize Reports
Queries can be defined and applied against a report to act as a filter for the data
gathered from the LSC database.  Queries can be saved and applied to any number
of reports.

This section lists the procedures for:

Applying a query to a report
Customizing report style sheets
Removing a query from a report
Creating a new query
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Editing a query
Deleting a query

Applying a Query to a Report

Use the procedure below to apply an existing query to a report.

1. Choose the Report tool bar button.

The Choose Report dialog box displays, as in Figure 8-2.

Figure 8-2: Choosing a Report to Print

2. From the list of Report Names, select the report to which you want to apply a
query.

Your selection is highlighted, and the Current Query field displays the name of
the query currently applied to the selected report.

NOTE:
The <None> entry in the Current Query field indicates that no query is
currently applied to the report.

3. Choose the Select button to the right of the Current Query field.
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The Select Query dialog box displays listing all queries, as in Figure 8-3.  (Refer
to page 159 for instructions on creating new queries if only the <None> entry
appears in this list.)

Figure 8-3: Selecting a Query to Apply to a Report

4. Select the query name from the Available Queries list, and choose the Apply
button.

To select a query name, point to the query and click the left mouse button.
Upon choosing the Apply button, the Select Query dialog box closes and the
selected query name is placed into the Current Query field of the Choose Report
dialog box.  The LSC database records are sorted, and only the records that
match the query’s specified filter criteria will be included when the report is
generated.

NOTE:
Before applying a query, make sure that the correct report name is highlighted
in the Choose Report dialog box.

Customizing Report Style Sheets

A pre-defined LSC report can be customized by first assigning a unique name to the
report and then applying a query which filters the data to be included in the new
report.

NOTE:
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For instructions on using the Crystal Reports software to create new inventory
and distribution reports, refer to Part Two of this manual.  For instructions on
incorporating the new Crystal reports into LSC, refer to page 163.

Use the following procedure to customize a pre-defined style sheet.

1. From the list of Report Names in the Choose Report dialog box, select the report
on which you want to base the new report.

Select a report that consists of fields and data which are similar to the report to
be created.

2. Choose the Add button in the Choose Report dialog box.

The New Report dialog box displays, as in Figure 8-4.

Figure 8-4: Naming a Customized Report

3. Enter a new unique name in the Report Name field.

The report name must be unique.

4. Select a file name to be associated with the new report.

All report files in your LSC program directory are listed below the File Name
field.  Because the new report is to be based on the report selected in the Choose
Report dialog box, click on the file name of the selected report.  (The list of
reports and their file names are provided on page 165.)

For example, if you were customizing the Open Tickets by Date report, then you
would select the OPNDATE.RPT file name.

5. Choose the OK button to save the new report information.
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The New Report dialog box closes.  The new report name is added to the list of
reports in the Choose Report dialog box.

At this point, the new report contains the same information as the report on
which it is based.  Applying a query to the report will customize the data to be
included in the new report.  Refer to the procedure on page 156 entitled
“Applying a Query to a Report.”

Removing a Query from a Report

Use the following procedure to remove a query from a report.

1. From the list of Report Names in the Choose Report dialog box, select the report
for which you want to remove the query.

Your selection is highlighted, and the Current Query field displays the name of
the query currently applied to the selected report.

2. Choose the Select button to the right of the Current Query field.

The Select Query dialog box displays.

3. Select the <None> query name, and choose the Apply button.

The Select Query dialog box closes.  The filter criteria is removed and all
records that apply to the report will be included when the report is generated.

Creating a New Query

Use the following procedure to create a new query.  The procedure assumes that you
have already chosen the Select button in the Choose Report dialog box to display the
Select Query dialog box.

1. Choose the Add button in the Select Query dialog box.

The Add Query dialog box displays, as in Figure 8-5.  Press the <TAB> key to
move from field to field within this dialog box.
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Figure 8-5: Defining a Query

2. Enter a Query Name and define a filter entry.

The purpose of each filter entry is to narrow down the list of records to be
included in a report.  If more than one filter entry is defined, the entries are
“linked” using either the AND or OR relationships.

For example, assume the following two filter entries:
Assign To = DAN
Action Code = Callback

If the entries are linked with the AND relationship, only the tickets that satisfy
both criteria (i.e., all tickets assigned to Dan which have the callback action
code) are included in the report definition.

If the entries are linked with the OR relationship, the tickets that satisfy either
criteria (i.e., all tickets assigned to Dan and all tickets with the callback action)
are included in the report definition.

For each filter entry, specify the following:

Query Name - Enter a query name up to 80 characters in length.
Component - Choose a component from the LSC database to use as
the filter basis.  Select a component from the drop-down list
associated with this field (e.g., Action, Cross Reference, Ticket #).
Operator - Choose an operator from the drop-down list associated
with this field (e.g., = - equal to, < - less than, <> - not equal to).
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Description - If desired, choose a description of the component from
the drop-down list associated with this field.  The items which are
included in this list depend on the selected component.  For example,
“Desired” and “Urgent” display as Descriptions if Priority is entered
in the Component field; “True” and “False” display if Ticket Closed
is entered in the Component field.
Query Link - Specify the relationship between the filter entries (e.g.,
Assigned To = DAN OR Action = Callback).  The link options are
AND and OR.

NOTE:
All filter entries in a query must have the same Query Link type (e.g., all entries
will be linked by AND or all entries will be linked by OR).

3. Choose the Insert button to accept the filter entry definition.
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The entry is added to the Current Query list in the Edit Query dialog box.  The
Edit Query dialog box should look similar to Figure 8-6 below.

Figure 8-6: The Filter Criteria for a Query

4. If required, insert additional filter entries.

Repeat steps #2 and #3 above.

NOTE:
To add a filter entry between existing entries, first highlight the filter entry line
in the Current Query list where you want the new entry to be placed.  The new
defined entry is placed in the highlighted position.

5. When all filter entries are defined, choose the Save button.

The query is saved and added to the Available Queries list in the Select Query
dialog box.  The new query can now be applied to a report.

Editing a Query

Use the following procedure to edit the definition of an existing query.  The
procedure assumes that you have already chosen the Select button in the Choose
Report dialog box to display the Select Query dialog box.

1. Select a query from the Select Query dialog box, and choose the Edit button.
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The Edit Query dialog box displays showing the query’s filter entries.

2. Modify the information, and choose the Save button.

For instructions on modifying the filter entries, follow the procedure above
entitled “Creating a New Query.”

To delete a filter entry, highlight the entry in the Current Query List and choose
the Delete button.

NOTE:
To add a filter entry between existing entries, first highlight the filter entry line
in the Current Query List where you want the new entry to be placed.  The new
defined entry is placed in the highlighted position.

Deleting a Query

Use the following procedure to delete an existing query.  The procedure assumes
that you have already chosen the Select button in the Choose Report dialog box to
display the Select Query dialog box.

1. Select the query to be deleted from the Select Query dialog box, and choose the
Delete button.

A prompt displays asking you to verify the delete action.  Choose the Yes
button to delete the query.  Choose No to cancel the delete action.  The query is
removed from the Available Queries list.

NOTE:
Queries that are currently applied to an LSC report can be deleted.

Adding New Reports
Additional reports can be incorporated into LSC through the use of the Crystal
Reports software.  Queries can also be applied to the new reports, and once added,
the reports can be renamed and/or deleted.

NOTE:
The Crystal Reports software is installed using the LSC install procedure.  A
Crystal Reports program icon is added to the McAfee Program Manager
group.  Procedures for using Crystal Reports are presented in Part Two of this
manual.
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Adding Reports

New reports that have been created using the Crystal Reports software can be added
into LSC by using the following procedure.  All report files (.RPT) must be located
in the LSC program directory.

Use the following procedure to add a new report into LSC.

1. Choose the Reports tool bar button.

The Choose Report dialog box displays.

2. Choose the Add button.

The New Report dialog box displays.

3. Enter the Report Name of the report to be added.

The name entered in this field is the name that will display in the Choose Report
dialog box.

 4. Select the File Name, and choose the OK button.

Select the .RPT file name to be added into LSC.  (The .RPT files that display are
located in the LSC program directory.)  The selected file will be associated with
the Report Name.

Renaming Added Reports

Use the following procedure to rename a Crystal report that has been added into
LSC.

1. Choose the Reports tool bar button.

The Choose Report dialog box displays.

2. From the list of Report Names, select the report to be renamed and choose the
Rename button.

The Rename Report dialog box displays prompting you to enter a new report
name.

3. Enter the new report name, and choose the OK button.

The new report name displays in the Choose Report dialog box, and the old
name is removed.  All attributes of the old report are preserved in the renamed
report (i.e., the report contents and applied query do not change).
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Deleting Reports

Use the following procedure to delete a Crystal report that has been added into LSC.

NOTE:
A pre-defined LSC report style sheet cannot be deleted; however, a report that
was created using the Crystal Reports software and then added into LSC can be
deleted.

1. Choose the Reports tool bar button.

The Choose Report dialog box displays.

2. From the list of Report Names, select the report to be deleted and choose the
Delete button.

A prompt displays asking you to confirm the deletion.

3. Choose the Yes button to delete the report.

Choose the No button to cancel the delete action.

If deleted, the report name is removed from the Choose Report dialog box.

Sample Reports
There are several categories of pre-defined reports included with LSC.  This section
discusses the types of report categories and provides a sample window which
illustrates the report contents.

NOTE:
If you have modified the LSC database labels, the report names and fields will
reflect the current labels.

The report categories include:

All Ticket Listings
Averaging Reports
Client Listings
Closed Ticket Listings
Open Ticket Listings
Miscellaneous Reports
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All Ticket Listings

The reports in this category include:

Report Name File Name

All Tickets by Account ID ALLACCT.RPT

All Tickets by Assigned To ALLSTAFF.RPT

All Tickets by Date ALLDATE.RPT

All Tickets by Department ALLDEPT.RPT

All Tickets by Priority ALLPRIOY.RPT

All Tickets by Problem Type ALLPBTYP.RPT

Each report is primarily categorized by the label in its name (e.g., by account ID, by
date or by priority).  All tickets are then listed in ascending ticket number order.

Figure 8-7 illustrates the All Tickets by Priority report.

Figure 8-7: All Tickets by Priority Report
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Averaging Reports

The reports in this category include:

Report Name File Name

Average Initial Response Time by Assigned To AINITSTF.RPT

Average Initial Response Time by Problem Type AVEINIT.RPT

Average Time to Close by Assigned To AVESTAFF.RPT

Average Time to Close by Problem Type AVEPBTYP.RPT

Both Average Initial Response reports indicate the average time required for an
initial action to be performed for a ticket.

The Average Time to Close reports indicate the average time required for the tickets
to be closed.

Figure 8-8 illustrates the Average Initial Response Time by Problem Type report.

Figure 8-8: Average Initial Response Time by Problem Type Report
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Client Listings

The reports in this category include:

Report Name File Name

Client Listing by Department CLEDEPT.RPT

Client Listing by Name CLENAME.RPT

Each report lists the detail information for the contact names assigned to an account.
Figure 8-9 illustrates the Client Listing by Name report.

Figure 8-9: Client Listing by Name Report
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Closed Ticket Listings

The reports in this category include:

Report Name File Name

Closed Tickets by Assigned To CLSSTAFF.RPT

Closed Tickets by Date CLSDATE.RPT

Closed Tickets by Department CLSDEPT.RPT

Closed Tickets by Priority CLSPRIOY.RPT

Closed Tickets by Problem Type CLSPBTYP.RPT

Each report is primarily categorized by the label in its name (e.g., by date, by
department or by priority).  All closed tickets are then listed in ascending ticket
number order.  Figure 8-10 illustrates the Closed Tickets by Priority report.

Figure 8-10: Closed Tickets by Priority Report
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Open Ticket Listings

The reports in this category include:

Report Name File Name

Open Tickets by Assigned To OPNSTAFF.RPT

Open Tickets by Date OPNDATE.RPT

Open Tickets by Department OPNDEPT.RPT

Open Tickets by Priority OPNNPRIOY.RPT

Open Tickets by Problem Type OPNPBTYP.RPT

Each report is primarily categorized by the label in its name (e.g., by date, by
department or by priority).  All open tickets are then listed in ascending ticket
number order.  Figure 8-11 illustrates the Open Tickets by Assigned To report.

Figure 8-11: Open Tickets by Assigned To Report
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Miscellaneous Reports

The reports in this category include:

Report Name File Name Description

Daily Action
Listing by Person

ACTLIST.RPT Categorized by LSC staff member and
then by ticket action code.

Monthly
Statistics by
Problem Type

MONPBTYP.RPT Categorized by problem type; lists
statistics for the current month.

Monthly Ticket
Load Statistics by
Problem Type

MONTCKT.RPT Categorized by problem type; lists the
number of new, opened and closed
tickets for the current month.

Ticket Details TCKETDET.RPT Lists the details for each ticket.  Each
ticket detail is listed on its own page.
Use the buttons at the top of the report
window to scroll through the list.

Figure 8-12 illustrates one page of the Ticket Details report.

Figure 8-12: The Ticket Details Report
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Part Two:
Using Crystal Reports
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Notes
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Chapter 9  Introduction to Crystal Reports

This chapter introduces Crystal Reports, shows you how to start the program,
introduces you to some of the things the program can do, and familiarizes you with
some of the “nuts and bolts” of using the program.

About This Part of the Manual
This part of the manual contains all of the information you should need for building
reports quickly and easily using Crystal Reports. It is divided into three appendices:

Chapter Description

Chapter 9:

Introduction to
Crystal Reports

Introduction gives you a brief overview of Crystal
Reports. It familiarizes you with the Crystal Reports
screens, using the mouse, error messages, and the help
facility.

Chapter 10:

Using Crystal
Reports

This chapter conceptually leads you through the process
of creating a report with Crystal Reports. It suggests a
methodology for creating reports starting with nothing
more than a one sentence statement of purpose for the
report.

Chapter 11:

Practical Crystal
Reports

Practical Crystal Reports is a “How to” chapter. It
contains a variety of report creation topics and additional
information on the practical aspects of using Crystal
Reports to solve typical reporting problems.

For information on topics not found in these appendices, refer to the Crystal Reports
Help system.
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This part of the manual assumes that you understand the basic concepts and usage of
Microsoft DOS or PC-DOS, and Windows 3.0 or higher. The procedures also
assume that you will be using a mouse in the creation of your reports. While the
instructions occasionally indicate keyboard methods for using the program, the
instructions are generally mouse-oriented since most Windows users have a mouse.

Special Notations Used in this Part

The following notations are used throughout this part of the manual:

Delete means the Del key on your numeric keypad.
Escape means the Escape or Esc key on your keyboard.
Enter means the Enter, Return, CR or ↵ key, depending on which of
these keys appears on your keyboard.
Click means to click the left mouse button one time.
Double click means to click the left mouse button twice, in quick
succession.
The term Cursor Keys means the Pg Up, Pg Dn, and Arrow Up, Arrow
Down, Arrow Right, Arrow Left, Home, and End keys on your numeric
keypad.
Ctrl+Key, Shift+Key, and Alt+Key are examples of the notation for two
key combinations. They mean to press the first key in the combination
(Control, Shift, or Alt), and, while keeping it depressed, to press the
second key in the combination (designated as Key).
Text enclosed in double brackets (for example, « information » ) is
intended to expand or explain the information that it follows.
Field names in formulas are italicized.
Insert|Formula means to select the Formula option from the Insert menu.
Drag, when used in talking about field boxes, means to position the
cursor on a field box, depress the left mouse button, and keep the button
depressed while moving the field to a new position.
Drag, when used in talking about text, means to depress the left mouse
button and, while it is depressed, move the I -beam cursor across the text
of interest to highlight and thus select it.
Computer type  indicates data that you are to enter using the
computer keyboard. It is also used to show example formulas.
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Starting Crystal Reports
You can start Crystal Reports in two ways:

from the DOS command line
from the Windows environment.

From DOS

To start Crystal Reports (and Windows at the same time) from the DOS command
line, type:

cd

and the name of the directory into which you installed Crystal Reports. For example,
if you installed Crystal Reports in the default Crystal Reports directory, type:

cd \CRW

and then press Enter.

At the prompt, type:

win CRW

and press Enter. Windows and Crystal Reports are both started.

From Windows

Once in Windows, select the group window that holds the Crystal Reports icon.

If you're using a mouse, double click on the Crystal Reports icon to start
the program.
If you're using the keyboard, use the arrow keys to select the icon and
then press Enter.

You can also start Crystal Reports from within Windows by double clicking on the
file name CRW.EXE in the File Manager.
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The Crystal Reports Registration Dialog Box

The Crystal Reports Registration dialog box appears whenever you start Crystal
Reports unless you have registered your copy of the program with the company,
received a serial number, and entered it in the Enter serial number... edit box to
disable this opening dialog box.

There are two good reasons to register your copy of Crystal Reports:

Registration entitles you to technical support should you ever require
assistance in using the product.
Registration assures you that you will be notified whenever the product
is upgraded to offer new features, benefits, and efficiencies.

The Crystal Reports Registration dialog box options are as follows:

Enter serial
number... edit box

Use this edit box to enter the serial number that Crystal
Services sends you when you register the program. Be
careful to enter the serial number correctly.

Proceed to Crystal
Reports button

Use this button to close out the dialog box and go directly
into the Crystal Reports program. The button will be
useful until you receive and enter your registration serial
number. At that time the Crystal Reports Registration
dialog box will no longer appear when you start the
program.

Edit Registration
Info button

Use this button to enter/edit product registration
information. The Edit Registration Info button takes you
to the Crystal Reports Registration dialog box. Use this
dialog box to enter your name, company name, and phone
and fax numbers. Crystal Reports stores this information
and displays it and/or prints it out automatically when you
print out the registration form, call up system information
(via the Help|System Information command), or send in a
technical support request (via the Help|Technical Support
Request command).
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Print Registration
Form button

Use this button to print a copy of the completed
registration form.

How to Register Your Copy of Crystal Reports

Use the following procedure to register your copy of Crystal Reports.

1. Click the Edit Registration Info button.

The Crystal Reports Registration dialog box appears.

2. Enter your name, address, phone, and fax in the edit boxes provided, and click
OK when finished

You are returned to the Crystal Reports Registration dialog box.

3. Click the Print Registration Form button.

Crystal Reports prints out a copy of your completed registration form.

4. Fax the form to Crystal Services at the number that appears on the form, or mail
it to Crystal Services at the address that appears on the form.

5. In a few days, the company will mail or fax you back your serial number.

6. Enter the serial number in the Enter serial number... edit box, and click the
Proceed to Crystal Reports button when finished.

This takes you to Crystal Reports and disables the dialog box so it no longer
appears when you start the program.

Quick Start
If you are an experienced Windows user who wants to get right into the program,
follow these steps to set up a Crystal Reports report for the first time after you install
the program.

1. Start Crystal Reports by double clicking on the Crystal Reports icon in the
Program Manager.

2. Select New Report from the File menu.

3. When the Choose Database File dialog box appears, select the first database you
want to activate for your report and press OK when finished.
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The Crystal Reports Report Editor appears with Page Header, Details, and Page
Footer sections set up on your report template. The sections are all blank
initially. Create your report by inserting and formatting items in each of these
sections.

4. The Insert Database Field dialog box appears on screen with the Report Editor.

The Insert Database Field dialog box displays a list of all of the fields in the
active database. To speed the entry of multiple fields, the box remains on screen
until click on the Done button. You can move the dialog box to a new location
if you wish.

5. Select the first field you want to appear on the report.

A rectangular insertion cursor appears.

6. Position the cursor at the point in the Details section where you want your field
to appear, and click the left mouse button to enter it.

Crystal Reports marks the field position with a rectangular box. The characters
in the box indicate whether the field is text (XXX...), number (555,...), dollar
value ($555,...) date (YYYY-M...), or Boolean (T/F). The number of characters
in the box indicate the number of characters allowed for the field in the database
from which it came.

7. Repeat Steps 5 and 6 until you have placed all the fields you want to place.

8. To create a title, select Insert|Text Field, type in the information you want to
appear, click Accept when finished, and position the field where you want it in
the Page Header section.

You can also insert database fields or special fields in that section from the
Insert menu.

9. To see how your results will print, select Print To Window from the Print menu.
Close the window when you are finished with your review.

10. If you want to:

change the placement or width of a field
format the field
insert a subtotal or grand total for a field
delete a field

click the field box for that field. Black handles appear on the right and
left sides of the field box to indicate that it has been selected.
To change the placement of the field, drag the field box to its new
position using the mouse or the arrow keys. The arrow keys move
the field box one grid position each time you press them.
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To change the width of the field, drag the right or left handle using
your mouse or use a Shift-Arrow combination on your keyboard.
To format or subtotal the field, click the right mouse button while the
cursor is inside the field. A pop-up menu appears listing your various
options.

- To change the font, select Change Font and refine your selection
using the Font dialog box when it appears.

- To change the format (alignment within field; number, currency, or
date display; etc.) select Change Format and refine your selection
using the Field Format dialog box when it appears.

- To insert a subtotal, select Insert Subtotal and refine your selection
using the Insert Subtotal dialog box when it appears. In this dialog
box select the field and the condition that triggers a new subtotal
whenever the field's value changes, and select the sort direction:
Ascending (A to Z, 1 to 9) or Descending (Z to A, 9 to 1). The
program creates a new section to hold the subtotal.

NOTE:
The program automatically sorts the data (based on the field that triggers the
subtotals) before it subtotals. Manually entering a subtotal sort is not necessary.

- To insert a grand total, select Insert Grand Total. The program
creates a new section to hold the grand total.

- To delete the field, select Delete Field.

11. To create a formula to make data calculations or comparisons, select Formula
Field from the Insert menu.

Enter a name for your formula in the Insert Formula dialog box, and enter the
formula itself in the Formula Editor when it appears. Enter fields, operators, and
functions by selecting them from their respective scroll lists.

You can get complete information on each available Function and Operator via
the Help button, and you can check your formula syntax via the Check button.
Entering a Crystal Reports formula is similar to entering a formula in a
spreadsheet cell. When finished editing, select Accept and place the formula just
like you do a database field.

12. To change the sort order, select Record Sort Order from the print menu.

Select the field(s) you want Crystal Reports to use for sorting the report data.

13. To change the sort and group by field, select Group Section from the Edit menu.
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Select the group section of interest from the list that appears in the Edit Group
Section (sections) dialog box, and select the new “trigger” field from the Edit
Group Section (edit) dialog box when it appears.

14. If you want to limit your report to specific records (for example, the records of
California customers that have YTD sales greater than $10,000), click the first
field on which you want your selection to be based (in this case the State field)
and choose Select Records from the Print menu or the right mouse button
pop-up menu.

Answer the questions that appear in the Select Records dialog box and click OK
when finished. If your selection is based on more than one field, repeat the
process with the remaining field(s) until you have completed entering your
selection specifications.

15. When finished, you can print your report by selecting Print To Printer from the
Print menu.

About Crystal Reports
Crystal Reports is a powerful yet easy to use program for creating custom reports,
lists, and form letters using data from your existing databases. The program works
by establishing connections with one or more of your databases. Using these
connections as conduits, Crystal Reports draws in the values from database fields
select and uses them in the report, either in their original form or as part of a formula
that generates more sophisticated values.

Crystal Reports was designed to work with all kinds of data: numbers, currency,
text, dates, and Boolean (Yes/No) fields. It has a wide range of built-in tools that you
can use to manipulate that data to fit your needs. Using these tools, you can:

make calculations and comparisons of data values,
calculate subtotals, and grand totals of field values,
calculate group averages, count the records in a group, and test for
minimum and maximum values,
test for the presence of specific values,
present data only if certain conditions are met,
evaluate logical relationships between values,
convert data from one type to another,
merge text with other text,
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merge text with data field data, and
perform numerous other useful, data -related activities.

The data can be placed wherever you want it on the report, highlighted with special
fonts and font sizes. With Crystal Reports, your reports can be as simple or as
complex as your needs demand.

How Crystal Reports Prepares Reports

Crystal Reports prepares reports by reading data in the database files you have
selected and making that data available for use in your report.

If you wish to use data in a single data file, you simply choose that file
when Create the report.
If you wish to use data in multiple data files, you need to select the files
and also to indicate the field or fields in each file that Crystal Reports is
to use to match data.

NOTE:
Crystal Reports does not write data to your original data files. Your original
files remain unchanged using Crystal Reports, no matter how much you might
manipulate the data select.

Databases that Work with Crystal Reports

Crystal Reports can build reports using the standard data files generated by dBASE
for Windows and Paradox for Windows as well as with DOS versions of dBASE and
Paradox.

The Crystal Reports Window
The Crystal Reports window is simple and easy to understand:

the Title Bar appears at the top of the window,
the Menu Bar appears just below the Title Bar, and
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the Button Bar appears just below the Menu Bar.

Title Bar

The Title Bar displays the name of the program running in the window, Crystal
Reports. You can use the title bar to activate the window (if the window is buried in
a cascade of windows) or to move the window (by depressing the left mouse button
with the pointer on the title bar and then, while the button is still depressed, dragging
the window to a new location), or to maximize the window (by double clicking on
the title bar).

The Menu Bar

The Menu Bar is Crystal Reports' command center. Each option on the menu bar
calls up a drop down menu of commands that you can use to create, modify, print,
and save your reports.

Each menu is listed in the table below:

File The File menu includes commands you can use to open, close, and
save files, to save files under a different file name, print the file to a
printer, and create new report files. It also includes a command you
can use to exit Crystal Reports. Additionally it contains a command
that allows you to configure Crystal Reports to your specifications.

Edit The Edit menu allows you to modify aspects of your report. The
menu includes commands you can use to edit formulas, to edit and
delete group sections, and to change summary operations. It also
contains commands for cutting, copying, and pasting text, clearing
(deleting) report elements, toggling the display of field names on and
off, and changing your report title.

Insert The Insert menu is the central menu use for creating reports. The
menu includes commands you can use to insert database fields, text
fields, and formula fields; subtotals, grand totals, summaries (counts,
averages, etc.), and group sections; print date, page number, record
number and group number fields; and graphics, lines, and boxes.

Format The Format menu includes commands for changing the look of the
elements in your report. It includes commands for changing fonts,
and formatting fields, report sections, graphics, lines, and boxes. The
menu also provides commands for adding field borders as well as
background color and drop shadows for your fields.
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Database The Database menu is used to select and delete databases for use
with your reports, to change the alias use to identify the database,
and to link and unlink databases. It also has a command, File
Location, for directing Crystal Reports to look for database files in
new locations. Two verify commands can be used to adapt your
reports to minor changes in database structure.

Print The Print menu includes commands that let you print your report to a
print window, to a disk file, or to a printer, print the report definition
(a report describing your report), select the records or groups to be
included in your report, select the order in which report data is to be
sorted (by record or by group), and select a printer if you want the
report to print on something other than the default printer.

Window The Window menu includes commands that let you rearrange icons
and windows. It also lists the report windows that are open and
includes a command that lets you close all report windows
simultaneously, if desired.

Help The Help menu includes a command that takes you to Crystal
Reports' main help index, a command that will give you information
about the Crystal Reports version you are using, and other
help-related topics.

The Button Bar

Crystal Reports groups several commonly-used commands on a Button Bar that
remains on screen at all times (unless you choose to turn it off).

Each command is represented by an individual button, and each button displays a
graphic that visually describes the command. You activate Button Bar commands by
clicking the appropriate button one time with the left mouse button. The Button Bar
eliminates some of the steps needed to activate the included commands, and it can
thus greatly speed your work in creating reports.
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The Status Bar

The status bar at the bottom of the report window displays valuable information to
help use Crystal Reports more efficiently:

Button bar
functions

When the cursor is over a Button Bar button, the Status Bar
displays a short description of the button's function.

Menu
command
descriptions

When you highlight a menu command, the Status Bar displays a
short description of the command . To highlight a menu
command, click the menu name and move to the command using
the Down Arrow key.

Current
selections

When select or place a graphic, field, text field, graphic line or
box, special field, or formula, the status bar displays the name of
the item selected. It displays:

-  the file name for a graphic,

-  the alias and field name for a field,

-  the text in a text field,

-  the words Line for a line and Box for a box,

-  the field type for special fields (PrintDate, RecordNumber,
etc.)

-  the formula name for a formula.

Graphic
Coordinates

When select or create a bit-mapped graphic, a graphic box, or a
graphic line, the program displays the coordinates for the left,
right, top, and bottom sides of the graphic element.

Right Mouse-Button Capabilities
When you are working in the Report Editor, you can speed up your work
considerably using Crystal Reports' right mouse button capabilities. When the cursor
is positioned on a report element (a field, a group field, a formula, etc.) and click the
right mouse button, Crystal Reports displays a pop-up menu right next to the
element. Unlike Crystal Reports' standard menus that group commands by function
(editing, inserting, etc.), these pop-up menus are element-specific: that is, they
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contain only those commands from Crystal Reports' primary menus that are
available for use with the selected element. The pop-up menus are valuable because:

they display the name and source (alias) of the element at the top  of the
menu so you can identify the elements on your report with a single
mouse click,
they appear right next to the selected element making them quicker and
easier to access than Crystal Reports' main menus,
they contain only the commands you need; you do not need to search for
commands on a more comprehensive menu,
they make it easier to learn Crystal Reports because:
- they eliminate the need to remember where to find a command, and
- because you're dealing with only a compact list of commands, they

make it easier to pick the right one, and
they spotlight the things you can do with an element making it an easier
system to use when you are under pressure or distracted.

Using the Right Mouse Button Menus

Use the following procedure to use the right mouse button menus.

1. Position the cursor on the element of interest.

2. Click the right mouse button.

The pop-up menu appears.

3. Select the command of interest from the pop-up menu.

These options work exactly like the corresponding options that appear on
Crystal Reports' primary menus. For information on using any of these menu
options, see the corresponding option in Crystal Reports Help.

NOTE:
If you have swapped left/right mouse buttons via the Control Panel, the left
mouse button will activate the pop-up menus.

Crystal Reports Report Windows
When a Crystal Reports report appears, it appears in a report window.

A report window has a title bar, minimize and maximize buttons, and a control menu
box like the Crystal Reports window.
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Unlike the Crystal Reports window, the report window does not have its own menu.
Instead, the commands from the Crystal Reports menu remain visible and are active
for the document window.

Also unlike the Crystal Reports window, the document window has scroll bars at the
bottom and along the right hand edge. Using these scroll bars, you can reveal parts
of the document that aren't immediately showing in the window.

Getting Help with Crystal Reports
Crystal Reports offers a comprehensive help system to support you during every
step of the report development process.

Context Sensitive Help

Context sensitive help gives you immediate help with a screen element of interest
(menu command, dialog box, etc.). The program takes you directly to the help
information you seek without the need to traverse the indexing system.

NOTE:
To get help on a specific menu command, click the menu name and then use the
Down Arrow key to highlight the command of interest. Once the command is
highlighted, press F1.

Indexed Help

Indexed help takes you to the help indexing system, a hierarchy of indexes which is
designed to help you target your topic of interest. Using the indexing system, you
can select a broad topic of interest from the first index and then narrow your
selection using the next index that appears, then the next. etc.
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Chapter 10  Using Crystal Reports

This chapter provides a structured approach to preparing reports with Crystal
Reports.

Using Crystal Reports
The approach of this chapter in preparing reports with Crystal Reports includes the
following elements:

deciding on the content of your report,
developing a prototype on paper,
setting up the prototype using Crystal Reports,
manipulating the data with formulas and functions,
grouping, summarizing, and sorting your data,
editing and formatting the data,
specifying the records/groups to be included in the report, and
printing the finished report.

This is not a hands-on chapter, but an important introduction that can make your
report creation work more efficient and more satisfying. The chapter has been
designed to provide you with a conceptual understanding of Crystal Reports as well
as a brief introduction to Crystal Reports' powerful features.

Deciding on the Content of Your Report
Before you do anything else, you should outline the information you want your
report to provide. Use the following list of questions as a guide in making that
outline:

What is the overall purpose of the report?
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Who is going to read the report?
What is the report title going to be?
What information do you need besides the title to identify the report?
- Where is that information to come from?
- If the information exists in a database, what types of fields is the data

stored in: number, text, etc.?
What identifying information do you want to appear at the bottom of
each page?
- Where is that information to come from?
- If the information exists in a database, what types of fields is the data

stored in: number, text, etc.?
What specific data do you want to appear in the body of the report?
- Where is that data to come from?
- Does that data exist in data fields or does it need to be calculated

from data field values?
- What kind of fields is the data stored in: number, text, etc.?
- Do you want to show totals?
- What kind?
- What do you want to total?
What information, if any, do you want flagged on the report?
- How do you want it flagged?
What information do you want highlighted in some way so that it really
stands out?
Do you want the report to be based on all records in the database or only
on specified records?

Purpose

What is the overall purpose of the report?

Reports are management tools. Their purpose is to help individuals quickly grasp the
essential elements and relationships found in raw data so they can make effective
decisions. For a report to be effective, it has to present the right data in a logical
way. If it presents the wrong data or if it presents the right data in a haphazard
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manner, the report may slow the decision making process or even encourage
incorrect decisions.

A good starting place in the development of a report is to write out the purpose of
the report in a sentence or two. The purpose statement helps you focus on your
primary needs, and it gives your report both a starting point and a goal. Here are
some examples of purpose statements:

The purpose of this report is to show monthly and year -to-date sales by
sales rep, compare this year's numbers to last year, and flag reps who are
seriously deficient.
The purpose of this report is to show sales activity for each item in
inventory, and to suggest reorder quantities based on that activity.
The purpose of this report is to calculate bowling averages and handicaps
for each member of the bowling league.

Clarifying the purpose of the report before you start is a critical step in the overall
process. A report without a clear purpose is like a meeting without a clear agenda; it
rambles and accomplishes little.

Readers

Who is going to read the report?

A single report is often used by many individuals. A detailed, company-wide sales
report, for example, may be used by sales reps, the regional sales manager, the
national sales manager, and the Chief Operating Officer (COO).

Each of these individuals will be interested in different aspects of the report.

A sales rep will use the report to evaluate his/her individual sales
performance and to compare that performance to that of other reps in the
region.
The regional sales manager will use the report to evaluate the reps in
his/her region and to compare the region's performance to that of other
regions.
The national sales manager will use the report to evaluate the
performance of his/her regional managers and to compare overall sales to
the current sales forecasts.
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The COO will use the report to evaluate the performance of the Vice
President of Marketing and the sales department as a whole, and to
project such things as manufacturing needs, warehouse locations, etc.

Since each of the users of the report has different interests, it is important to plan the
report so it includes the information each of the users is looking for.

Title

What is the report title going to be?

Write out a working title for your report. You may decide to change it later, but at
least you will have a title to use when creating your prototype report.

Other Header Information

What information do you need besides the title to identify the report?

Are you going to include identifying information in addition to your report title?
You may wish to include the current date, information on who prepared the report, a
block of text to describe the purpose of the report, the range of data covered, etc. If
you are going to include such information, write it down so you can use it in
preparing your prototype.

Header Information Sources

Where is that information to come from?

The information can come from a variety of sources, depending on the kind of
information you plan to use. For example, the current date can be inserted using the
Crystal Reports Insert|Print Date Field command. Information on who prepared the
report might be drawn from individual data fields in the database(s) used. (If it is to
be drawn from a database, what database? Or, what combination of databases?) A
block of text can be created and entered on the face of the report itself. As you begin
to think of where the information is to come from, you begin formally structuring
the report.
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Data Types in the Header

If the information exists in a database, what types of fields contain the data: number,
text, etc.?

Crystal Reports uses different rules for working with different types of data. You
will find it helpful later if you note the data type of each piece of data you plan to
draw from a database.

Footer Information

What identifying information do you want to appear at the bottom of each page
(page number, report name, author's name, “Confidential,” etc.)?

Footer Data Sources

Where is that information to come from?

Data Types in the Footer

If the information exists in a database, what types of fields is the data stored in:
number, text, etc.?

Report Body Data

What specific data do you want to appear in the body of the report?

When you think of a report, it is probably the body of the report that you think of.
The body should contain all the data that you need to fulfill the statement of purpose
you wrote for the report. It should also contain all of the data needed by the various
users that you have identified. You might find it helpful to list first the basic data
that is required to fulfill the purpose statement, and then list the more specific kinds
of data needed by the various users.
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Body Data Sources

Where is that data to come from?

This step requires you to look at the available databases. Crystal Reports allows you
to combine data from different databases to create your reports, so you have a great
deal of flexibility in your work.

Much of the data in a typical report will be taken directly from data
fields. Which data fields will you be using and where are they located?
Other data will be calculated based on data fields. Which data fields will
be used in the calculations?
Still other data will be input directly into the report (headings, text
blocks, etc.). Which data will enter directly on the report, without
drawing it from data fields?

Existing or Calculated?

Does that data exist in data fields or does it need to be calculated from data field
values?

Some report information can be drawn directly from data fields (sales information,
for example); other information will have to be calculated based on data field values
(sales commission, for example, based on the relationship of sales to quota). In your
planning, it can be helpful to segregate or flag data that needs to be calculated from
that which can be used directly.

Data Types in the Body

What kinds of fields contain the data: number, text, etc.?

While it is important to understand data types for all data you will be using, it is of
critical importance that you know the data type for data fields that will be used in
calculations. Functions and operators work with specific kinds of data, so it's
important to know the data type to know which functions and operators you can use
in your calculations.
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Groups

Do you want your data organized into groups? How do you want it grouped? By
customer? By date?

Group Values

Do you want to show a subtotal at the end of each group? A count? An average?
Crystal Reports allows you to specify several kinds of group values.

Group Value Positions

Where do you want the group values to appear. With the group data? With the group
data but on a page separate from other groups? Only at the bottom of the page?

Crystal Reports gives you all of these options.

Grand Totals, Grand Total Averages, etc.

Do you want to total (or average, count, or determine the maximum or minimum
value included in) all the values in any column on your report?

Crystal Reports allows you to do this and place the grand total (or the grand total
average, grand total count, etc.) at the bottom of the selected column.

Flags

What information, if any, do you want flagged on the report?

You may want to call attention to some data by flagging it on your report. For
example, non-moving inventory items are often flagged on inventory reports so they
can be given special attention. If you want any information flagged, identify the
information and the parameters for flagging. Using the inventory report example,
you might want to flag each item that has shown no activity during the last month,
during the last three months, or during some defined period.
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Flag Options

How do you want it flagged?

You may want to flag items with an asterisk or some other symbol, or you may want
a word to appear as a flag. In any case, you should write out flagging instructions so
they are handy.

Highlights

What information do you want highlighted in some way so that it really stands out?

Crystal Reports gives you the opportunity to underline report elements, or to change
the fonts or font size used for specific report items. All of these formatting tools can
be used to highlight key data on a report. If you have data that you want highlighted,
you should write down highlighting instructions so they are handy too.

Record or Group Selection

Do you want the report to be based on all records or groups in the database or only
on specified records or groups?

Crystal Reports gives you the opportunity to base a report on all records in a given
database, or on a limited set of records from the database. Using Crystal Reports you
can select records based on simple date ranges or comparisons, or you can create
complex formulas to identify the records to be included. Take a few minutes to
determine the records needed for your report and list the criteria to be used for
selecting those records.

Sorting

Do you want your data sorted based on record or group values?

Crystal Reports gives you both alternatives.
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Developing a Prototype on Paper
Graphic designers generally begin their work on a magazine cover, brochure, or
display advertisement with a rough pencil sketch. They often use boxes, circles, or
other symbols to represent the graphic elements they intend to include in the final
product, and they often use lines or scribbles to represent text. Doing the rough
design on paper, in pencil, helps them create a “look” for each page. It helps them
find a balanced way of positioning the various elements before they begin working
with sophisticated graphics tools. We think you will find a similar exercise helpful
in designing your Crystal Reports reports.

While a paper prototype is useful regardless of your expertise with Crystal Reports,
it is particularly valuable when you are first learning to use the Crystal Reports
program. With the paper prototype at hand, you can put your full effort into learning
and using the Crystal Reports commands instead of trying to design and learn at the
same time.

Use the following procedure to design a paper prototype with Crystal Reports.

Get paper of the size you'll be using for your finished report.
Position your title and other descriptive header information, using boxes
or lines to represent report elements.
Position your footer information.
Review the page for balance.
Look at the information you intend to include in the body of your report.
- Count the number of fields you will be using and estimate the

appropriate spacing between fields.
- Use rectangles to pencil in the fields using your estimated spacing.
- Change the spacing if necessary.
- Decide on a logical sequence for presenting the report data.
- Label the fields to indicate that sequence.
Use small boxes to indicate group values and totals.
Place some random flags where you want the flags to appear.
Darken any elements you want highlighted so they stand out from the
rest of your prototype.
Review your finished product for look and balance, and make changes as
needed.
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Setting Up the Prototype Using Crystal Reports
Once you have completed your paper prototype, it is a straightforward process to
recreate that prototype in the computer, using Crystal Reports. Before you do, it is
important to understand how Crystal Reports' report editing process works.

NOTE:
This section assumes that you are new to Crystal Reports and that you plan to
build a simple report using data from a single database. No advanced topics are
covered in this section.

When you want to begin a new report, Crystal Reports displays the Choose Database
File dialog box. Use this dialog box to select the database file(s) that contain the data
you want to use in your report. You will first select the directory and, once in the
directory, you can select the database file you identified earlier in Deciding on the
Content of Your Report.

The Report Editor
Once select your database, Crystal Reports displays the Report Editor screen. Use
this screen to insert and format data and to watch your report take shape.

When you open a new report, Crystal Reports automatically creates three sections in
the Report Editor:

A Page header section – this section is generally used for the report title,
field headings, and other information that you want to appear at the top
of each page.
A Details section – this section is the body of the report. The bulk of
your report data will generally appear in this section.
A Page footer section – this section usually contains the page number
and any other information that you want to appear on the bottom of each
page.

The name of each section appears in the gray area to the left of the Report Editor edit
box.

Build your report by inserting data fields, formulas, and other report elements
(record counts, record numbers, etc.) in the Details section of the editor. Use the
Insert menu, in most cases, to select or create the elements you want to insert on the
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report. The Report Editor uses rectangular element markers to indicate the size,
position, and data type of the report elements you have inserted.

You add subtotals (and other group values) by selecting a field to subtotal and
then telling Crystal Reports the conditions that are to generate a new subtotal or
group value (change of customer number, change of sales rep, etc.). Crystal Reports
creates group value sections as needed and places the group value in the section.
Again, Crystal Reports uses rectangular field boxes to represent the group values.

Insert grand totals in the Grand Total section. This section appears when select
the field to total and then select Insert|Grand Total. Crystal Reports uses a
rectangular field box, this time to identify the field in the Grand Total section of the
Report Editor.

You can add freeform text anywhere on the report by positioning the text cursor
in the section in which you want the text to appear, typing in the text, and then using
the Tab key to move it into position. You can also type freeform text in a text field;
this allows you to avail yourself of additional formatting options (alignment, hide
options, etc.).

Auto-Scrolling Capabilities

The Report Editor has auto-scrolling capabilities. That is, whenever the cursor hits
one of the edges of the Report Editor when you are placing, resizing, or moving a
field or drawing a graphic line or box, the Editor automatically scrolls to reveal more
workspace (if more is available).

Resizing Sections

The Report Editor first appears with default section sizes. You can expand or reduce
report sections by dragging the lines that separate the sections. When you position
the I-beam cursor over one of those lines, the cursor changes to a double-arrow
resizing cursor. Once that cursor appears, you can resize as needed. Alternately, to
expand a report section, you can click the section of interest and press Enter as many
times as needed. Once you've expanded a section, you can reduce it by deleting
unneeded lines with the Backspace key.

A Word about Databases, Records and Fields

Before we go any further, a discussion of databases, records, and fields is in order. A
record is the basic building block of a database. Each record contains data about a
single entity (a customer, an order, etc.), and each database contains at least one
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record. The data in each record is stored in fields (holding spaces). Each field holds
one piece of data known as a value. The database from which you will create a
report is a collection of related records. A customer database, for example, is a
collection of records that each contain data on a single customer.

Records and Fields in Row/Column Reports

Think of the data in a database as being stored in horizontal rows and vertical
columns.

CustNumber Fname Lname

01034456 Bill Brown

01034457 Jane Doe

01034458 Bob Jackson

01034459 Mary Jones

The table shows field values for four records from such a database (in this case a
customer database).

Each row represents one record. All of the data in that row is about a
single customer, but the data is broken into three distinct pieces:
customer number, first name, and last name. Each of those pieces
represents a value found in a field on that record, the CustNumber,
Fname, and Lname fields respectively (as indicated by the column
headings).
Each column represents one field. All the data in a given column
represents the values that appear in that field on each of the records in the
database.

The structure of a row/column report corresponds to the structure of a database with
rows representing individual records and columns representing individual fields.

Records and Fields in Data Block Reports

Some reports do not follow the row/column format, however. Instead, some group
related data in data blocks. A mailing list, for example, typically uses several rows
for each record: a row for the company name, a second row for the street address, a
third row for the city, state and ZIP code, etc. In such a report all the data for a given
customer in the list appears in a block. Each block represents a single record even
though the data in the block spans several rows.
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Data Types

The data type of a field, (string, number, currency, date, Boolean, or memo)
determines the type of information that can be stored in that field and which will
print in the report column.

Fields of each data type display on your screen like this:

XXXXXXX String — for example, a company name, account description
or customer name.

$5,555,555.55 Currency (Paradox/Btrieve files only) — for example $500.00
or $50,000,000.00-.

5,555,555.55 Number — for example 120 or 5555.

YYYY-MM-DD Date — for example Oct 10 90.

YES/NO Boolean (YES/NO) data fields — for example, the result of a
formula which compares a customer's credit limit to see if it is
greater than $5000 and prints YES if the credit limit is more
than that amount; NO if it is less than that amount.

XXXXXXX Memo — a paragraph describing a piece of property,
comments regarding a job applicant, a summary of a movie
plot, etc.

Formatting, and Record and Group Selection

While formatting, and record and group selection will be covered in depth later,
there are a few things about those subjects that are worthwhile to cover here:

Currency, date, and Boolean fields are shown above in the default
format. This format is used for both the element markers (in the report
editor) and for the report elements themselves (in the report). If you want
your data to appear in a different format on your report, you can make
the desired changes using the Format|Field command.

NOTE:
The characters in the element markers change to reflect font changes and many
formatting changes (alignment, etc.).

The width and position of a field (when place it in the Report Editor)
determines the initial spacing between fields and the order in which the
fields will print across the report page.



Using LAN Support Center 201

When insert a data field in your report, Crystal Reports assumes that you
want to pull data from all the data records in the selected database. To
limit the records (or groups of records) used in your report, you need to
tell Crystal Reports how to identify the records or groups of records you
want to include. Using Edit Record Selection Formula or Edit Group
Selection Formula on the Print menu, you can build the selection formula
that fits your needs.

Building Your Prototype
To build your report you will follow these steps:

Select the database(s) you wish to use in your prototype report.
Enter and position the data fields, text, and titles you want included in
the header, footer, and body of your report.
Print your report to the Print Window and review your work.
Make whatever changes are necessary.
Insert your totals, subtotals and other group fields.
Enter and position any formula fields that will calculate or mani pulate
data or create flags.
Print your report to the Print Window and review your work.
Format the report elements that you want to stand out in some way from
the others.

Selecting the Database(s)

Use the File|New Report command to begin a report from scratch. That command
leads you to a dialog box from which you can select the first database you wish to
use. To select additional databases, use the Database|Add File to Report command.

Entering and Positioning Data Fields

Enter and position data fields using the Insert Database Field dialog box that lists
available fields in the selected database. Make your selections from the list, and then
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place the field in your report using the rectangular field placement cursor that
appears.

Adding Text

You can add text to your report by typing it at the text cursor and then moving it into
place. Move the I-beam cursor to the line on which you wish to enter text and click
the left mouse button to set the text cursor at the left edge of the Report Editor.
Then, simply type in your text, move the I-beam cursor in front of it, and push it into
position using the Tab key or Space Bar. You can also add text by inserting text
fields and positioning them as you would any other field.

Entering Field Titles

By default, Crystal Reports automatically inserts a field title whenever insert a new
field or formula field. The title is a text field that can be edited. The left edge of the
title field aligns with the left edge of the field it identifies. To toggle this feature off
use the File|Options command.

Printing and Reviewing

You can print and review your work in progress at any time using the Print|Print To
Window command. When select this command, Crystal Reports prints your report to
the print preview window.

Making Changes

Move a database field by dragging it to a new position with the mouse, or by
selecting it and using the Arrow keys. You can move a field within its originating
section or to other sections of your report if you wish. Delete a field by selecting it
and then pressing the Delete key or selecting Edit|Clear.

NOTE:
To select multiple fields at one time, press the Shift key and, while keeping it
depressed, click the various fields you want to select. Handles will appear on
each field selected. When finished, you can move or delete the selected fields as a
group.
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Placing Totals, Subtotals, and Other Group Values

Place grand totals by selecting the numeric or dollar field you want to total, and then
selecting Insert|Grand Total from the Menu Bar.

Select group values (subtotals, group averages, group counts, etc.) by first selecting
the field you want grouped. Then select the kind of group value you want, using the
Insert|Subtotal or Insert|Summary commands. Select the kind of group value you
want (if selected Insert|Summary). Then select the field that the program uses to sort
and group your data by and the sort direction.

Moving Group Values

Move a subtotal or summary by dragging it to a new position with the mouse, or by
selecting it and moving it with the Arrow keys. You can move subtotals and
summaries only within their originating sections, or from the group footer section to
the group header section for the subtotal or summary of interest.

Entering Formulas

Enter formulas using the Insert|Formula command. This command calls up the
Formula Editor. Using the Formula Editor, build your formula using fields,
functions, and operators, and check your work using the built in formula checker.

Formatting

You can change the font or point size using the Format|Font command. You can
change the alignment and printing characteristics of field data using the Format|Field
command, and you can change the conditions that trigger subtotals, add page breaks,
suppress blank lines, hide selected sections, etc. using the Format|Section command.

Once you have built a prototype report, you have a working model that you can
customize to meet your specific needs.
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Manipulating the Data with Formulas and
Functions

Crystal Reports uses formulas and functions to help Create reports more quickly and
easily. It uses them also to allow you to do the kind of “number crunching” and data
manipulations that are necessary for advanced reporting.

 Formulas

A formula is a set of instructions that may be used to calculate information you
cannot obtain directly from database data fields. For example:

A database record may have a Qty1 field and a Qty2 field but no field
that sums both quantities. If you want the sum of these two fields to
appear on your report, you need a formula that adds the value in one field
to the value in the other.
A database record for a sales rep may contain the field GrossSales and
you want to use 120% of that gross as the sales quota for the following
year. To accomplish this you need a formula that multiplies GrossSales
by 120%.
A database record for a one product company may contain a field
Revenue that expresses total dollar sales for the year. You're interested in
determining the number of units sold based on an average price of 49.95
per unit. To accomplish this you need a formula that divides Revenue by
49.95.

All of these examples require simple formulas: {file.Qty1} + {file.Qty2}, 1.20 *
{file.GrossSales}, and {file.Revenue}/49.95 respectively. These formulas all use
Crystal Reports operators (+, * [multiply], / [divide]) and they're all easy to create
and understand.

But not all of your information needs can be reduced to simple formulas; some
needs require extensive calculations or manipulations. For example:

You want to determine your average monthly unit sales for the last year,
rounded to the nearest unit.
You want to convert ounces of inventory to pounds and ounces, and
have it appear in the format x pounds y ounces.
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The formulas required to accomplish these activities require a fair amount of data
manipulation: rounding, averaging, converting numbers to text, calculating
remainders, etc. While some of the manipulations (averaging, calculating
remainders) can be done using Crystal Reports operators alone, others cannot be
done without the use of functions. And even the ones that can be done without
functions can be done more quickly and efficiently with them. (For additional
information on formulas, see Crystal Reports Help.

Functions

A function is a preset procedure or subroutine used to evaluate, make calculations
on, or transform data. For example:

the NumericText function evaluates the contents of a text field to see if it
is a number, and
the UpperCase function transforms all lowercase characters in a string to
uppercase.

When you specify a function, Crystal Reports performs the set of operations built
into the function without requiring you to specify each operation separately. For
example:

the Average function sums a list of values and divides the sum by the
number of values in the list.
the DayOfWeek function extracts the day component of a date,
determines the day of the week the date falls on, and converts the day of
the week to a number (1-7) where Sunday is the first day of the week.

By performing multiple operations with a single command, these kinds of functions
are a kind of shorthand that make it easier and less time consuming for you to create
reports. But not all functions involve lengthy calculations; some simply allow you to
do things that you couldn't do easily without them while others take the drudgery
out of report creation. For example:

the ToNumber function converts a number that has been stored as text, to
a number that can be used in calculations, and
TrimRight removes all the spaces to the right of a string of data stored
left-justified in a database.
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How Functions are Used

Functions are used in formulas. In fact, a single function and its required
argument(s) may include the entire formula. For example, Abs ({file.TestResult}) is a
perfectly acceptable, stand-alone formula for calculating the absolute value of the
field TestResult.

Function Syntax

Each function comes with its own set of usage rules (syntax). These rules must be
followed for the function to perform correctly. If they are not, Crystal Reports
displays a Formula Compiler Error message.

As an example, the correct syntax for using the Average([array]) function is:

Average ([array])

« where array is an array of constants, field values or calculation results, separated
by commas. »

Translated, this means that to use the Average([array]) function correctly, you
should enter:

Average

followed by a list of numeric values, separated by commas, with the list of values
enclosed in brackets, and with the array enclosed in parentheses. Thus:

Average ([1,2,3,4,5])

is an example of the correct way to use the Average([array]) function.

If you try to use the function:

without separating the values by commas,
without enclosing the values in brackets,
without enclosing the array in parentheses,
while including any unnecessary characters, or
with values that are not numeric,

Crystal Reports won't accept the formula and will display a Compiler Error message
identifying your error.
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Entering Formulas and Functions

Formulas and functions are entered via Crystal Reports' Formula Editor.

The Formula Editor is a dialog box that contains all the tools you need to create and
check the correctness of formulas. Using the Editor, you:

assign a name to your formula,
enter the formula,
check it to make sure you have entered it correctly, and then
accept it for use in your report.

When you accept it, Crystal Reports places the formula in your report in the position
selected for it. Then, when you print the report, Crystal Reports prints the results of
the formula instead of the formula itself.

The Fields Box

You can enter fields into your formulas in two ways: via the Fields box, or
manually.

To enter a field via the Fields scro ll box, move the I-beam cursor to the
place you want to insert the field and click the left mouse button to set
the text cursor at that point. Then you locate the field you wish to insert
from the Fields scroll box list.
- Fields already in use in the report are grouped at the top of the list;

other available fields follow.
- Formulas you have entered are listed next, their names preceded by

the @ sign.
- All other fields available in the active databases are listed last,

grouped by database.

Select a field. Crystal Reports inserts the selected field (complete with the required
syntax elements) at the text cursor.

NOTE:
Select an item from the Formula Editor scroll boxes (Fields, Functions, or
Operators) by double clicking it, or by clicking it once to highlight it and then
clicking the Select button at the bottom of the Editor to complete the selection
process.

To enter a field manually, you locate the text cursor in the appropriate
position and type in the field name as you would any text.
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The correct syntax for a database field name is:
{file.fieldname}
If you:
- do not include the file name,
- leave out the separating period, or
- fail to surround the expression in braces,
Crystal Reports will generate a Formula Compiler Error message

detailing your error.
The correct syntax for a formula field is:
{@formulaname}

Operators and Functions Boxes

You can also enter operators and functions into your formula in one of two ways:
manually or via the Operators and Functions scroll boxes.

To enter an operator or function manually, you locate the text cursor in
the appropriate position and type in the operator or function as you
would any text.
To enter an operator or function via the lists in the Functions and
Operators scroll boxes, set the text cursor where you want the entry to
appear in the formula.
- Then select the item of interest from the scroll box lists. Crystal

Reports inserts the selected item in your formula, complete with any
parentheses, brackets, or commas required.

NOTE:
For an array of items, only the first comma is included. As enter additional
items into an array, you will need to type in commas to separate the items.

Order of Precedence

When entering formulas that contain different kinds of operators, it is important to
consider order of precedence, the order in which Crystal Reports performs the
operations in your formula.

You learned simple order of precedence in high school math: when performing
calculations, do multiplication and division first, then addition and subtraction.
Thus:
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5 + 10 X 3 = 35

The calculation 10 x 3 is performed first to get 30. 30 is then added to 5 to arrive at
the final answer.

Now if your intention is to add 5 to 10 and then multiply the sum by 3, you have to
modify the order of precedence with parentheses. You can do that thus:

(5 + 10) x 3 = 45

It's clear that parentheses have a higher precedence than the add, subtract, multiply,
and divide operators. They redirect the order of calculation.

You learned all of this in school and Crystal Reports follows the same rules of
precedence. But Crystal Reports uses many additional operators, and it's important
for you to understand the precedence Crystal Reports assigns to each so you can
write your formulas to perform as expected.

In the following list, Crystal Reports performs the top level operations
first, then the second level, then the third, and so forth.
When it encounters two or more operations that are on the same level, it
performs them left to right.

Level 1 Parentheses, Array, IfThenElse

Level 2 Call, Subscript

Level 3 Identity, Negate, Dollar, Not

Level 4 Multiply, Divide, Percent

Level 5 Add, Subtract

Level 6 To

Level 7 Less than, Greater than, Greater than or equal, Less than or equal, In

Level 8 Equal, Not equal

Level 9 And

Level 10 Or
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Using Dates in Formulas

Crystal Reports includes many useful functions for including dates and date ranges
in formulas; you will learn more about those functions in Crystal Reports Help. At
this point, however, it's useful to know how to enter any date into a formula.

Enter a date simply by entering the Date function (manually or via the Function
button) and then providing the date of interest in the parentheses that follow in the
form YYYY,MM,DD (1992,01,01 = January 1, 1992).

The Formula Checker

The Formula Editor also contains a formula checker which checks the syntax of your
formula. If the syntax is incorrect, the formula checker points out the location of the
problem and tells you what the problem is. You activate the formula checker by
selecting the Check button. Crystal Reports also checks the formula automatically
when you choose Accept. When debugging formulas, especially if you have entered
them manually, look carefully for:

missing quotation marks around text stri ngs,
missing database name accompanying field names,
missing braces around database name/field name combinations,
missing closing parentheses to match opening parentheses,
case differences (the Formula Checker is case sensitive),
if-then-else formulas that use different data types for the then and else
actions, and
using X instead of * for multiplication.

The Formula Editor is easy to use and can be called up by selecting Formula from
the Insert menu.

Developing Complex Calculations with Formulas

Crystal Reports allows you to combine fields, functions, and operators to create
complex calculations and manipulations of data. For example, to test the drawing
power of two different offers, you can use a single Crystal Reports formula to send
one offer to all customers with an even customer number and a second offer to all
customers with an odd customer number. You can do some remarkable
manipulations using Crystal Reports formulas.
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Grouping, Summarizing, and Sorting Your Data
Crystal Reports allows you to group, summarize, and sort your data to achieve the
reporting results you want.

Grouping the Data

A group is a set of records that are related to each other in some way. In a customer
list, for example, a group could consist of all those customers living in the same ZIP
code, or in the same state. In a sales report, a group could consist of all the orders
placed by the same customer, or all of the orders generated by a specific sales rep.

Breaking data into groups (and then doing something to evaluate the group data, if
you wish) is a key part of effective reporting. In fact, it's what separates a report
from being merely a presentation of raw data and a valuable communication tool.

Crystal Reports allows you great flexibility in grouping data. It also allows you to
create a number of different kinds of group values.

Group Values

A group value is the value generated as the result of an evaluation, a tally, or a
calculation performed on data from a single group. A subtotal is one kind of group
value; it is the sum of all of the values from a single field, from all the records in a
group. In a sales report, for example, if you subtotal sales by sales rep, Crystal
Reports gathers all the records that belong to the sales rep and totals the sales
amounts from all the records. In a group average, Crystal Reports averages the
values in a group of records; in a group count, it counts the values in a group of
records, etc. Group values are important tools for creating powerful reports. Crystal
Reports gives you several alternatives for working with group data. It enables you
to:

calculate the sum of values,
calculate the standard deviation or variance of the values,
average the values,
count the values,
determine the highest value, and
determine the lowest value in the group.
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Grouping Data with Crystal Reports

While there may be many data fields on a report, there is typically only one field for
which you are interested in grouping the data. In a sales report, for example, it would
probably be the field listing the amount of sales; in a commission report, it would
probably be the field listing the amount of commission, etc. To group data you first
select the field you want to group together.

Once the field is selected, select the action you want to take on each group of data
from that field:

If you want to simply group the data and take no further action, you can
select Insert|Group.
If you want to subtotal it, you can select Insert|Subtotal.
If you want to average, count, determine the maximum or minimum
value, etc., you can select Insert|Summary.

Subtotals and summaries make up the category of group fields.

NOTE:
The Insert|Subtotal command is simply a shortcut for setting up a summary
that adds the values in each group.

Once you have selected the group field and the action, select another field (a sort and
group by field) that triggers a grouping whenever its value changes. In grouping
your data by state, for example, you would use the state field to create a new group
(and generate a group value if selected) whenever the state changes. Likewise, the
ZIP code field would trigger a grouping whenever the ZIP code changes.

Once you've made these simple selections, Crystal Reports does the rest. Your data
will be grouped, and the group value (if you have selected one) will be calculated
and will accompany each group.

Summarizing the Data
Crystal Reports provides three easy-to-use summarizing options:

Grand Total A grand total adds all values in a field for the entire report and
prints the sum on the last page.
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Subtotal A subtotal is a partial total, a total of a specific, limited group of
data in a field.

Summary A summary summarizes field data from a specific, limited group of
records. It can total the data like a subtotal, but it can also average
the values, count the values, or determine the highest or lowest
value in each group or field.

All of these options are available on the Insert menu.

The Summarizing Process

The process of summarizing the data on your report follows these steps:

1. Selecting the field you want to summarize.

2. Selecting the summarizing option you want from the Insert menu.

Finally, if select Subtotal or Summary as a total type, the process will also
include the following step:

3. Selecting the data field that triggers a new subtotal/summary whenever its value
changes.

Selecting a Field to Total

To select the field you want to summarize, click on it with a mouse. Crystal reports
puts handles on the selected marker to highlight it as selected.

Selecting a Total Type

To select a total type, select it from the Insert menu or pop-up menu.

Selecting a Field to Trigger a New Subtotal

If select Subtotal or Summary as a total type, Crystal Reports asks you to indicate
the field that is to trigger a new subtotal/summary whenever its value changes.
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Sorting
There is a logic to the way values are arranged when they appear in a column on
your report. Initially, they are arranged in the same order as the data appears in your
database. But data can be sorted in a variety of ways:

A mailing list, for example, could be sorted in ascending order, on the
ZIP code field; that is, the customers would be sorted so that those with
the lowest ZIP codes would appear first and those with the highest ZIP
codes would appear last.
It could also be sorted in ascending alphabetical order, on the last name
field; that is, customers with last names beginning with A would appear
first and those with last names beginning with Z would appear last.
It could also be sorted by street address or customer first name if you had
some practical reason for doing so.

Crystal Reports gives you the opportunity to change the existing sort order using the
Print|Record Sort Order and Print|Group Sort Order commands.

Sorting by Record

When use the Print|Record Sort Order command, Crystal Reports asks you to select
two things:

the field you want your sort to be based on (sort field), and
the sort direction.

Sort Field

A sort field is a field that determines the order in which data appears on your report.
Crystal Reports sorts field data using Windows' sort comparison algorithms, and it
uses rules specific to the Country select in the International section of the Windows
Control Panel.

You can use any field as a sort field. A field's data type determines the method in
which the data from that field is sorted:
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Text Text fields are sorted in the following manner:

One character values are sorted so that blanks have the lowest value,
then punctuation, then numbers, then uppercase letters, and finally
lowercase letters.

Then two character values are sorted, then three, etc. using the same
rules. As a result:

“BOB” comes before “bob”,

“123" comes before ”124",

“ ” (blank) comes before “a”, and

“aa” comes before “aaa”

Dollars Dollar fields are sorted in numeric order.

Number Number values (120, or 5555) are sorted in numeric order.

Dates Date fields are sorted in chronological order.

Booleans Comparison fields are sorted so that false values come first, then
true.

When select a sort field, Crystal Reports sorts the values from that field.

Sort Direction

Direction refers to the order in which the values are printed, once sorted.

Ascending order means smallest to largest, 1 to 9, A to Z, False to True.
Descending order means largest to smallest,  9 to 1, Z to A, True to False.

Single Field Sorts

Single field sorts are sorts in which all the data in the report is sorted based on the
values in a single field. Sorting an inventory report by stock number and sorting a
customer list by customer number are examples of single field sorts.

Multiple Field Sorts

In multiple field sorts, Crystal Reports first sorts the entries (alphabetic or numeric)
in the first field selected, putting them in ascending or descending order as specified.
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Then it sorts any entries in the second field that can be sorted without disturbing the
sort order of entries in the first field. It then sorts any entries in the third field that
can be sorted without disturbing the sort order of the entries in the first two fields. It
follows the same pattern for sorting additional fields.

Sorting Groups

Crystal Reports allows you to change the order in which groups appear on your
report. You can:

base the sort on any group (subtotal or summary) in your report, and
sort your report so that group field values appear in ascending or
descending order.

You change the sort order using the Print|Group Sort Order command. When you
sort by group, nothing happens to the sort order of the records within a group; only
the relative positions of the groups themselves change.

Editing and Formatting the Data
Crystal Reports makes it easy to edit and format your data. The editing/formatting
process follows these steps:

1. Selecting the data you want to edit or format.

2. Selecting the editing or formatting action you want to take place.

3. Entering the specifics of the action in the dialog box/editor if/when it appears.

Selecting the Data

To select the data element you want to edit or format, click on it with your mouse.
Crystal Reports draws handles on the element marker to highlight it as selected.



Using LAN Support Center 217

Selecting the Action

Once the element is selected, select the editing or formatting action from Crystal
Reports' Edit or Format menus. For example:

to change the font used to print the data, select Font from the Format
menu,
to hide the field when printing, select Field from the Format menu, or
to modify a formula, select Formula from the Edit menu.

Entering the Specifics

In those cases where a dialog box or editor appears after you've selected an action,
enter the specifics of that action in the window that appears. For example:

in the Font dialog box, enter the font and point size you wish to use, and
indicate whether you want the data to appear in boldface or italics, or
whether you want it to be underlined or overprinted with the strikeout
character, and
in the Formula Editor, Make the changes you want to the formula that
appears, check those changes if you wish, and accept the revised formula
when you're finished.

Crystal Reports takes it from there and performs the action selected.

NOTE:
In some cases you have to specify a second action to complete the editing change
desired. For example, to move some text in your report, you first cut the text
from its current position, and then you paste it in its new position. In such a
case select the data and then the action (Cut) to cut the text to the clipboard.
Then you mark the new position using the insertion pointer and select Paste to
insert the text in the new position.

Specifying Records/Groups to be Included
When select a field to appear on your report, Crystal Reports, by default, prints field
values from every record in the selected database. But in many cases you may not
want to include all the values, but only a specific range of values. For example, you
may want to include only a specific group of customers or a specific range of
account numbers out of the total number of values in the database. Or you may want
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to include values from only those records that fall within a particular date range.
With Crystal Reports this is easy. The program includes four commands on the Print
menu for restricting your report to specific records or groups of records:

Select Records

This option allows you to limit your report to specific records that fit a condition or
conditions you specify. It automatically builds a record selection formula using your
responses to dialog box questions. This option requires no knowledge of the Crystal
Reports formula language.

Edit Record Selection Formula

This option also allows you to limit your report to specific records that fit a
condition or conditions you specify. It takes you to the Formula Editor where you
can manually build a record selection formula to fit your needs. This command is
intended for users who are familiar with the Crystal Reports formula language.

Select Groups

This option allows you to limit your report to specific groups that fit a condition or
conditions you specify. It automatically builds a group selection formula using your
responses to dialog box questions. This option requires no knowledge of the Crystal
Reports formula language.

Edit Group Selection Formula

This option also allows you to limit your report to specific groups of records that fit
a condition or conditions you specify. It takes you to the Formula Editor where you
can manually build a group selection formula to fit your needs. This command is
intended for users who are familiar with the Crystal Reports formula language.

Select the command, specify the records or groups of records you want included,
and your report prints using only the selected records or groups.

Printing the Finished Report
When you want to print your report or when you want to see what your report will
look like when printed, you can use Crystal Reports' three printing options:

printing to the printer for hard copy output
printing to a print window to review your work
printing to a disk file for use with other applications

All of these options are available on the Print menu.
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When you are creating a report, you will find yourself printing to the print window
often, in order to check placement and formatting of the various report elements. The
print window even includes a print preview function that lets you see each page of
your report as a whole, top to bottom. Then, when you want to print a final or
interim copy of the report for hands-on review, you can print to the printer for hard
copy output.

If you want to use your report data in another application (in a spreadsheet or word
processor for example), you can print the report to a disk file in any of a variety of
popular file formats. Once in a disk file, you can import the data into your other
application following the importing procedures established by the receiving
application.
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Chapter 11  Practical Crystal Reports

This chapter contains a number of topics on the practical aspects of using Crystal
Reports to solve typical reporting problems.

Practical Crystal Reports
This chapter contains a number of topics on the practical aspects of using Crystal
Reports to solve typical reporting problems. The topics are broken down into the
following groups:

Creating a report Topics on a variety of report creation skills.

Manipulating text
and data

Topics that show you how to manipulate (copy, delete,
move, etc.) text and data on your report.

Working with
graphics and graphic
enhancements

Topics that show you how to size, scale, crop, and fine
tune the placement of bit-mapped graphics, and how to
create, size, and position lines, boxes, and tables on your
report.

Creating a Report
This section leads you through the following report creation topics:

Selecting a database
Selecting additional databases
Linking the databases
Understanding the invisible grid
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Creating margins
Inserting fields
Selecting fields to move, format, etc.
Spacing fields
Inserting text
Selecting text (to delete, change the font, etc.)
Aligning text with fields
Inserting blank lines
Deleting blank lines
Changing field and text fonts
Highlighting fields with borders and drop shadows
Centering text, field values
Inserting page headers and footers
Inserting page numbers and other special fields
Grouping data
Summarizing grouped data
Creating group headers
Sorting your data
Hiding parts of the report when printing
Selecting records and groups you want included on your report.
Selecting page orientation and paper size

Selecting a Database

You begin the report creation process by selecting (activating) a database. Once
activated, the database serves as a source from which you can select fields to appear
on your report and to be included in report formulas.

Select a database using the New Report command on the File menu.

Selecting Additional Databases

Crystal Reports allows you to draw data from multiple databases for use in a single
report. Select the first database you want to use from the Choose Database File
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dialog box that appears when select New Report from the File Menu. Select the
second and each additional database using the Add File to Report command on the
Database menu.

Linking the Databases

You link databases so that records from one database will match up with records
from another. For example, if you activate a Customer database and an Order
database, you link the databases so that orders in the Order database can be matched
up with the customers who placed the orders (from the Customer database).

Links are fields that are common to the two databases. The fields do not have to
have the same name; but they must have the same structure (size, data type), and
contain the same kind of data.

When you activate additional databases using the Database|Add File to
Report command, Crystal Reports takes you directly to the Define Link
dialog box. Use this dialog box to establish the link between the database
you are activating and a database which is already active..
If you later wish to create new links, or update or delete existing links,
use the Database|Links command which takes you to the Links dialog
box .Use this dialog box for a variety of linking activities.

Understanding the Invisible Grid

The Report Editor looks very freeform. It looks like you can place anything
anywhere and hope for good results. But that is not the case. The Editor contains an
invisible grid which directly affects the placement of data fields and text fields.

Think of the grid as a series of row and column coordinates. Crystal Reports allows
you to place fields and text only at these coordinates, not between them. In this way
it makes it very easy for you to place and space data on your report, and to align text
and fields as needed. If you attempt to place a report element between grid
coordinates, Crystal Reports “snaps” the element to the grid, (i.e., it moves the
element automatically to the nearest coordinate).

When place a data field in the Report Editor, Crystal Reports “snaps” it
to the nearest coordinate. Use the arrow keys or the mouse to move the
fields once they have been placed.
- When use the arrow keys to move the field, each time you press the

arrow the field moves one grid position.
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- When use the mouse to drag the field to a new location, Crystal
Reports “snaps” the field to the nearest coordinate as the field moves.

When you type text in the Report Editor, Crystal Reports always begins
the text at a grid coordinate.
- Use the Tab key to move the text; each time you press the Tab key

the text moves six grid positions

NOTE:
Crystal Reports uses a four pixel horizontal grid and a vertical grid that is
variable, based on the line height assigned to the largest font used within a
report section.

Creating Margins

Set margins in Crystal Reports using the Print|Set Printer Margins command.

Crystal Reports uses a dashed line to display your margins in the Report
Editor and Label Editor.
The displayed margins are active: they define the outer printing limits of
the report or label. Crystal Reports will not allow you to place or move a
field or text so it extends beyond the margins.
The numeric margin settings appear in both the Mailing Labels dialog
box and in the Printer Margins dialog box.
When Create a new report, Crystal Reports uses the non -printing areas
established for your printer as default margins. For example, if your
printer specifications indicate that the left quarter inch of a page is a
non-printing area, Crystal Reports sets the default left margin at .25
inches. While you can set margins that fall inside the non -printing areas,
parts of your report may be clipped off if you do.
All margins are calculated from the paper edge. Thus, a left margin of
.25 inches causes the printing to start exactly one quarter inch in from the
edge of the paper.

Inserting Fields

Insert fields on your report using the Database Field command on the Insert menu.
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Selecting Fields to Move, Format, etc.

To do many things with a field (change the font, move it, etc.), first you must select
it. Select means to point to the element with the mouse and then to click the left
mouse button to choose the element as the object of the next menu selection. For
example, to change font size, you first select the element for which you want to
change the font size. Then select the Font option from the Format menu (or Change
Font from the right mouse button menu) to select the new font size. The new font
size applies only to the field selected.

When select a field, black handles appear on the field box. These handles indicate
that the field is selected, and therefore active.

Selecting Multiple Fields at One Time

To select multiple fields at one time, press the Shift key and, while keeping it
depressed, click the various fields you want to select. Handles will appear on each
field selected. You can then move or delete the fields as a group. You can also
change the font or formatting or add borders for all selected fields.

Spacing Fields

Set spacing between data fields by placing the fields where you want them in the
Report Editor (using the mouse or Arrow keys), checking your spacing using the
Print|Print to Window command, and then fine-tuning the spacing, again in the
Report Editor.

Spacing Considerations

The following items can affect column spacing:

Field size

The amount of space allotted for a field may be much greater than the size of the
value that appears in the field.

- In a number or dollar amount field (which is right justified by
default), this can create a large number of leading blank spaces
which can impact field spacing.
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- In all other fields (which are left justified by default), it can create a
large number of trailing blank spaces which can impact field spacing.

You can reduce the amount of space allotted for a field by selecting the field and
then resizing it using the mouse or a Shift-Left Arrow or Shift-Right Arrow key
combination.

Mouse

To reduce the size of a field in the Report Editor using the mouse, select the field
and then drag either of the handles to make the field box smaller.

Shift-Left Arrow key

To reduce the size of a field in the Report Editor using the Shift-Arrow key
combination, select the field, press the Shift key, and, while keeping it depressed,
press the Left Arrow key enough times to reduce the field to the desired size.

NOTE:
If you have set up a data block of fields in the Report Editor (i.e.,
Customer/Address/City in a customer list report), you can resize all of the fields
simultaneously. First, click each of the fields while holding down the Shift key.
Then resize the fields by dragging on one of the sizing handles from any of the
selected fields (using the mouse) or by using the Shift-Arrow key combination.

Alignment

Number and dollar amount fields are right justified by default; all other data types
are left justified. A right aligned field following a left aligned field may appear to be
spaced properly in the Report Editor. You may need to fine tune the spacing,
however, once you review the report in the Print Window.

Inserting Text (Titles, Labels, etc.)

You can add text to your report by typing it at the insertion point and then moving it
into place or, by using the Insert|Text Field command.

Use the following procedure to insert text directly on your report.

1. Move the I-beam cursor to the line on which you wish to enter text.

2. Click the left mouse button to set the insertion point at the left margin of the
Report Editor.

3. Type in your text.

4. Move the I-beam cursor in front of the text, click to set the insertion point and
push the text into position using the Tab key.
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Use the following procedure to insert text using a text field.

1. Select Insert|Text Field.

The Edit Text Field dialog box appears.

2. Enter your text in the Enter Text edit box, and click OK when finished.

A rectangular placement cursor appears and changes into a field box when it
enters the Report Editor.

3. Position the field box where you want the text field to appear and click the left
mouse button to place it.

NOTE:
By default, Crystal Reports automatically places a title in the Page Header
section to identify each field or formula field insert in your report. These titles
are simply text fields. As such, they can be moved, formatted, deleted, resized,
or edited to change the text.

For fields, the default title is the name of the field.

For formulas, the default title is the name of the formula.

The left edge of each title aligns with the left edge of the field it identifies.

Automatic titles can be toggled off and on via the Insert Detail Field Titles
option in the Options dialog box.

Selecting Text (To Delete,  Change the Font, etc.)

To do many things with text (change the font, delete it, etc.), first you must select it.
Select means to highlight the text by dragging the I-beam cursor over it while
holding down the left mouse button. Your next action (changing the font, selecting
Edit|Cut, etc.) acts upon the text selected.

NOTE:
When text is in a text field, select it as you would select any field.
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Aligning Text with Fields

Often in reporting, you may find yourself wanting to align text with column data
(that entered as fields or formula fields). To do this, place your fields, type your text,
and then move the text into position using the Tab key. It is important to understand
why use the Tab key to perform this function and not the Space Bar. Spaces on the
screen take up a different amount of space than spaces on the printer. Thus, what
looks like it is aligned on screen (using the Space Bar) may not be aligned when you
print. If text and fields are aligned to a given tab stop on screen, however, the
elements will also be aligned when you print. Since both elements are aligned to the
same tab stop, a tab expansion can affect only the absolute position of the elements
on a page, not their alignment relative to each other.

Use the following procedure to align text with fields, move the text, the field, or
both.

Move the text with the Tab key. Each time you press the Tab key the text
moves six grid positions.
Move the fields with the Arrow keys. Each time you press one of the
Arrow keys, the text moves one grid position.

NOTES:
a - If you want to center the text over a field, or right or left align it, you can
type the text into a text field and use the Format|Field alignment commands to
set the alignment of the text within the text field.

b - Text can be moved right and left (with the Tab and Backspace keys) as can
fields (with the Right Arrow and Left Arrow keys). By moving text and fields in
concert, you should be able to get good alignment easily.

c - To align field titles with fields, working from left to right is best. Make
certain the first title is aligned with its field, then align the second title with its
field, etc. Aligning, in this case, consists of aligning the left edge of the title with
the left edge of the field.

d - For the best (and easiest) alignment of text and field data, enter your text
elements as text fields using the Insert|Text Field command (instead of entering
the text directly onto the report).
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Inserting Blank Lines

To insert a blank line, move the I-beam cursor to the section in which you want to
enter the blank line, click the left mouse button to set the insertion point, and press
Enter one time for each blank line you want to insert.

Considerations
If place the insertion point before text and then press Enter, the blank
lines will appear above the text.
If place the insertion point after text and then press Enter, the blank lines
will appear below the text.
If place the insertion point before or after a field and then press Enter, the
blank lines will always appear below the field. If you want to insert
blank lines above the field, insert the number of blanks you need below
the field as indicated, and then move the field down to the bottom blank
line you have just created.

NOTE:
You can also add blank lines by dragging the section boundary to increase
section size .

Deleting Blank Lines

By default the Report Editor allots three lines for the Page Header section and three
lines for the Page Footer section of your report. The defaults may allot more lines
than you need for those items on your report.

Additionally, you may expand a section on your report by a random number of lines
prior to inserting text and data, just to make sure you have enough room for your
entries. You may find that you have added more lines than necessary

Printing the report without first deleting the unneeded blank lines can leave gaps in
your report that make the report less attractive visually and more difficult to read.

Use the following procedure to delete unneeded blank lines.

If an entire section is blank (i.e., if you aren't putting anything into the
Page Footer section of your report), you can eliminate the allotted blank
lines by eliminating the entire report section via the Hide Section option
of the Format Section command.
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If you have text and/or data in a section and just want to remove the
extraneous blank lines, click the I -beam cursor on the blank line you
want to delete. This sets the insertion point. Once the insertion point is
set. press the Backspace key (the key that deletes the previous character);
Crystal Reports deletes the line on which the insertion point is set.

NOTE:
You can also delete blank lines by dragging the section boundary to decrease
section size.

Changing Field and Text Fonts

You can change fonts quickly for any field value or text string in your report using
the Font dialog box.

Use the following procedure to change fonts for a field value.

1. Select the field(s) for which you want to change the font.

To select a single field, click the field.

To select multiple fields, hold the Shift key down while click the fields.

Handles appear on the selected field(s).

2. Select Format|Font or click the right mouse button and select Change Font from
the pop-up menu.

The Font dialog box appears.

3. Make the font, style, size, color, and/or effects changes you want and click OK
when finished.

Use the following procedure to change fonts for a text string.

1. With the left mouse button depressed, drag the I-beam cursor over the text of
interest to select it.

2. Select Format|Font or click the right mouse button and select Change Font from
the pop-up menu. The Font dialog box appears.

3. Make the font, style, size, color, and/or effects changes you want and click OK
when finished.
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Highlighting Fields with Borders and Drop Shadows

Crystal Reports makes it easy for you to highlight your data with borders and drop
shadows, and color.

Use the following procedure to create borders, drop shadows, and add field color

1. Select the field(s) you want to highlight.

To select a single field, click the field.

To select multiple fields, hold the Shift key down while click the fields.
Handles appear on the selected field(s).

2. Select Format|Border and Colors or click the right mouse button and select
Change Border and Colors from the pop-up menu.

The Format Border and Colors dialog box appears.

3. Set up the text color, fill (field color), border, and drop shadow you want.

4. Click OK when finished to return to the Report Editor.

The selected fields will be highlighted to your specifications.

NOTE:
If selected multiple fields, the same highlights will be applied to all fields. If you
want to highlight different fields differently, you must select and highlight each
unique field individually.

Centering Text, Field Values

To center text and field values, use the Crystal Reports' alignment command.

1. Select Insert|Text Field and create a text field that contains the text you want.

2. Place the text field in the approximate position you want it to appear on the
report.

3. Change the font, font size, and font style for the text field if you wish.

4. Resize the text field box so it matches the margins within which you wish to
center the text.

For example, if you want to center text beneath a report title, expand the field
box so it's the same size as the report title (or report title field box). If you want
to center a header entry over the body of the report, expand the header entry
field box so it's the same width as the data in your report.
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5. Select Format|Field, and then select centered from the Alignment box in the
Field Format dialog box when it appears.

6. Select OK when finished; Crystal Reports centers your text within the expanded
field box.

Use the following procedure to center a field value within the space allotted for the
field:

1. Select the field whose value you want to center.

2. Change the font, font size, and font style for the field if you wish.

3. Select Format|Field, and then select centered from the Alignment box in the
Field Format dialog box when it appears.

4. Select OK when finished; Crystal Reports centers the field value within the
space allotted for the field.

Inserting Page Headers and Footers

In many cases, you may want to include information at the top and each page of
your report.

At the top of the report (page header) you may want to include such
things as the report title, the report date, the range of dates covered by the
report, etc.
At the bottom of the report (page footer) you may want to print the page
number, the author's name, “Confidential,” etc.

Crystal Reports makes it easy for you to include such header and footer information.

To Insert Page Headers and Footers

Insert page headers and footers by placing the desired information in the appropriate
section of the report editor.

header information goes in the Page header section
footer information goes in the Page footer section
Any information place in these sections prints on each page of the report
(unless you take special steps to prevent some printing).
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You can use text, fields, or formulas in these sections just as you can in
the Details section.

To Format Page Headers and Footers

You can format each element in a header or footer in the same way you would
format that element if it appeared in the details section:

you can change the font for text, fields, or formulas (see Format|Font),
you can center the values horizontally on the page, center them over your
report data, or align them flush left, centered, or flush right within the
space allotted for them,
you can change the way dates, numbers, and currency appear when they
print, (see Format|Field) and
you can suppress any blank lines that occur in the section (see
Format|Section).

To format a header or footer element, select the element and then select the
formatting option of interest.

Inserting Page Numbers and Other Special Fields

Crystal Reports allows you to insert special fields in your reports (in addition to the
data fields you draw from databases). These special fields allow you to insert dates,
page numbers, and group and record numbers in your report.

Print Date
Field

Use Insert|Print Date Field to insert a field that prints whatever
is the current date when the report prints.

Page Number
Field

Use Insert|Page Number Field to insert a field that prints the
current page number.

Record
Number Field

Use Insert|Record Number Field to have Crystal Reports
number each record printed in the Details section of your report.

Group Number
Field

Use Insert|Group Number Field to have Crystal Reports number
each group in your report.
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When select any of these special fields, a rectangular placement cursor appears.
Move the cursor to the point where you want to insert the field and click the left
mouse button to place it.

Grouping Data

Grouping data means breaking your data into meaningful groups before it appears
on your report. Crystal Reports makes it easy:

to group your data, and
to evaluate or perform calculations on the data in each group should you
so wish.

Simple Grouping

Simple grouping means breaking the data into groups without performing any
additional action (totaling, averaging, etc.) on the grouped data.

On a customer list, for example, you may want to group your data by
state for use by your customer service or telemarketing personnel.
Crystal Reports can quickly organize your data into state groups so that
each group contains only customers from a single state.
On a sales report you may want to group data by salesrep (each group
containing only sales made by a single salesrep) or by customer (each
group containing only sales made to a single customer). Crystal Reports
gives you the flexibility to group data in a variety of ways.

NOTE:
Whenever Crystal Reports groups data, it first sorts the data, and then it breaks
the sorted data into groups. For example, if you want to group a customer list
by state, Crystal Reports first sorts the data by state. Then it begins a new
group whenever the state changes. The following data shows that process

If all you want to do is group your data, you can do this easily with Crystal Reports
using the Insert|Group command.

Use the following procedure to do simple grouping.

1. Select the field you want to group.

For example:
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- if you want to group a customer list by state, select the field that
contains the company name, or

- if you want to group an orders report by customer, select the field that
contains the order amount.

2. Select Insert|Group Section. The Insert Group Section dialog box appears.

3. In the top scroll box, select the field that you want to trigger a grouping,
whenever its value changes.

For example:

- if you want to group a customer list by state, select the state field, or
- if you want to group an orders report by customer, select the field that

contains the customer name or customer number.

4. In the second scroll box, select the sort direction (in ascending order = A to Z, 0
to 9, in descending order = Z to A, 9 to 0)

5. If selected a date or Boolean field in the top scroll box, a third scroll box
appears near the bottom of the dialog box. In this scroll box, select the date or
Boolean condition that finalizes your subtotal specification.

6. Select OK when finished. Crystal Reports sorts the data and then breaks it into
groups according to your specifications.

NOTE:
You can tell that the data is grouped because two new sections appear in the
Report Editor bracketing the Details section.

Nesting Groups

You may also want to nest groups of data: group data within a group. For example,
on a customer list, you may want to group your data by state, and then, within each
state group, break the data down further, by city.

Crystal Reports lets you do this easily: use the Insert|Group Section command two
times, first to set up the state group and then to set up the city group.

NOTE:
You can add additional nesting levels as needed; there is no practical limit to
how many nesting levels you can set up.

Use the following procedure to group using nesting groups.
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1. Select the field you want to group.

For example:

- if you want to group a customer list by state and then, within each state
group, group the list by city, select the field that contains the
company name, or

- if you want to group an orders report by customer and then, within each
customer group, group the list by date, select the field that contains
the order amount.

2. Select Insert|Group Section.

The Insert Group Section dialog box appears.

3. In the top scroll box, select the field that you want to trigger a grouping,
whenever its value changes.

For example:

- if you want to group a customer list by state and then by city, select the
state field, or

- if you want to group an orders report by customer and then by date,
select the field that contains the customer name or customer number.

4. In the second scroll box, select the sort direction (in ascending order = A to Z, 0
to 9, in descending order = Z to A, 9 to 0)

5. If selected a date or Boolean field in the top scroll box, a third scroll box
appears near the bottom of the dialog box. In this scroll box, select the date or
Boolean condition that finalizes your subtotal specification.

6. Select OK when finished.

Crystal Reports groups the data according to the first set of specifications.

7. Select the same field selected in Step 1.

8. Select Insert|Group Section again. The Insert Group Section dialog box appears.

9. This time select the field you want to trigger the second group (the group within
the group) whenever its value changes.

For example:

- if you want to group a customer list by state and then by city, select the
city field, or

- if you want to group an orders report by customer and then by date,
select the date field.
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10. Select the sort direction (ascending = A to Z, 0 to 9, descending = Z to A, 9 to
0).

11. Select OK when finished. Crystal Reports groups the data, this time using both
sets of specifications.

12. Repeat Steps 6 to 10 for each additional group you want to set up.

SummarizingGrouped Data

Sometimes you may want to go beyond mere grouping of data. You may want to
first group the data and then evaluate or perform calculations on the data in each
group. You may want to sum, average, or count the values, calculate the variance or
standard deviation of the values, or determine the highest (maximum) or lowest
(minimum) value in each group.

You can sum the data using the Insert|Subtotal or Insert|Summary
commands.
You can sum, average, count, calculate the variance or standard
deviation, or determine the maximum or minimum values using the
Insert|Summary commands.

NOTE:
Not all summary options are available for every data type. For example, you
cannot sum or average string fields.

Grouping and Summarizing Grouped Data

1. Select the field you want to group.

For example:

- if you want to group a customer list by state and then count the number
of values in each group, select the field that contains the company
name, or

- if you want to group an orders report by customer and then determine
the average sized order for each customer, select the field that
contains the order amount.

2. Select Insert|Summary.

The Insert Summary dialog box appears.

3. In the top scroll box, select the action you want to take on the grouped data.
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For example:

- if you want to count the number of values in each group, select Count,
or

- if you want to average the values in each group, select Average.

4. In the next scroll box, select the field that you want to trigger a grouping,
whenever its value changes.

For example:

- if you want to group a customer list by state, select the state field, or
- if you want to group an orders report by customer, select the field that

contains the customer name or customer number.

5. In the next scroll box select the sort direction (ascending = A to Z, 0 to 9,
descending = Z to A, 9 to 0).

6. If selected a date or Boolean field in the top scroll box, a third scroll box
appears near the bottom of the dialog box. In this scroll box, select the date or
Boolean condition that finalizes your summary specification.

7. Select OK when finished. Crystal Reports sorts the data, and then groups and
summarizes it to your specifications.

Grouping and Summarizing Using Nesting Groups

1. Select the field you want to group.

For example:

- if you want to group and count a customer list by state and then, within
each state group, group and count the list by city, select the field that
contains the company name, or

- if you want to group and sum an orders report by customer and then,
within each customer group, group and sum the list by date, select
the field that contains the order amount.

2. Select Insert|Summary. The Insert Summary dialog box appears.

3. In the top scroll box, select the action you want to take on the grouped data.

For example:

- if you want to count the number of values in each group, select Count,
or

- if you want to average the values in each group, select Average.
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4. In the next scroll box, select the field that you want to trigger a grouping,
whenever its value changes.

For example:

- if you want to group a customer list by state, select the state field, or
- if you want to group an orders report by customer, select the field that

contains the customer name or customer number.

5. In the next scroll box select the sort direction (ascending = A to Z, 0 to 9,
descending = Z to A, 9 to 0).

6. If selected a date or Boolean field in the top scroll box, a third scroll box
appears near the bottom of the dialog box. In this scroll box, select the date or
Boolean condition that finalizes your summary specification.

7. Select OK when finished. Crystal Reports groups and summarizes the data to
your specifications.

8. Select the same field selected in Step 1.

9. Select Insert|Summary.

The Insert Summary dialog box appears.

10. Select the action you want to take on the grouped data.

11. This time select the field you want to trigger the second group (the group within
the group) whenever its value changes.

For example:

- if you want to group and count a customer list by state and then by city,
select the city field, or

- if you want to group and sum an orders report by customer and then by
date, select the date field.

12. Select the sort direction (ascending = A to Z, 0 to 9, descending = Z to A, 9 to
0).

13. Select OK when finished. Crystal Reports groups and summarizes the data to
your specifications.

14. Repeat Steps 8 to 14 for each additional group you want to set up.

NOTE:
Group values (subtotals, summaries) and grand totals are automatically
formatted to match as closely as possible the formatting of the field they are
summarizing.
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Creating Group Headers

Just as Crystal Reports allows you to place a header at the top of each page, it also
allows you to place incremental headers above each group in your report. This
feature allows you to give your reports a polished, professional appearance.

Whenever you group your data, or insert a subtotal or a summary, Crystal Reports
creates two new sections on your report.

One section, the Group Footer section (#1: CUSTNUM in the
screenshot), appears below the Details section. This section holds the
group value field itself.
A matching section, the Group Header section (#1: CUSTNUM in the
screenshot), appears above the Details section. Anything place in this
section will appear as a header for your group.

NOTE:
Both sections are given the same designation so you can tell that they are tied
together. The two sections are also tied together visually.

If you put text in the Group Header section, the same text will appear as
a header for each group on the report.
If you put the field in the Group Header section that use for the sort and
group by field, Crystal Reports will create a “live” header for each
group. For example, if you have a subtotal that groups your data by
Customer, putting a duplicate copy of the Customer field in the Group
Header section for that subtotal heads each group with the customer
name. You can then format this header field to make it stand out if you
wish, using a larger point size, bold face or italics, etc.

NOTE:
You can hide either the Group Header section or the Group Footer section for
any group by activating the Hide Section option available via the
Format|Section command.

Multiple Groups for the Same Field

When set up a second group for the same field, Crystal Reports creates a second
group section on your report beneath the first group section. Likewise, it creates a
second Group Header section above the first Group Header section. For each new
group field section on an existing field, Crystal Reports creates a pair of sections that
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effectively “bracket” the existing sections. Each section is clearly marked so you can
easily tell which header section goes with each group section.

If place headers in each of the Group Header sections, you produce a report that is
extremely easy to read. For example, if you have grouped your data by State and
then by City within each state, each new State section will be headed by a State
header, and each City section within the State section will be headed by a City
header.

Sorting Your Data

Crystal Reports allows you to sort your data by record and by group. This section
discusses each of the sorting procedures in depth.

NOTE:
Crystal Reports sorts your data using the sorting rules appropriate to the
country that you have selected in the International dialog box in the Windows
Control Panel.

Sorting by Record

Crystal Reports allows you to sort your data on one or more sort fields. Single and
multiple field sorts will be covered in this section.

Single Field Sorts

Single field sorts are sorts in which all the data in the report is sorted based on the
values in a single field. Sorting an inventory report by stock number and sorting a
customer list by customer number are examples of single field sorts.

Multiple Field Sorts

In a multiple field sort, Crystal Reports first sorts the entries (alphabetic or numeric)
in the first field selected, putting them in ascending or descending order as specified.
Then it sorts any entries in the second field that can be sorted without disturbing the
sort order of entries in the first field. It then sorts any entries in the third field that
can be sorted without disturbing the sort order of the entries in the first two fields. It
follows the same pattern for sorting additional fields.
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Use the following procedure to sort by record.

1. Select Print|Record Sort Order. The Sort Order dialog box appears.

2. Select the Sort Field(s) and Sort Direction you want and click OK when
finished.

Crystal Reports sorts the records to your specifications.

NOTE:
If you group your data using the Insert|Group, Insert|Subtotal, or
Insert|Summary command, Crystal Reports sorts your data automatically, as
part of the grouping process. For example, if you sort a customer list by state,
Crystal Reports first sorts the list alphabetically by state, before breaking it into
state groups. In such a case, you do not need to use the Print|Record Sort Order
command to generate the sorting.

Sorting Groups

Crystal Reports allows you to change the order in which groups appear on your
report. You can:

base the sort on any group (subtotal or summary) in your report, and
sort your report so that groups appear in ascending or descending order.

When you group data, Crystal Reports first sorts the data by record and then groups
it according to your specifications. Here is some data typical of that found in the
{file.STATE} field of a customer list:

In order to group the data by state, Crystal Reports sorts the original data
alphabetically by state, on the first pass, and then it breaks the data into groups
(whenever the value in the state field changes) on the second pass. The resulting
groups appear in ascending alphabetical order; the group containing all the
customers from Arizona comes before the group containing all the customers from
Colorado. Now this is fine if you want the groups appearing in that order. But let's
assume we want the data grouped so that the group containing the most records (the
state with the most customers) appears first, then the state with the second highest
number of records, then the third, etc. Crystal Reports lets you do this easily using
the Print|Group Sort Order command.

Use the following procedure to sort groups.

1. Select the Print|Group Sort Order command.
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The Sort Order dialog box appears, listing all the groups that you have set up in
your report. In our example above, since customer data is grouped by state and
the number of records in each state group is counted, a group name similar to
this will appear in the Summary Fields box:

Group #n:customer.STATECount of customer.CUSTNAME

Translated, this means that the {customer.CUSTNAME} field (the field that
contains the customer name) is grouped and counted every time the value in the
{customer.STATE} field changes.

2. Select this group, click the Add button.

Crystal Reports places it in the Sort Fields box and activates the Sort Direction
options.

3. Since you want the largest groups (by count) to appear first and the smallest last,
select Descending. If you wanted the smallest groups to appear first, you would
select Ascending.

4. Click OK when finished.

Crystal Reports sorts the groups to your specifications.

NOTE:
When you sort by group, nothing happens to the sort order of the records
within a group; only the relative positions of the groups themselves change.

Hiding Parts of the Report when Printing

Crystal Reports has four formatting commands that suppress (hide) various parts of a
report. Each of these commands is discussed individually in Crystal Reports Help.
The purpose of this section is to show the differences between the commands and
how you can use them together to achieve sophisticated report formatting.

The four commands are:

Suppress if
Duplicated

Suppress if Duplicated (Field format dialog box) prevents a field
value from printing if it is identical to (a duplicate of) the value
that comes immediately before it. The value doesn't print but the
space in which it would have printed remains.

Suppress if
Zero

Suppress if Zero (Format Number/ Currency dialog boxes)
prevents a value from printing if it is a zero value. The value
doesn't print but the space in which it would have printed
remains.
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Suppress
Blank Lines

Suppress Blank Lines (Format Section dialog box) eliminates
nonessential blank lines from your report.

Hide when
Printing

Hide when Printing (Field format dialog box) prevents a field
from printing. The field doesn't print but the space allotted for
the field remains.

Selecting Records and Groups to Include on Your Report

You can include all records in your report, or you can restrict your report to specific
records or groups of records. For example, you can print a sales report showing year
to date sales for all sales reps in the country, or you can print a report that presents
nationwide sales but only for the last month, or even a report that shows year to date
sales but only for those sales reps in Texas and California. Your reports can be as
inclusive or exclusive as you wish.

Crystal Reports includes four commands on the Print menu for selecting records and
groups.

- Select Records
- Select Groups
- Edit Record Selection Formula
- Edit Group Selection Formula
Using the first two commands, Crystal Reports generates a selection
formula for you automatically, based on your specifications.
Using the last two commands, Create your own selection formula using
the Formula Editor.

Generating a Selection Formula Automatically

The Select Records and the Select Groups commands automatically generate record
selection formulas based on your responses to dialog box questions. These
commands require no knowledge of the Crystal Reports formula language.

When you're using these commands, select a field/group value and respond to
questions about how you want to limit that field or group value. For example, if you
want to prepare a report limited to Texas customers, you first click the state field in
the customer database. Then, select Print|Select Records (or choose Select Records
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from the right mouse button menu). When the Select Records dialog box appears
enter your selection criteria in the dialog box.

Use the following procedure to have Crystal Reports generate a selection formula.

1. Select the first field/group value you want Crystal Reports to use for
determining the records/groups to be included in the report.

2. Select Print|Select Records or Print|Select Groups, whichever is appropriate.

NOTE:
Alternately, you can select a field or group value and click the right mouse
button menu. Select Records appears on the right mouse button menu whenever
a field is selected, and Select Groups appears on the right mouse button menu
whenever a group value is selected.

The Select Records or Select Groups dialog box appears, depending on your
selection.

3. Enter your selection criteria in the dialog box and click OK when finished to
return to the Report Editor.

4. Repeat Steps 1- 3 for each additional field/group value you want the program to
use for selecting records/groups.

Crystal Reports will generate a selection formula based on your specifications
and limit the report to the records or groups you have specified.

NOTE:
To view or edit the selection formula generated by Crystal Reports, select
Print|Edit Record Selection Formula or Print|Edit Group Selection Formula,
whichever is appropriate to your selection.

Creating a Selection Formula Manually

The Edit Record Selection Formula and Edit Group Selection Formula commands
take you to the Formula Editor so you can manually create your own selection
formula. Both of these commands require some understanding of the Crystal Reports
formula language.

Using the Formula Editor, you can build a formula that restricts your report to the
records or groups you specify. For example, to limit your report to those records
with a customer number greater than 099999, you would build a record selection
formula similar to this:

{file.CustNumb} >> “099999"
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To limit your report to those groups with a subtotal on the Amount column
(triggered by changes in the CustNumb field) less than $10,000, you would build a
group selection formula similar to this:

Sum({file.Amount},{file.CustNumb}) << $10000

NOTE:
If select:

Grouped by file.CustNumb

Sum of file.Amount

(the group field of interest in this example) from the Field list, Crystal Reports
automatically inserts everything into the formula with the exception of
<<$10000.

You can also restrict the records used in the report by date. For example, to restrict
an invoice report to invoices from a specific month, May 1991 in this case, you
would build a record selection formula similar to this:

{file.Date}>>=Date(1991,05,01) and
{file.Date}<<Date(1991,06,01)

or this:

{file.Date} in Date(1991,04,30) to Date(1991,06,01)

or this:

Month({file.Date}) = 5

You can make your selection formulas as simple or complex as you wish. You can
use most of the functions and operators available for building any formula. Your
only restrictions are:

your record or group selection formula must be Boolean, (i.e., it must
return a Yes (True) or No (False) value). If build a selection formula that
isn't Boolean, you get a Formula Compiler Error that says, “The result of
the selection formula must be a yes/no value.”
it cannot use the PageNumber, GroupNumber, or RecordNumber
functions, and it cannot use a Subtotal, Grand Total, or Summary.

Selecting Date Ranges

When you wish to select records based on a range of dates, you can use any of
Crystal Reports' preset date ranges, or you can build a custom range to fit your
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needs. For a complete list of Crystal Report date ranges, please see Crystal Reports
Help.

Generating Your Own Selection Formula

1. Select Print|Edit Record Selection Formula or Print|Edit Group Selection
Formula.

The Formula Editor appears.

2. Create your selection formula.

3. Click Accept when you are finished.

Crystal Reports will limit your report to the records/groups specified.

NOTE:
You will find a number of selection formula templates in the Help facility under
Edit Record Selection Formula. These templates cover a wide range of typical
record selection needs, and they can be pasted into the Formula Editor via the
Windows clipboard. Once they're in the Formula Editor, you can change the
formulas to fit your data.

Selecting Page Orientation and Paper Size

You can use Crystal Reports with a variety of paper sizes and with portrait or
landscape page orientation. Select paper sizes and page orientation via the Print
Setup dialog box which appears when select Print|Select Printer.

Use the following procedure to select a new paper size/page orientation.

To select a new paper size and/or page orientation, select Print|Select
Printer.
When the Print Setup dialog box appears, you activate the printer you
want to use if it is not already the default printer.
Select your page orientation (Portrait or Landscape) in the Orientation
box, and select your paper size and source in the Paper box. Your choice
of paper sizes depends on the capabilities of the printer you have
selected, and the choice changes from printer to printer. For example, the
HP LaserJet driver (PCL) offers a choice of letter, legal, executive or A4
paper sizes whereas the PostScript printer driver lets you choose from
letter, letter small, legal, A4, A4 small, B5, and note paper sizes. When
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Make your selection and return to Crystal Reports, the paper you have
selected is active.

Manipulating Text and Data
This section outlines the various procedures to use for manipulating (copying,
deleting, moving, etc.) text and data on your report.

Adding Text

To add text, set the insertion point where you want the new text to begin, and type in
your addition, or use a text field (Insert|Text Field command).

Copying Text

Use the following procedure to copy text.

1. Select the text you want to copy by dragging the I-beam cursor over the text.

2. Select Edit|Copy.

Crystal Reports moves a copy of the selected text to the Clipboard without
disturbing the highlighted text.

3. Set the insertion point where you want to insert the copied text and select
Edit|Paste.

Crystal Reports copies the text at the selected point.

NOTE:
You can also copy text to the Clipboard using the fifth button on the Button
Bar. You can also paste text into your report from the clipboard using the sixth
button on the Button Bar.

Deleting Text

Use the following procedure to delete text.
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set the insertion point where you want to begin dele ting, and press the
Delete key enough times to delete the unneeded text, or
select the text you want to delete by dragging the I -beam cursor over it,
then:
- select Edit|Clear (or press Delete) to delete it permanently, or
- select Edit|Cut (or press Shift -Delete) to cut the text to the clipboard

for later use, or
set the insertion point at the beginning of a line of text you want to delete
and press Shift-End to select the entire line. Then:
- select Edit|Clear (or press Delete) to delete it permanently,
- or select Edit|Cut (or press Shift -Delete) to cut the text to the

clipboard for later use.

Editing Text

Delete, edit, and/or add text as needed following the techniques described above.

Moving Text

You can move text in Crystal Reports in two different ways:

By pushing or pulling it to a new position using the Tab key.
By cutting it to the Clipboard and then p asting it in a new position.

Using the Tab Key

Set the insertion point immediately in front of the text you want to move.

Press the Tab key to move the text to the right. All text to the right of the
insertion point moves each time you press the Tab key.
Press the Backspace key to move the text to the left. All text to the right
of the insertion point moves each time you press the Tab key.

NOTE:
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If you want to move several pieces of text on a given line into position (i.e.,
aligning titles with data fields), begin at the left. Move the leftmost text into
position, reset the insertion point to the left of the second text element and move
it into position, reset the insertion point to the left of the third text element, etc.

Using Cut and Paste

1. Select the text you want to move.

2. Select Edit|Cut.

Crystal Reports moves the text to the Clipboard.

3. Set the insertion point to the new text position.

4. Select Edit|Paste to paste the text at the new insertion point.

Moving Fields

Move a database field by dragging it to a new position with the mouse, or by
selecting it and using the Arrow keys.

Moving Fields with a Mouse

1. Select the field you want to move.

To select a single field, click the field.
To select multiple fields, hold the Shift key down while click the
fields. Handles appear on the selected field(s).

2. With the cursor on the field (on one of the fields if you have selected multiple
fields) and the left mouse button depressed, move the field to its new position.

3. Release the mouse button when the field is in place.

Moving Fields with the Arrow keys

1. Select the field you want to move.

To select a single field, click the field.
To select multiple fields, hold the Shift key down while click the
fields. Handles appear on the selected field(s).
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2. Use the Arrow keys to move the field to its new position.

The field moves one grid position each time you press the Arrow key.

NOTES:
a - Crystal Reports allows you to move fields across other fields without
affecting the placement of the bottom fields.

b - You can move fields between sections with the following exceptions:

grand totals cannot be moved outside the Grand Total section, and

a subtotal or summary can be moved only within its initial section or to the
header portion of its initial section.

Deleting Fields

You can delete a database field from your report by selecting it and:

pressing the Delete key on the keyboard,
selecting Delete Field from the right mouse button pop -up menu, or
selecting Clear from the Edit menu.

Each of these methods has the same effect: deleting the selected field. You may find
one alternative to be more convenient at one time while a different alternative is
more convenient at another.

 Working with Graphics and Graphic
Enhancements

This section leads you through the following graphics-related topics:

Bit-mapped graphics concepts,
Inserting and moving graphics,
Sizing and scaling graphics,
Cropping graphics,
Creating, moving, and formatting graphic lines
Creating, moving, and formatting graphic boxes



Using LAN Support Center 251

Using graphic boxes to highlight data
Creating tables using graphic lines and boxes
Graphic elements and the Status Bar
Using the status bar when positioning a graphic element

Bit-mapped Graphics Concepts

Bit-mapped graphics are the kind of graphics (pictures, logos, etc.) that are generally
produced by paint programs and scanners. They are composed by the graphic
designer as a pattern of tiny dots (pixels) on screen, and they are printed as a pattern
of tiny dots on your report. Even though there are some limitations to what an
individual can create with dots, a skilled graphics designer can nonetheless achieve
some stunning effects that can add visual impact to your report.

Crystal Reports allows you to use bit-mapped graphics in your reports from a wide
variety of sources:

scanners,
paint programs,
video capture cards,
screen capture programs,
CompuServe,
commercial graphics developers, and
shareware and public domain graphics suppliers.

As long as the graphic is stored in one of the popular graphics formats that work
with Crystal Reports, you can use it in your report.

- Most paint, scanner, screen capture, and video capture programs can
save graphics in one of the compatible file formats (.bmp, .pcx, .gif,
.tif, and .tga).

- Additionally, many programs (paint programs, graphics conversion
programs, screen capture programs, draw programs) will allow you
to import a graphic in a different format and save it in a format that is
compatible with Crystal Reports.

- There are, in fact, many low cost shareware programs or free public
domain programs that allow you to easily convert a bit -mapped
graphic stored in one format to another.
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Crystal Reports was designed for maximum graphics compatibility.

NOTES:
a - When select a graphic for inclusion in your report, Crystal Reports stores a
copy of the graphic in the report file. Any changes Make to the graphic affect
the copy; they do not alter the original.

b - When click the right mouse button with the cursor over a graphic, a
graphic options menu appears with the name and extension of the originating
graphic file at the top. The file name is for information only since the graphic in
your report is only a copy of the original. That copy is stored as part of the
report and no longer has a separate file name. Any changes Make to the
graphic affect the copy only; they do not alter the original.

Inserting, Moving, and Deleting Graphics

Crystal Reports enables you to insert, move, and delete graphics with ease.

Inserting a Graphic

You can insert graphics anywhere you want them to appear on your report.

Use the following procedure to insert a graphic.

1. Select Insert|Graphic (or click the Insert Graphic button on the button bar).

The Choose Graphic File dialog box appears.

2. Select the graphic you want to enter in your report, and click OK when finished.

Crystal Reports returns you to the Report Editor, and an outline the size of the
graphic appears as an aid in placement.

3. Position the outline where you want the graphic to appear and click the left
mouse button to place it.

Crystal Reports displays the graphic where placed it.

Moving a Graphic

You can move a graphic in one of two ways:

using the mouse
using the dialog box
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Moving Graphics Using the Mouse

Move a graphic with the mouse if you want to determine its final placement visually.

To move a graphic using the mouse, click the graphic and, keeping the
left mouse button depressed, drag the graphic to the place you want it.

NOTES:
a - You can move the graphic within its current section, or move it to a new
section if you wish. The position of the upper left hand corner of the graphic
(not the position of the arrow) determines the section in which the graphic will
appear.

b - Make sure you do not click the graphic on the handles. If you do, you will
resize the graphic when you drag it.

Moving Graphics Using the Dialog Box

Move a graphic using the dialog box if you want the graphic to appear at an absolute
position on your report.

1. Select the graphic you want to move and select Format|Graphic to call up the
Graphic Format dialog box. (Alternately you can double click the graphic to call
up the dialog box or select the graphic and then select Change Format from the
right mouse button menu.)

2. Click the Position button.

The Graphic Position dialog box appears. This dialog box indicates the position
of the graphic relative to the top left corner of its section.

To position the graphic even with the top left corner (the top flush
against the top of the section, the left side flush against the left side
of the section), enter the following settings: Top 0.00, Left 0.00.
To move the graphic to the right, increase the Left setting. For
example, to move the graphic in two inches from the left edge of the
section, enter 2.00 for the Left setting (assuming you're working in
inches).
To move the graphic down in the section, increase the Top setting.
For example, to move the graphic down two inches from the top of
the section, enter 2.00 for the Top setting.

NOTE:
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Crystal Reports automatically resizes the section to accommodate the new
graphic location.

3. Click OK when finished to return to the Graphic Format dialog box, and click
OK once there to return to the Report Editor.

Your graphic will be positioned according to your specifications.

Deleting a Graphic

Crystal Reports makes it easy for you to delete a graphic from your report.

Use the following procedure to delete a graphic.

1. Select the graphic you want to delete.

2. Select Edit|Clear, press the Delete key, or select Delete Graphic from the right
mouse button menu.

Sizing and Scaling Graphics

Size and Scaling are two interrelated options that appear in the Graphic Format
dialog box.

Size refers to the absolute length and width of a graphic. If the original
graphic is one inch wide, it has an absolute width of one inch. If you
double the width of the graphic it has an absolute width of two inches.
Scaling refers to the length and width of a graphic as a percentage of the
original length and width. If the original graphic is one inch wide, it has
a width scaling value of 100%. If you double the width of the graphic, it
has a width scaling value of 200%.
When you first place a graphic, Crystal Reports presents it  in its original
size (the size in which it was saved).
- When you change the size values in the Graphic Format dialog box,

Crystal Reports adapts the scaling values to the new height and/or
width.

- When you change the scaling values in that dialog box, the program
adapts the size values to the new height and/or width.

- When you resize the graphic using the mouse, the program adapts the
size values and the scaling values in the dialog box to the new height
and/or width.
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When select a graphic for placement, Crystal Reports presents an outline that
indicates the original size of the graphic (the size in which it was saved). When place
the outline, the graphic replaces the frame. You can then enlarge or reduce the size
of the graphic to fit your needs. You have two options for doing this:

using the mouse, and
using the Format|Graphic command.

Resizing Using the Mouse

You can expand or reduce the size of the graphic using a mouse via the sizing
handles that appear on the sides and corners of the graphic when select it. (To select
a graphic, click it with the left mouse button.)

The Sizing Handles

The sizing handles provide a very straightforward means of resizing your graphic:

The handles on the right and left sides of the graphic expand or reduce
the width of the graphic without affecting the height. For example, if
your graphic was a square initially, it becomes a rectangle with the top
and bottom becoming longer than the sides (if expanded) or shorter than
the sides (if reduced). This kind of sizing results in a graphic that has
different proportions than the original.
The handles on the top and bottom of the graphic expand or reduce the
height of the graphic without affecting the width. For example, if your
graphic was a square initially, it becomes a rectangle with the sides
becoming longer than the top and bottom (if expanded) or shorter than
the top and bottom (if reduced). This kind of sizing also results in a
graphic that has different proportions than the original.
The handles on the corners of the graphic expand or reduce the height
and width of the graphic equally. If your graphic was originally a square,
it remains a square even though it has been resized. This kind of sizing
results in a graphic that retains the same proportions as the original.

Use the following procedure to resize using a mouse.

1. Click the graphic to select it. Handles appear on the sides and the corners.

2. Resize the graphic by dragging on the appropriate handle.



256 Using LAN Support Center

You can resize your graphic in two different ways using the Graphic Format dialog
box:

resizing a graphic to an absolute size, and
scaling a graphic to a percentage of its original size.

Resizing to Absolute Size

Use the following procedure to resize a graphic to an absolute size.

1. Click the graphic to select it and then select Format|Graphic to call up the
Graphic Format dialog box. (Alternately you can double click the graphic to call
up the dialog box or select the graphic and then select Change Format from the
right mouse button menu.)

2. Enter the new height and/or width in the Size box.

3. Click OK when finished.

Crystal Reports resizes your graphic to your new specifications.

Use the following procedure to resize a graphic as a rercentage of its original size.

1. Click the graphic to select it and then select Format|Graphic to call up the
Graphic Format dialog box. (Alternately you can double click the graphic to call
up the dialog box or select the graphic and then select Change Format from the
right mouse button menu.)

2. Enter the new scale value for the height and/or width in the Scaling box.

3. Click OK when finished.

Crystal Reports resizes your graphic to your new specifications.

NOTES:
a - When you change the Size values, the Scaling values won't change while the
dialog box is open. Also, when you change the Scaling values, the Size values
won't change while the dialog box is open. The changes will appear the next
time you open the dialog box.

b - Crystal Reports automatically resizes the appropriate report section to
accommodate the resized graphic.
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Cropping Graphics

Cropping refers to “cutting away” those portions of your graphic that you do not
want to print. If, for example, when you scanned your company logo from a
letterhead you also scanned in some extraneous material (company address,
corporate officers, etc.), you will probably want to “sanitize” the logo before use it.
Using Crystal Reports cropping capability, you can easily cut away the extraneous
material leaving only the logo to print.

There are two ways to crop a graphic:

using the mouse
using the dialog box

Cropping Using the Mouse

Using the mouse is the easiest way to crop a graphic. It doesn't require any
guesswork and you see your results immediately on screen.

You crop by dragging the resizing handles while depressing the Shift key.

When you drag the top handle down, you cut off part of the top part of
the graphic.
When you drag the bottom handle up, you cut off part of the bottom part
of the graphic.
When you drag the right side handle to the left, you cut off part of the
right side of the graphic.
When you drag the left side handle to the right, you cut off part of the
left side of the graphic.
When you drag one of the corner handles into the graphic, you cut off
part of two sides of the graphic simultaneously (the top and a side, or the
bottom and a side).
When you drag any of the handles away from the graphic (dragging the
top handle up, the left handle to the left, etc.) you expand the frame and
put white space between the graphic and the frame.

Use the following procedure to crop a graphic using the mouse.

1. Select the graphic you want to crop.

Sizing handles appear on the graphic.

2. With the Shift key depressed, crop your graphic by dragging the appropriate
sizing handle(s).
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3. When finished, release the Shift key, resize the graphic if needed, and move the
cropped graphic into place.

NOTE:
Resizing a graphic does not undo the cropping. It simply resizes that portion of
the graphic that remains after cropping.

Cropping Using the Dialog Box

When you crop a graphic using the dialog box, you specify (in inches or
centimeters) the piece of the graphic that Crystal Reports is to cut from the top,
bottom, right, and/or left side.

NOTE:
This method of cropping can be particularly useful if you want to take a specific
sized piece off each side of your graphic. For example, if you want to cut exactly
one inch off all four sides of your graphic,you can do it more quickly and
accurately with the dialog box than the mouse.

Use the following procedure to crop a graphic using the dialog box.

1. Select the graphic you want to crop and select Format|Graphic to call up the
Graphic Format dialog box. (Alternately you can double click the graphic to call
up the dialog box or select the graphic and then select Change Format from the
right mouse button menu.)

2. In the Cropping box, enter the amount you want to crop from the Top, Left,
Bottom, and/or right sides of your graphic.

Enter positive numbers to cut parts off your graphic.
Enter negative numbers to expand the frame, leaving white space
between the frame and the graphic.

NOTE:
All cropping settings apply to the size of the original graphic. If the graphic has
been resized before cropping, make certain use the Original Size settings as
guidelines when entering your new cropping instructions. As a general rule,
when you are going to crop and resize a graphic, crop the graphic first, and
then resize it.

3. Click OK when finished.

Crystal Reports returns you to the Report Editor with the Graphic cropped to
your specifications.
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NOTE:
While there are many options in the Graphic Format dialog box, to crop a
graphic you only need to concern yourself with the cropping instructions.
Crystal Reports automatically maintains the scale and adjusts the absolute size
of the graphic so it will display and print to your specifications.

To restore a cropped graphic to its original size and shape, change all of the
Cropping of original settings to 0.00.

To restore a resized graphic to its original size and shape, change both
Scaling settings to 100%.

To restore a cropped and resized graphic to its original size and shape,
change both the cropping and the scaling settings as described above.

Creating, Moving, and Formatting Lines

Crystal Reports enables you to create freeform lines that you can use to highlight
field data, blocks of data, or entire sections of your report.

Use the following procedure to create a line.

1. Click Insert|Line.

A pencil cursor appears.

2. Set the tip of the cursor (the pointed end) where you want the line to begin and
drag the cursor horizontally or vertically with the left mouse button depressed.

The line appears as you drag the cursor.

3. Release the mouse button when the line is the length you want it.

NOTE:
To format the line (set line style, width, and color), use the Format|Line
command.

Moving a Line

You can move a graphic line using the mouse, or with the keyboard using the arrow
keys.

Use the following procedure to move a line using the mouse.

1. Click the line to select it.
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NOTE:
When selecting a line or other graphic, the mouse cursor must be an Arrow.
Make sure the cursor changes to an arrow before you attempt to select a line.

2. Drag the line where you want it.

Make sure to keep the left mouse button depressed as move it.

3. Release the mouse button once your line is in position.

Use the following procedure to move a line with the arrow keys.

1. Click the line to select it.

2. Use the arrow keys to move the line up, down, right, or left and position it
where you want it.

NOTE:
Crystal Reports displays line coordinates in the Status Bar to help you adjust
the size and position of a line. Using the status bar readings, you can easily
place a line at a specific location on your report, or align two or more graphic
elements with each other.

Formatting a Line

Crystal Reports allows you to specify the style, width, and color for each graphic
line you include in your report. Enter your line formatting specifications in the Line
Format dialog box.

Use the following procedure to format a graphic line.

1. Select the line of interest and then select Format|Line. (Alternately, you can
double click the line or select Change Format from the right mouse button
menu.)

The Line Format dialog box appears.

2. Enter your formatting instructions for the line.

3. Click OK when finished.

Crystal Reports returns you to the Report Editor with the line formatted to your
specifications.
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Resizing a Line

Once you have created a line, you can adjust its length using either the mouse or the
keyboard arrow keys.

Use the following procedure to resize a line using the mouse.

1. Select the line you wish to resize.

2. Move the mouse so that the cursor is over one of the square sizing handles at the
endpoints of the line.

NOTE:
When the mouse cursor is over one of the sizing handles, it changes to a double
headed arrow (the Resizing cursor).

3. Drag the handle until the line is the length you want.

Use the following procedure to resize a line using the arrow keys.

1. Using the mouse, select the line you want to resize.

2. While holding down the Shift key, press:

the Right Arrow key to lengthen a horizontal line,
the Left Arrow key to shorten a horizontal line,
the Down arrow key to lengthen a vertical line, or
the Up arrow key to shorten a vertical line.

Creating, Moving, and Formatting Boxes

Crystal Reports enables you to create free-form graphic boxes that you can use to
highlight field data, blocks of data, or entire sections of your report.

You can also use graphic boxes by themselves, as stand-alone graphic elements, to
add visual interest to your report.

Use the following procedure to create a box.

1. Click Insert|Box. A pencil cursor appears.

2. Set the tip of the cursor (the pointed end) where you want to anchor one corner
of the box and drag the cursor towards the opposite corner with the left mouse
button depressed.

The box appears as you drag the cursor.
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3. Release the mouse button when the box is the size you want it.

NOTE:
To format the box (set line style and width, line color, etc.), use the Format|Box
command.

Moving a Box

You can move a graphic box using the mouse, or with the keyboard arrow keys.

Use the following procedure to move a box using the mouse.

1. Click the box to select it.

NOTE:
You can select a box only with an arrow cursor. Position the I-beam near the
box edge until it changes to an arrow and then click the edge of the box (not the
center) to select it.

2. Drag the box where you want it.

Make sure to keep the left mouse button depressed as move it.

3. Release the mouse button once your box is in position.

Use the following procedure to move a box with the arrow keys.

1. Click the box to select it.

2. Use the arrow keys on the keyboard to move the box up, down, right, or left
until it is in the position that you want.

NOTE:
Crystal Reports displays box coordinates in the Status Bar to help you adjust
the size and position of a graphic box. Using the status bar readings, you can
easily place a box at a specific location on your report, or align two or more
boxes with each other.

Formatting a Box

Crystal Reports allows you to change:
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the box style (the kind of line that outlines the box: single solid line,
single dashed line, etc.),
the width (thickness) of the line that outlines the box, and
the color of the line that outlines the box.
Additionally, you can specify the fill for the box (whether the box is
filled with a color or empty).

Enter your box formatting specifications in the Box Format dialog box.

Use the following procedure to format a box.

1. Select the box of interest and then select Format|Box. (Alternately, you can
double click the box or select Change Format from the right mouse button
menu.)

The Box Format dialog box appears.

2. Enter your formatting instructions for the box.

3. Click OK when finished.

Crystal Reports returns you to the Report Editor with the box formatted to your
specifications.

Resizing a Box

Once you have created a box, you can adjust its size using either the mouse or the
keyboard arrow keys.

Use the following procedure to resize a box using the mouse.

1. Select the box you wish to resize.

2. Move the cursor over one of the square sizing handles.

NOTE:
When the cursor is over one of the sizing handles, it changes to a double headed
arrow (the resizing cursor).

3. Drag the handle until the box is the size you want:

If you want to change the height of the box, drag the handle at the
top or the bottom.
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If you want to change the width of the box, drag the handle at the
right or the left side.
If you want to change both the height and the width at the same time,
drag one of the handles at the corners of the box.

Use the following procedure to resize a box using the arrow keys.

1. Using the mouse, select the box you want to resize.

2. While holding down the Shift key, press:

the Right Arrow key to make the box wider,
the Left Arrow key to make the box narrower,
the Down arrow key to make the box taller, or
the Up arrow key to make the box shorter.
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Notes
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Appendix A  Error Messages

This appendix lists the error messages associated with LSC.  All messages are listed
in alphabetical order.

LSC Error Messages
A reserved item cannot be edited or deleted.

There are certain items in the qualification lists that are reserved or pre-defined, for instance, the
“TO_DO” action code is reserved.

Component, Operator, and Description fields must be filled in.
To insert filter criteria for a query through Add Query or Edit Query dialog boxes, you need to select
data for all three fields.

Delete the action selected?
LSC asks for your confirmation before deleting an action in the View Tickets window.

Delete the Staff selected?
LSC asks for your confirmation before deleting a staff in the Setup Staff dialog box.

Delete the ticket selected?
LSC asks for your confirmation before deleting a ticket from the database.

Delete the View Name selected?
LSC asks for your confirmation before deleting a view in the Custom View Settings dialog box.

Do you want to delete this entry?
LSC asks for your confirmation before deleting an entry in the Qualification Lists dialog box.

Error: The date range is not valid.
When entering the date range in the Filter Ticket List dialog box, the To date must be equal to or later
than the From date.

Error: Unable to create or open specified file.
To archive tickets to a file or restore tickets from a file, LSC must create or open a file accordingly.  This
message occurs if the operation is unsuccessful.
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Extremely low in memory.  Unable to invoke ticket window.  Please close one or more
tickets to free up memory.

As an MDI (Multiple Document Interface) application, LSC allows you to open more than one ticket
window simultaneously.  The maximum number of windows are limited to the PC’s memory.  When the
threshold is reached, the message alerts you to close one or more ‘least used’ ticket.

Field cannot be left empty.
When editing an item in a qualification list, you cannot enter an empty string.

Login incorrect.  Please try again or click the Cancel button to abort.
The login initials and password combination provided is incorrect.  You may retry or abort logging in to
LSC.

Please close all ticket windows before switching to view another set of ticket database.
LSC allows you to view either the current or a historical database.  Before you switch from one to the
other, you need to close all ticket windows to prevent database corruption.

Please do not specify filename with .ACT, .DES, or .DEA extension.
The ticket database is maintained in 3 files, HLPDSK1H.DAT, HLPDSK1A.DAT, HLPDSK1P.DAT
and HLPDSK1T.DAT.  When archiving tickets, you need to specify a filename (usually with the .ARC
extension).  The file will hold data from HLPDSK1H.DAT.  LSC will use the same filename, but assign
the .ACT extension to hold the data from HLPDSK1A.DAT, the .DES extension to hold the data from
HLPDSK1P.DAT, and the .DEA extension to hold the data from HLPDSK1T.DAT.  Consequently, the
message occurs if you specify the .ACT file extension.

Please provide a View Name.
When defining or editing a custom view in the Custom View Settings dialog box, you need to name the
view in order to save the configuration.

Please provide the Account ID.
When adding/editing the Account information, the Account ID field cannot be left empty.

Please provide the Company ID.
When adding/editing the Company information, the Company ID field cannot be left empty.

Please provide the Staff Initials.
When adding or editing the staff profile in the Setup Staff dialog box, you need to provide the staff
initials.  This message can also occur if you did not provide the initials for the Login dialog box.

Please select a ticket on the View Tickets list first before the specified operation can be
completed.

Before you try to perform a ticket-related operation (e.g., Add Action, Contact Details, Delete Ticket),
you must first highlight a ticket on the View Tickets list by clicking on it.

Please specify a Closed Date/Time which is equal or later than the Opened Date/Time.
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When you close a ticket, you may only specify a Closed Date/Time that is later than the Opened
Date/Time.

Please specify a file for the archived tickets.
To archive tickets, you need to specify a filename as the destination.

The Account ID has already been used.  Please provide a different ID.
When adding/editing Account information, the Account ID must be unique.

The addition of this staff member will exceed the number of LSC users allowed by your
license.  Please contact McAfee to purchase additional copies of the LSC software.

You are attempting to add more staff than the number indicated by the LSC license you have purchased.
You may increase the number of  staff by upgrading your license.  Please contact McAfee.
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The Company ID has already been used.  Please provide a different ID.
When adding/editing Company information, the Company ID must be unique.

The current ticket is the first ticket in the database according to the Filter/Sort criteria.
When you choose the Previous tool bar button or choose the Previous Ticket command from the Ticket
menu, LSC will search the database for the previous ticket according to the Filter/Sort order.  This
message appears if the present ticket displayed is the first ticket.

The current ticket is the last ticket in the database according to the Filter/Sort criteria.
When you choose the Next tool bar button or choose the Next Ticket command from the Ticket menu,
LSC will search the database for the next ticket according to the Filter/Sort order.  This message appears
if the present ticket displayed is the last ticket.

The new password was not retyped correctly.
When adding or editing the staff profile in the Setup Staff dialog box, the two password fields must be
equivalent to confirm the choice.

The number of view names included on the menu has reached the maximum.
To accommodate the limited length of a pop-up menu, the maximum number of views that can appear
on the View menu is ten (10).  When defining or editing a custom view in the Custom View Settings
dialog box, this message occurs if you choose to include the view on the menu and there are already ten
custom-defined views on the menu.

The related information for this account has changed.  Do you wish to update the account
information?

You have added/changed the related information for the account selected in the Account ID field:  First
Name, Last Name, Phone, Department, or Network Address fields.  To update the account information,
choose the Yes button.  To save the modified information with that ticket only, choose the No button.
To return to the Ticket window, choose the Cancel button.

The Staff Initials has already been used.  Please provide different initials.
When adding or editing the staff profile in the Setup Staff dialog box, the initials must be unique.

The View Name has already been used.  Please provide a different name.
When defining or editing a custom view in the Custom View Settings dialog box, the view name must
be unique.

There are no archived tickets in the file specified.  Please select a file that contains archived
tickets.

When restoring tickets from a file, the file specified does not have archived tickets.  The restoration
process cannot continue.

This item has already been defined in the database.
When adding or editing an item through the Qualification Lists dialog box, the name must be unique
within each list.
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This ticket is currently being edited by another user.  Please make your changes later.
To support multiple users, LSC locks the ticket (window) last opened by each user.  This ensures that
only one person can save changes to a ticket at any time.  When users attempt to edit the same ticket
simultaneously, only the changes made by the “first” user (the user who locks the ticket) will be
effective.  All other users will be alerted with a message to edit the ticket later.

This will save the detail information for this account.  Do you wish to continue?
This message enables you to confirm whether you wish to save modifications made to a company’s
contact detail information (the address, Email, fax, etc.).  There can only be one company ID associated
with an account ID.

Warning: The corresponding .ACT file cannot be opened. Do you wish to continue?
When restoring tickets from a file, LSC cannot open the corresponding .ACT file, or the file does not
exist in the same directory as the .ARC file (the main archive file).  The .ACT file contains the ticket
actions.

Warning: The corresponding .DES file cannot be opened. Do you wish to continue?
When restoring tickets, LSC cannot open the corresponding .DES file, or the file does not exist in the
same directory as the .ARC file (the main archive file).  The .DES file contains the ticket problem
descriptions.

Warning: The corresponding .DEA file cannot be opened. Do you wish to continue?
When restoring tickets, LSC cannot open the corresponding .DEA file, or the file does not exist in the
same directory as the .ARC file (the main archive file).  The .DEA file contains the action descriptions.

Warning: The file specified does not have archived tickets.  Overwrite file contents?
When you choose to archive tickets to a file, the file selected has a format that is different from the LSC
database.  Responding Yes to the message will overwrite the file’s existing content with LSC database
information.

You do not have the rights to add new item in the highlighted field.  Please select an
existing value or see your administrator for granting the proper rights.

The LSC administrator has set up your security profile (through Setup Staff) such that you may only
select existing items from the Qualification Lists (e.g.  Problem Type, Product Category, Issue Type,
etc.).  In addition, if you are not granted the right to “Setup Staff”,  you will not be allowed to add new
values in the “Assigned to” and “Person” fields in the Ticket and Add/Edit Action windows respectively.
See your LSC administrator to modify your rights.

You have too many tickets in the database to perform filter/sort operation completely.
Please archive old or unwanted tickets.

This message displays when there is a large number of tickets in your database and you attempt to
perform a filter/sort operation.  It is recommended that a maximum of 20,000 tickets be maintained in
any ticket database.

You may not delete this staff as he/she is logged in to LSC.
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As a security measure, you may not delete a staff member in the Setup Staff dialog box when he/she is
logged in to LSC.

You may not login to LSC with the same staff initials more than once.
As a security measure, you may login to LSC using the same initials on only one station.

You may only delete the activities with the TO_DO action code.
Your rights to delete activities are limited to only those that have the “TO_DO” action code.  To delete
any other activities, your staff profile needs to be updated in the Setup Staff dialog box.

You may only edit the tickets that are assigned to you.
Your rights to edit tickets are limited to those tickets assigned to you only.  To edit all other tickets, your
staff profile needs to be updated in the Setup Staff dialog box.

You must enter a Query name.
When adding or editing a query, the Query Name must be supplied.

You cannot delete a pre-defined report.
There are pre-defined reports that are shipped with LSC which print ticket information in a easy-to-read
format.  These reports are protected from being deleted accidentally.

You cannot rename a pre-defined report.
There are pre-defined reports that are shipped with LSC which print ticket information in a easy-to-read
format.  These reports are protected from being renamed accidentally.
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Appendix B  Btrieve Status Codes

This appendix lists the return status codes for Novell’s Btrieve Record Manager.

Btrieve Status Codes
Btrieve returns a status code after each operation an application performs. If the
operation was successful, Btrieve returns status code 0. If the operation was not
successful, Btrieve will return one of the nonzero status codes described in this
section.

If Btrieve returns a code that is not contained in this section, refer to your Btrieve
Installation and Operation Manual for error codes from the utilities.

01  INVALID OPERATION
The operation parameter specified in the call is invalid.

02  I/O ERROR
An error occurred during disk read/write. This status code indicates that the file has been damaged and
must be recreated, or that the file specified on the open call was not created. This status code also occurs
if the application passed an invalid position block.

03  FILE NOT OPEN
The operation cannot execute because the file is not open. A successful Open operation must be
performed before Btrieve can process any other operations. This status code may also occur if the
application passed an invalid position block for the file.

04  KEY VALUE NOT FOUND
The specified key value in the index path was not found.

05  DUPLICATE KEY VALUE
A record with a key field containing a duplicate key value cannot be added to an index that does not
allow duplicate values.
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06  INVALID KEY NUMBER
The value stored in the key number parameter was not valid for the file being accessed. The key number
must correspond to one of the keys defined when the file was created or to a supplemental index.

07  DIFFERENT KEY NUMBER
The key number parameter changed before a Get Next, Get Next Extended, Get Previous, Get Previous
Extended, Update, or Delete operation. The operation specified requires the same key number parameter
as the previous operation because Btrieve uses positioning information relative to the previous key
number.

If you need to change key numbers between consecutive Get Next, Get Next Extended, Get Previous, or
Get Previous Extended operations, use a Get Position operation followed by a Get Direct operation to re-
establish positioning for the new index path.
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08  INVALID POSITIONING
The current position must be established to update or delete a record. Perform a Get or Step operation to
establish the current position. This status code may also occur if the application passed an invalid
position block for the file.

09  END-OF-FILE
The operation tried to read past the file boundaries (end-of-file or start-of-file). When reading a file in
ascending order according to an index path, Btrieve returns the last record in that index path. When
reading a file in descending order according to an index path, Btrieve returns the first record in the index
path.

The Get Extended and Step Extended operations return this status code if the number of records
satisfying the filtering condition is less than the number of specified records to be returned and the reject
count has not been reached.

10  MODIFIABLE KEY VALUE ERROR
The operation tried to modify a key field which is defined as non-modifiable.

11  INVALID FILENAME
The filename specified does not conform to file naming conventions.

12  FILE NOT FOUND
The filename specified does not exist. Check the key buffer parameter to make sure the pathname is
terminated with a blank or a binary zero.

13  EXTENDED FILE ERROR
Btrieve could not find the extension file for an extended file which the application tried to open.
Extension files must be loaded on the logical disk drive specified when the extension was created. Both
the primary file and its extension file must be on-line to access an extended file.

14  PRE-IMAGE OPEN ERROR
The pre-image file could not be created or opened. There are three possible causes for this error.

• Btrieve could not create a new pre-image file because your disk directory is full. Btrieve must be
able to create a pre-image file.

• Btrieve could not open the pre-image file to restore file integrity. If the pre-image file was erased
or damaged, Btrieve cannot restore the file’s integrity. In this case, either use the RECOVER
command in the BUTIL utility to retrieve the damaged file’s data records in a sequential file, or
replace the file with its most recent backup.

• Btrieve could not assign a handle to the pre-image file because the Btrieve was not started by a
user with access rights to the pre-image file.

15  PRE-IMAGE I/O ERROR
An I/O error occurred during the pre-imaging function. Either the disk is full or the pre-image file is
damaged.
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• If the disk is full, erase any unnecessary files or extend the file to gain additional disk space.

• If the pre-image file is damaged, the integrity of the Btrieve file cannot be ensured. Either use the
RECOVER command in the BUTIL utility to retrieve the damaged file’s data records in a
sequential file, or replace the file with its most recent backup.

16  EXPANSION ERROR
An error occurred while writing the directory structure to disk prior to the creation of the expanded file
partition. Either Btrieve could not close the file, or a new page was added to the file and Btrieve could
not close and reopen the file to update the directory structure. Check for a disk hardware failure.

17  CLOSE ERROR
An error occurred while writing the directory structure to disk prior to closing the file. Either Btrieve
could not close the file, or a new page was added to the file and Btrieve could not close and reopen the
file to update the directory structure. Check for a disk hardware failure. This status code also occurs if
the application passed an invalid position block for the file.

18  DISK FULL
The disk is full and the file could not be expanded to accommodate the insertion. Either erase any
unnecessary files or extend the file to gain additional disk space.

19  UNRECOVERABLE ERROR
An unrecoverable error has occurred. File integrity cannot be ensured. Either use the RECOVER
command in the BUTIL utility to retrieve the damaged file’s data records in a sequential file, or replace
the Btrieve with its most recent backup.

20  RECORD MANAGER INACTIVE
A request has been made before the Record Manager has been started. Restart the Record Manager.

In network environments, the operation was not processed because BREQUEST was not loaded. Reload
BREQUEST.

21  KEY BUFFER TOO SHORT
The key buffer parameter was not long enough to accommodate the key field for the index path
requested. Verify that the length of the key buffer equals the defined length of the key specified in the
key number parameter. This status code can be returned only by certain interfaces.

22  DATA BUFFER LENGTH
The data buffer parameter was not long enough to accommodate the length of the data record defined
when the file was created. Verify that the length of the data buffer is at least as long as the file’s defined
record length.

• For Get or Step operations, if the data buffer is too short to contain the fixed length portion of the
record, Btrieve does not return any data to the data buffer. If the record is a variable length record
and the data buffer is too short to contain the entire variable length portion of the record, Btrieve
returns as much data as it can and a status code 22, indicating that it could not return the entire
record.
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• For the Insert operation, Btrieve does not insert the record if the data buffer is shorter than the
fixed length portion of the record.

• For the Update operation, if the data buffer is too short to contain the fixed length portion of any
record, Btrieve does not update the record.

• For the Create, Stat, and Create Supplemental Index  operations, a status code 22 indicates that the
data buffer is not long enough to contain all the file and key specifications, and the alternate
collating sequence definition, if specified.

23  POSITION BLOCK LENGTH
The position block parameter was not 128 bytes long. This error can only be detected using certain
language interfaces.

24  PAGE SIZE ERROR
The page size was invalid. The page size must be a multiple of 512 bytes but must be no larger than
4096 bytes. To solve this, run or load BSETUP at the server. Change the page size to 4096 and the
largest record size to 17000. See Appendix C for more information.

25  CREATE I/O ERROR
The file specified could not be created. Possible causes are a full disk directory or a full disk. If you are
creating a file over an existing file, Btrieve returns this status code if the existing file is open or the
operating system does not allow the creation for some other reason (for example, a NetWare file is
flagged transactional).

26  NUMBER OF KEYS
The number of keys specified for the page size was invalid. For standard Btrieve files with a page size of
512 bytes, the number of key segments must be between 1 and 8. For larger page sizes, the number of
key segments must be between 1 and 24. You must define at least one key without the null attribute.

27  INVALID KEY POSITION
The key field position specified exceeded the defined record length for the file. Either the key position
was greater than the record length or the key position plus the key length exceeded the record length.
For key-only files, the key must begin in the first byte of the record (position 1).

28  INVALID RECORD LENGTH
The record length was invalid. The record length specified (plus overhead for duplicates) must be less
than or equal to the page size minus 6 or greater than or equal to 4 bytes long.

29  INVALID KEY LENGTH
The key length was invalid. The key length specified must be greater than zero and cannot exceed 255.
The length of a binary key must be even. Btrieve requires that each key page in the file is large enough
to hold at least eight keys.

If the page size is too small to accommodate eight occurrences of the specified key length (plus
overhead), either increase the file’s page size, or decrease the key length.
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30  NOT A BTRIEVE FILE
The filename specified is not a valid Btrieve file. Either the file was not created by Btrieve, or it was
created by an earlier version of Btrieve.

Another possibility is that the first page of the file, which contains the File Control Record, is damaged.

31  FILE ALREADY EXTENDED
The file specified has already been extended. A file can be extended only once.

32  EXTEND I/O ERROR
The file could not be extended. Possible causes are that the directory is full, the disk is full, or the disk is
write protected.

34  INVALID EXTENSION NAME
The filename specified for the extended partition was invalid.

35  DIRECTORY ERROR
An error occurred while changing to the directory that contains the Btrieve file. Either the drive specified
in the Get Directory operation does not exist or the pathname specified in a Set Directory operation was
invalid.

36  TRANSACTION ERROR
A Begin Transaction operation could not be performed because no transactions were specified when the
Btrieve was initialized.

37  TRANSACTION IS ACTIVE
A Begin Transaction was issued while another transaction was active at that station. Transactions cannot
be nested.

38  TRANSACTION CONTROL FILE I/O ERROR
An error occurred when Btrieve tried to write to the transaction control file. Possible causes were that the
disk was full, the disk was write protected, or the transaction control file (which was created when the
Btrieve was loaded) was deleted.

39  END/ABORT TRANSACTION ERROR
An End or Abort Transaction operation was issued without a corresponding Begin Transaction
operation.

40  TRANSACTION MAX FILES
The application tried to update more than the maximum number of files allowed within a transaction.
The maximum number of different files that can be updated during a logical transaction is set when
Btrieve is configured. Refer to your Btrieve Installation and Operation manual  for more information
on configuration.
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41  OPERATION NOT ALLOWED
The application tried to perform an operation that is not allowed at this time. Some operations are not
allowed under certain operating conditions. For example, Btrieve returns this status code if you attempt
to perform a Step, Update, or Delete operation on a key-only file or a Get operation on a data only file.

Also, certain operations are prohibited during transactions because they have too great an effect on the
pre-image file or on Btrieve’s performance. These operations include Close, Set or Clear Owner, Extend,
Create Supplemental Index, and Drop Supplemental Index.

42  INCOMPLETE ACCELERATED ACCESS
The application tried to open a file that was previously accessed in accelerated mode and never
successfully closed. The file’s integrity cannot be ensured. Either use the RECOVER command in the
BUTIL utility to build a new file or restore the file using the latest backup.

43  INVALID RECORD ADDRESS
The record address specified for a Get Direct operation was invalid. The address is outside of the file’s
boundaries; it is not on a record boundary within a data page, or on a data page. The 4-byte address you
specify for a Get Direct operation should be one that was obtained by a Get Position operation.

44  NULL KEY PATH
The application tried to use the Get Direct operation to establish an index path for a key whose value is
null in the corresponding record. Btrieve cannot establish positioning based on a null key value.

45  INCONSISTENT KEY FLAGS
The key flags specification on a Create operation was inconsistent. If a key has multiple segments, the
duplicate, modifiable, and null attributes should be the same for each segment in the key.

46  ACCESS TO FILE DENIED
The application opened a file in read-only mode and tried to perform an Update, Delete, or Insert on that
file. Another possible cause is that the owner name required for updates was not specified correctly
when you opened the file.

47  MAXIMUM OPEN FILES
The number of files opened in accelerated mode exceeded the number of buffers available in Btrieve’s
cache. When a file is opened in accelerated mode, Btrieve reserves one of its cache buffers for the file.
Btrieve always reserves five empty buffers for index manipulation. Reconfigure the Btrieve Record
Manager with a smaller page size parameter to allocate more buffers.

48  INVALID ALTERNATE SEQUENCE DEFINITION
The first byte of an alternate collating sequence definition (the identification byte) did not contain the
hexadecimal value AC.

49  KEY TYPE ERROR
The application tried to create a file or a supplemental index with an invalid extended key type, or tried
to assign an alternate collating sequence to a binary key or key segment. You can only assign an
alternate collating sequence to a string, lstring, or zstring key type.
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This status code is also returned if you define a supplemental index requiring an alternate collating
sequence, and no alternate collating sequence definition exists either in the file or in the key definition
passed in the data buffer.

50  OWNER ALREADY SET
The application tried to perform a Set Owner operation on a file that already has an owner. Use the Clear
Owner operation to remove the previous owner before specifying a new one.

51  INVALID OWNER
There are two possible causes for this status code:

• If your application received this status code after a Set Owner operation, the owner names
specified in the key buffer and data buffer did not match.

• If your application received this status code after an Open operation, the file you tried to open has
an owner name assigned to it. Your application must specify the correct owner name in the data
buffer.

52  ERROR WRITING CACHE
While trying to make a cache buffer available, Btrieve tried to write data to a logical disk drive from a
file that was previously opened in accelerated mode. An I/O error occurred during a write.

53  INVALID INTERFACE
An application tried to access a file containing variable length records with a language interface from
Btrieve v3.15 or earlier. To access files with variable length records, you must use v4.xx or later
interface.

54  VARIABLE PAGE ERROR
During a Step Direct operation, Btrieve could not read all or part of the variable length portion of a
record. In this case, Btrieve returns as much data as possible to your application. This error usually
indicates file damage to one or more pages in the file.

55  AUTOINCREMENT ERROR
The application tried to specify either the segmented or duplicate attribute for an autoincrement key
type. An autoincrement key cannot be part of another key and cannot allow duplicates.

56  INCOMPLETE INDEX
A supplemental index was damaged. This can occur if a Create Supplemental Index operation or a Drop
Supplemental Index operation is interrupted and does not run to completion. Perform a Drop
Supplemental Index operation to completely remove the index from the file.

57  EXPANDED MEMORY ERROR
This error is applicable only in the client-based DOS environment. Btrieve returns this status if it
receives an error from the Expanded Memory Manager. This error usually means that Btrieve was
unable to save or restore the memory mapping register context, indicating an incompatibility with
another application that uses expanded memory.
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58  COMPRESSION BUFFER TOO SHORT
The application tried to read or write a record that is longer than the value specified for the size of the
compression buffer. Reconfigure the Btrieve Record Manager, specifying a higher value for the
“Maximum Compressed Record Size” option.

59  FILE ALREADY EXISTS
This status code is returned for the Create operation if you specified -1 in the key number parameter and
the name of an existing file in the key buffer parameter.

60  REJECT COUNT REACHED
Btrieve rejected the number of records specified by the reject count before an Extended Get/Step
operation found the requested number of records which satisfy the filtering condition. Check the first
two bytes of the data buffer returned for the number of records that were retrieved.

61  WORK SPACE TOO SMALL
The Extended Get/Step operations use the pre-image buffer as work space. This error code indicates that
the work space was not large enough to hold the filtering data buffer structure and the largest record to
be received. The size of the work space is configurable (see the Btrieve Installation and Operation
manual for more information). Check the first two bytes of the data buffer returned for the number of
records that were retrieved.

62  INCORRECT DESCRIPTOR
The descriptor (data buffer structure), which is passed for an extended Get or Step operation, is
incorrect.

63  INVALID EXTENDED INSERT BUFFER
Extended Insert provides an invalid buffer. Either the buffer length is less than five bytes, or the number
of records specified is zero.

64  FILTER LIMIT REACHED
During an Extended Get Next/Previous operation, a rejected record was reached. Furthermore, this
rejected record is such that no other record can satisfy the given filtering condition, going in the
direction specified by the operation. This is applicable only if the key specified by the key number is
also used as the filtering field.

65  INCORRECT FIELD OFFSET
The field offset in the extractor of an Extended Get/Step is invalid based on the length of the retrieved
record.

74  AUTOMATIC TRANSACTION ABORT
This is an informative status code and is applicable only in the server-based environment. Btrieve
replaced an End Transaction operation with an Abort Transaction because an error had been detected for
a TTS file inside the transaction. In addition, Btrieve executed the Abort Transaction operation.

78  DEADLOCK DETECTED



282 Using LAN Support Center

Btrieve detected a deadlock condition. The application should clear all resources (such as aborting or
ending the transaction or releasing all record locks) before proceeding. This allows the other applications
to access the resources for which they are waiting.

80  CONFLICT
The Update or Delete operation could not be performed because the record was changed by another
application since your application read the record. Reread the record prior to resending an Update or
Delete operation.

81  LOCK ERROR
This error can result from one of two conditions:

• The Btrieve lock table was full. Decrease the number of locks that your application uses or
reconfigure the Btrieve Record Manager and specify a higher value for the “Maximum Number of
Record Locks” option.

• The application tried to unlock one record that was locked with a multiple record lock, and the
record position stored in the data buffer did not correspond with any record that was locked in that
file.

82  LOST POSITION
When performing a Get Next or Get Previous on a key with duplicates, the application tried to retrieve a
record that was deleted or whose key value was modified by another application. Re-establish
positioning using a Get Equal or a Get Direct operation.

83  READ OUTSIDE TRANSACTION
The application tried to delete or update a record within a transaction, but the record was not read within
the transaction. If you are going to update or delete a record within a transaction, you must read the
record within the transaction to ensure you have first obtained exclusive access to the data.

84  RECORD LOCKED
The application tried to apply a nowait lock on a record that was currently locked by another application,
or to apply a nowait lock on a file while another application held active record lock(s) in that file.

If this status code is returned, your application can use either of the following two methods:

• Retry the operation until it is successful. Under light to moderate network use, this may be the
simplest and quickest solution.

• Use the wait option (+100/+300) instead of the nowait option.

85  FILE LOCKED
The application tried to apply a nowait record or file lock while another application held the file locked.
This status code is also returned when the application tries to open a file outside of a transaction and the
file is locked by some other application.

If this status code is returned, your application can use either of the following two methods:
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• Retry the operation until it is successful. Under light to moderate network use, this may be the
simplest and quickest solution.

• Use the wait option (+100/+300) instead of the nowait option.
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86  FILE TABLE FULL
Btrieve’s file table was full. Reconfigure Btrieve and specify a higher value for the “Maximum Number
of Open Files” option.

87  HANDLE TABLE FULL
This status code is applicable only in the server-based and Windows environments.

Btrieve’s handle table was full. Reconfigure the Btrieve and specify a higher value for the “Maximum
Number of File Handles” option.

88  INCOMPATIBLE MODE ERROR
The application tried to open a file in an incompatible mode. If the first application to access a file opens
it in accelerated mode, all other applications must open it in accelerated mode. If the first application to
access a file opens it in non-accelerated mode, other applications cannot open the file in accelerated
mode.

90  REDIRECTED DEVICE TABLE FULL
This status code is applicable only in the server-based environment.

BREQUEST’s redirection table or server routing table was full. This occurs if you attach to additional
servers or map to additional drives after you loaded BREQUEST. Reload BREQUEST, specifying a
larger number for the “Number of File Servers” or “Number of Mapped Drives” options (/S and /R
respectively).

This error also occurs if you detach a particular server and attach to a different server. Once a
workstation has attached to a server, BREQUEST will not remove its name from the server routing table.

91  SERVER ERROR
This status code is applicable only in the server-based environment.

BREQUEST could not establish a session with the server. In NetWare environments, either the NetWare
Btrieve Record Manager has not been started or the server was not active. Verify that the NetWare
Btrieve Record Manager is active on the server in question.

92  TRANSACTION TABLE FULL
This status code is applicable only in the server-based environment.

The maximum number of active transactions was exceeded. Reconfigure Btrieve and specify a higher
value for the “Number of Concurrent Transactions” option.

93  INCOMPATIBLE LOCK TYPE
Your application tried to mix single record locks (+100/+200) and multiple record locks (+300/+400) in
the same file at the same time. All locks of one type must be released before a lock of the other type can
be executed.

94  PERMISSION ERROR
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Your application tried to open or create a file in a directory without the proper privileges. Btrieve does
not override the network privileges assigned to users.

95  SESSION NO LONGER VALID
This status code is applicable only in the server-based environment.

The previously established session was no longer active due to an error at the workstation, the file
server, or on the network. Verify that your workstation is still attached to the file server and then reload
BREQUEST.

96  COMMUNICATIONS ENVIRONMENT ERROR
This status code is applicable only in the server-based environment.

This code occurs when loading Btrieve on a NetWare server. The SPX connection table is full. Reload
SPX, specifying a higher value for the connection table. Refer to the NetWare system documentation for
more information.

97  DATA MESSAGE TOO SMALL
This status code is applicable only in the server-based environment.

Your application tried to read or write a record which was longer than the Btrieve Record Manager or
BREQUEST could handle. Reconfigure the Btrieve Record Manager and specify a higher value for the
“Maximum Record Length” option. Reload BREQUEST and specify a higher value for the /D option.

• For an Update, Insert, or Create operation, the application receives this error if the data buffer
length it specifies for the record exceeds the length specified for the Btrieve Record Manager or
BSERVER.

• For a Get, Step, or Stat operation, the application receives this error if the value specified for the
data buffer length is shorter than the length of the data Btrieve would return, regardless of the data
buffer length specified in the program.

98  INTERNAL TRANSACTION ERROR
This status code is applicable only in the server-based environment.

An error has been detected while executing a previous operation on a NetWare TTS file. Therefore, no
operation other than Abort Transaction (21) is allowed at this point.

99  THE REQUESTER CANNOT ACCESS THE NETWARE RUNTIME SERVER
The DOS Requester returns this status code when NetWare Runtime server support is enabled (/C:1) and
the Requester either detects no existing connection or cannot find a valid login username. If the
Requester cannot find a login username other than SUPERVISOR, there is no valid name to pass.

100  NO CACHE BUFFERS ARE AVAILABLE
Btrieve has used all the cache buffers it allocated at load time. Using the Setup utility, you can increase
the value for the Cache Allocation configuration option. Alternatively, you can change the Number of
Remote Sessions configuration option to decrease the number of concurrent Btrieve users. For more
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information, refer to Chapter 3, “Installing and Configuring Btrieve,” in the Btrieve Installation and
Operation manual.

101  INSUFFICIENT OPERATING SYSTEM MEMORY IS AVAILABLE
There is not enough operating system memory available to perform the requested operation. Decrease
the value for the Cache Allocation configuration option (using the Setup utility), decrease the number of
concurrent Btrieve users (using the Number of Remote Sessions configuration option in the Setup
utility), or add memory to the server. For more information on the configuration options, refer to Chapter
3, “Installing and Configuring Btrieve,” in the Btrieve Installation and Operation  manual.

102  INSUFFICIENT STACK SPACE IS AVAILABLE
Btrieve has run out of stack space. To increase the amount of stack space available to your application,
relink the application, setting the stack size to a higher value. Only the NLM applications calling Btrieve
on the local server get this message.

103  THE CHUNK OFFSET IS TOO BIG
A Get Direct/Chunk operation has specified an offset beyond the end of the record, either explicitly or
through the use of the next-in-record bias to the subfunction value. Unless Btrieve returns this status
while processing the first chunk, the operation was partially successful. Check the data buffer length
parameter immediately after the call to see how much data (and therefore how many chunks) Btrieve
retrieved.

This code can also be returned by the Update Chunk operation when the specified offset is more than
one byte beyond the end of the record. However, in this situation, Status Code 103 indicates that Btrieve
made no changes to the record.

104  THE LOCALE INFORMATION COULD NOT BE FOUND
The Create or Create Index function returns this status code to indicate that the operating system was not
able to return a collation table for the country ID and code page specified. Check that the application
specified the locale’s country ID and code page correctly and that the operating system is configured to
support the country ID and code page.

105  THE FILE CANNOT BE CREATED WITH VARIABLE-TAIL ALLOCATION TABLES
(VATS)

The application specified that a Btrieve file should be created with Variable-tail Allocation Tables
(VATs); however, the application failed to specify that the file was to use variable-length records (a
precondition for files to use VATs). This status applies to key-only files as well as regular data files.

106  THE OPERATION CANNOT GET THE NEXT CHUNK
The application called the Get Direct/Chunk operation to retrieve a chunk from a record and used the
next-in-record bias on the descriptor subfunction. However, after the application established its
positioning in the record (but prior to this call), the target record was deleted.

107  CHUNK UPDATES/RETRIEVALS CANNOT BE PERFORMED ON THE FILE
The application tried to use either a Get Direct/Chunk operation or an Update Chunk operation on a pre-
v6.0 formatted file.
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Client-Based Btrieve for
OS/2 and Windows Status Codes

Client-based Btrieve may return the following status codes in an OS/2 or Windows
environment.

1001  THE MULTIPLE LOCKS OPTION IS OUT OF RANGE
The number specified for the Multiple Locks configuration option must be between 1 and 255, inclusive.

1002  BTRIEVE CANNOT ALLOCATE THE MEMORY NEEDED
Make sure that the workstation has enough memory to load all the programs it requires.

1003  THE MEMORY SIZE IS TOO SMALL
Make sure the value for the Memory Size configuration option is large enough to accommodate the
required cache size.

1004  THE PAGE SIZE OPTION IS OUT OF RANGE
The value of the Page Size configuration option must be an even multiple of 512, and it must be between
512 and 4,096, inclusive.

1005  THE PRE-IMAGE FILE DRIVE OPTION IS INVALID
You must specify a valid drive letter for the Pre-Image File Drive configuration option.

NOTE
Pre-image files are used only for files created by Btrieve versions earlier than
v6.x, or by v6.x if it was loaded with the Create Btrieve Files in Pre v6.x Format
configuration option set to Yes.

1006  THE PRE-IMAGE BUFFER SIZE OPTION IS OUT OF RANGE
The Pre-Image Buffer Size configuration option must be between 1 and 64, inclusive.

NOTE
Pre-image files are used only for files created by Btrieve versions earlier than
v6.x, or by v6.x if it was loaded with the Create Btrieve Files in Pre v6.x Format
configuration option set to Yes.

1007  THE OPEN FILES OPTION IS OUT OF RANGE
The Open Files configuration option must be between 1 and 255, inclusive.

1008  THE CONFIGURATION OPTIONS ARE INVALID
The configuration options specified contain invalid or unidentifiable values. For more information on
configuration options, refer to the installation and operation manual for your operating environment.
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1009  THE TRANSACTION FILENAME OPTION IS INVALID
The filename specified for the Transaction Filename configuration option is not valid. Check to make
sure that the transaction filename is correct.

1011  THE COMPRESSION BUFFER SIZE SPECIFIED IS OUT OF RANGE
The Compression Buffer Size configuration option must be between 1 and 64, inclusive.

1013  THE TASK TABLE IS FULL (WINDOWS ONLY)
The Btrieve DLL may return this status code if the task entry table is full. You can remedy this situation
by increasing the number of available task entries; use the tasks initialization option (tasks=xxx) under
the [BTRIEVE] or [BREQUESTDPMI] headings in NOVDB.INI. The minimum value for this option is
1; the maximum value is 255.

1014  THE APPLICATION ENCOUNTERED A STOP WARNING
WBTRVSTOP () returns this status code if the application still has open files or an active transaction.
The application must close all files and end all transactions before calling WBTRVSTOP ().

1015  A POINTER PARAMETER IS INVALID
One of the pointer parameters passed into Btrieve is invalid.

1016  BTRIEVE IS ALREADY INITIALIZED
The Btrieve DLL may return this status code if an attempt is made to initialize Btrieve when it is already
initialized. To reinitialize Btrieve, close all files, end/abort all transactions, and call WBTRVSTOP ()
before calling the initialization function.

1017  THE BTRIEVE REQUESTER FOR WINDOWS CANNOT FIND WBTRVRES.DLL
WBTRCALL.DLL returns this status code when it cannot find the resource file WBTRVRES.DLL. You
can remedy this situation by placing a copy of the WBTRVRES.DLL file in the same directory as the
WBTRCALL.DLL file.

Btrieve Requester Status Codes
This section lists the status codes that the Btrieve Requesters may generate.

2001  THE MEMORY ALLOCATION IS INSUFFICIENT
In an OS/2 environment, the Requester cannot allocate enough memory for the parameters specified
with the BRQPARMS environment variable. In a DOS environment, reduce the value specified for the
/D configuration option.

2002  THE OPTION IS INVALID OR OUT OF RANGE
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In an OS/2 environment, either one of the options specified with the BRQPARMS environment variable
is invalid (such as /P instead of /D) or the value specified for a parameter is out of range. Check the SET
BRQPARMS statements to make sure it is correct.

2003  THE REQUESTER DOES NOT ALLOW LOCAL ACCESS TO THE SPECIFIED FILE
The application attempted to access a file stored on a local drive. The version of WBTRCALL.DLL
installed at the workstation does not allow access to local files.

2004  SPX IS NOT INSTALLED
Install the NetWare SPX v1.3 or later communications software for OS/2.

2005  AN INCORRECT VERSION OF SPX IS INSTALLED
Install the NetWare SPX v1.3 or later communications software for OS/2.

2006  THERE IS NO AVAILABLE SPX CONNECTION
SPX has already established the maximum number of sessions it can handle. To increase the maximum,
edit the NET.CFG file. Refer to your NetWare documentation for more information on NET.CFG.

2007  A POINTER PARAMETER IS INVALID
One of the pointer parameters passed to Btrieve is invalid. Check the program to ensure that the pointer
parameters are correct.
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Appendix C  LSC File List

This appendix contains a list of all the files included with LAN Support Center.

LSC Main File List

File Name Purpose

USEBRQ.BAT The batch file that enables users to run LSC with the server-
based Btrieve

USEBTR.BAT The batch file that enables users to run LSC with the client-
based Btrieve

FILE.DDF Data dictionary file #1 needed to build custom reports.

FIELD.DDF Data dictionary file #2 needed to build custom reports.

INDEX.DDF Data dictionary file #3 needed to build custom reports.

CONVERT.DLL The library that converts LSC 2.x database to 3.0 format

LSC.EXE The main executable program that runs LSC.

LSC Ticket Records Databases

File Name Purpose
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HLPDSK1A.DA
T

Action header database

HLPDSK1H.DA
T

Ticket header database

HLPDSK1P.DAT Ticket problem description database

HLPDSK1T.DAT Action description database

LSC Administrative Databases

File Name Purpose

HLPDSK1C.DA
T

Unique Account IDs with corresponding information database

HLPDSK1D.DA
T

Department database

HLPDSK1F.DAT Filter criteria database

HLPDSK1G.DA
T

Product category database

HLPDSK1I.DAT Action code database

HLPDSK1L.DAT Last name database

HLPDSK1M.DA
T

First name database

HLPDSK1N.DA
T

Network address database

HLPDSK1Q.DA
T

Query database

HLPDSK1R.DA
T

Report database
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HLPDSK1S.DAT Staff (Login, security, etc.) database

HLPDSK1U.DA
T

Issue type database

HLPDSK1V.DA
T

Report query database

HLPDSK1X.DA
T

Labeling database

HLPDSK1Y.DA
T

Problem type database

HLPDSK1Z.DAT Unique Company IDs with corresponding information
database

Pre-defined LSC Reports
NOTE:
If you have modified the LSC database labels, the report names listed in the
Choose Report dialog box will reflect the current labels.

File Name Report Name

ALLACCT.RPT All Tickets by Account ID

ALLSTAFF.RPT All Tickets by Assigned To

ALLDEPT.RPT All Tickets by Department

ALLDATE.RPT All Tickets by Date

ALLPRIOY.RPT All Tickets by Priority

ALLPBTYP.RPT All Tickets by Problem Type

AINITSTF.RPT Average Initial Response Time by Assigned To

AVEINIT.RPT Average Initial Response Time by Problem Type

AVESTAFF.RPT Average Time to Close by Assigned To

AVEPBTYP.RPT Average Time to Close by Problem Type
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CLEDEPT.RPT Client listing by Department

CLENAME.RPT Client listing by Last Name, First Name

CLSSTAFF.RPT Closed Tickets by Assigned To

CLSDATE.RPT Closed Tickets by Date

CLSDEPT.RPT Closed Tickets by Department

CLSPRIOY.RPT Closed Tickets by Priority

CLSPBTYP.RPT Closed Tickets by Problem Type

ACTLIST.RPT Daily Action Listing by Person

MONPBTYP.RPT Monthly Statistics by Problem Type

MONTCKT.RPT Monthly Ticket Load Statistics by Problem Type

OPNSTAFF.RPT Open Tickets by Assigned To

OPNDATE.RPT Open Tickets by Date

OPNDEPT.RPT Open Tickets by Department

OPNPRIOY.RPT Open Tickets by Priority

OPNPBTYP.RPT Open Tickets by Problem Type

TCKETDET.RPT Ticket Details

QUERY.RPT Last page of all printed reports which lists the queries applied to the
report.

LSC Dynamic Link Libraries

File Name Purpose

BDIABOUT.DLL McAfee About Box

BWLIB.DLL McAfee License Installation

CHK4BRQ.DLL McAfee Check for Brequest

COMMDLG.DLL Common Dialog Boxes

CRPE.DLL Crystal report engine

CTL3D.DLL Three-D effects to controls

NWCALLS.DLL Netware functions
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NWUTIL.DLL McAfee NetWare utilities

PDBBTRV.DLL Crystal’s Btrieve DLL

PDCTBTRV.DLL Crystal’s Btrieve DLL

TBPRO1W.DLL Toolbox DLL

TBPRO2W.DLL Toolbox DLL

TBPRO3W.DLL Toolbox DLL

TBPRO5W.DLL Toolbox DLL

UFLSAMP1.DLL Crystal Report DLL

UFLSAMPT.DLL Crystal Report DLL

WBHANDLE.DLL McAfee Btrieve Handler

WBTRCALL.DLL Novell Btrieve DLL

WBTRVDEF.DLL Novell Btrieve DLL

WBTRVRES.DLL Novell Btrieve DLL

Crystal Reports v2.0 Files

File Name

CR2.BMP

CR3.BMP

CR4.BMP

00019144.DAT

00028747.DAT

BWCC.DLL

CRXLATE.DLL

DDEML.DLL

P3CONV.DLL
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P3DIB.DLL

P3FILE.DLL

P3INFO.DLL

PXENGWIN.DLL

CRW.EXE

CRW.HLP

CRW.INI

CRW.NET

BTRLABEL.RPT

BTRORDER.RPT

LABELS.TXT
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Appendix D  Using Brequest

This appendix discusses the use and configuration of the server-based Btrieve record
manager, BREQUEST.

Using the Btrieve NLM
The Btrieve record manager must be loaded before running LAN Support Center.  It
is highly recommended that you use the server-based BREQUEST program.  This
appendix offers recommendations on setting up and using the Btrieve NLM.

NOTE:
a - When using BREQUEST, version 6.10 or greater is required.

b - When using BREQUEST, BSPXCOM must also be loaded on the fileserver.
For details on loading these programs, refer to your Novell documentation.

Using the NLM with LSC

Using BREQUEST, as opposed to BTRIEVE, will improve the performance of data
collection, auditing and reporting by at least 50% and by as much as 500%.  An
additional advantage is the savings in local (client) memoryBTRIEVE.EXE can
occupy from 50-85K of conventional memory, whereas BREQUEST.EXE can
occupy approximately 31-45K.  The exact amount of memory required for both
programs depends on the specified command line parameters.

Use the following procedure to configure the Btrieve NLM.

1. To configure the NLM, run BSETUP.NLM.

At the file server console prompt, type:

LOAD BSETUP <ENTER>

2. Choose Set Configuration to verify that the following options are defined.
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The values provided below are the minimum values required; your current
values may be set higher.

Number of Open Files: = 22  (default = 20)
Number of Transactions: = 1  (default = 0)
Largest Record Size: = 17000  (default = 8192)
Largest Page Size: = 4096  (defaul t = 4096)

NOTE:
All other BSETUP options can remain unchanged.

3. Save the configuration, and exit BSETUP.

BSETUP writes the configuration changes to the BSTART.NCF file.  The
changes do not take effect until the next time the Btrieve NLM is loaded.

4. To load the NLM, run BSTART.

At the file server console prompt, type:

BSTART <ENTER>

BSTART is an NCF file which loads both BTRIEVE.NLM and
BSPXCOM.NLM.

5. To unload the Btrieve NLM, issue the BSTOP command.

If the Btrieve NLM was loaded when changes were made in BSETUP, you need
to unload Btrieve and then reload the NLMs in order for the changes to take
effect.

For example, at the console prompt, type:

BSTOP <ENTER>
BSTART <ENTER>

NOTES:
a - Loading SPX -  All LSC modules require SPX to be loaded at each
workstation. Brequest communicates with BSPXCOM.NLM via SPX.
BSPXCOM, in turn, passes all requests from Brequest to the BTRIEVE NLM.
If SPX is not loaded at a workstation, that workstation has no communication
whatsoever with the Btrieve record manager. If you have loaded Brequest and
are getting “BTRIEVE Record Manager Not Loaded” messages, make sure
that SPX is loaded.  This normally only becomes an issue on workstations that
load the ODI drivers because the ODI drivers can optionally load SPX.
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b - Brequest /D switch - The /D: parameter specifies the size of the “data
message buffer length.”  This buffer refers to the maximum record size that the
NLM will transmit to the workstation.  This switch should be set to 17000 for
the purposes of LSC.

c - Brequest Error 87 - If you receive an “Error 87” from Btrieve while using
Brequest, increase the ‘Number Of Open Files’ setting in BSETUP.

Using the BTRIEVE VAP
All of the options and suggestions regarding the Btrieve NLM also apply to the
Btrieve VAP.  The BSETUP parameters, Brequest parameters, and Windows
requester initialization settings are identical.

NOTE:
When using the Btrieve VAP, the file server needs to be rebooted in order for
any changes in BSETUP to take effect.
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Appendix E  LSC Import/Export Utility

This appendix discusses the use of the DOS-based LSC import/export utility.

Using the Import/Export Utility
The import/export utility, LSCIMEX.EXE, is a DOS application which allows you
to import or export data into/from the LSC 3.0 databases.  The import/export utility
is copied into the LSC program directory upon installing LSC.

The following requirements must be met before running the import/export utility:

The utility must be executed from within the directory in which the LSC
3.0 software and database files are located.
The Btrieve record manager must be loaded before running the utility.

Because LSC 3.0 has a customizable interface, most data fields are not restricted to a
particular format.  The import/export utility will match the field names in LSC even
if they have been changed by the administrator.  The only fields that have a specified
format are date and time fields.  All other fields may be of any type or format.

Use the following keys to navigate throughout the utility.

Key Action

<ESC> Return to the previous menu.  Also used to initiate the
export or import process.

<Up/Down Arrow> Highlight the menu option in the direction of the arrow.

<Enter> Choose the highlighted menu option.
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A mouse can also be used to navigate throughout the utility and choose menu
options.  The mouse cursor appears as a small square.  When the small square rests
on a desired menu option, click the left mouse button to choose the option.

Importing Data into LSC

Tickets are imported from the file ITICKETS.TXT, and actions from
IACTIONS.TXT.  To import a file, copy it into the LSC directory as one of the
appropriate file names.  The file(s) must be in comma delimited ASCII format.

NOTE:
Quotes around each text field are optional.  If your text fields contain commas,
quotes are required to prevent the commas from being interpreted as
delimiters.

Use the following procedure to import LSC ticket data from an ASCII text file.

1. Load the Btrieve record manager.

Either server-based or client-based Btrieve can be used with the import/export
utility. Refer to “Btrieve Configuration Options” in Chapter 2 for a discussion of
the Btrieve options.

2. Execute the import/export utility.

Enter the following command at the DOS prompt:

LSCIMEX <ENTER>

The main menu displays.

3. From the main menu, choose the Import Data into LSC option.

The Import Menu displays.

4. Choose either Import Ticket Information or Import Action Information,
depending on the data you want to import.

Ticket information and action information are imported separately because there
can be many actions associated with one ticket.  In order to keep track of which
actions are associated with which tickets, the ticket number field is required for
importing actions.

After choosing one of the import options, a list of fields displays.

5. Indicate the layout of the fields in the import file.
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This list represents the fields available for import.  The numbers to the left of
each field indicate the order of the fields in the import file.  For example, if you
want to import a file which contains ticket number, priority, status and date (in
that order), you would put a 1 next to the Ticket Number field, a 2 next to the
Priority field, a 3 next to the Status field, and a 4 next to the Date field.

A zero in any field indicates that the field does not exist in the import file, and it
should be ignored.  In the example above, a zero would be placed in all
remaining fields.  With the exception of the zeros, the numbers you place in the
fields must be unique.

As mentioned above, the ticket number field is required when importing actions.
If the ticket number contains a zero when importing tickets, then only contact
information (and not ticket information) is recorded.

6. Press the <ESC> key, and choose the Yes option to begin the import process.

Ticket information must be imported from a file named ITICKETS.TXT, and
actions must be imported from IACTIONS.TXT.

Once selecting the field order and starting the import process, a “Please Wait”
box will appear and the number of records being imported displays on the
screen.  If any errors occur during the process, you will be notified at the end
and directed to the file ERRORLOG.TXT for details.

7. To exit the utility, press the <ESC> key two times.

A box displays with the title “Exit LSC Import/Export Program.”

8. Choose the Yes option to exit the utility.

Exporting LSC Ticket Data

Use the following procedure to export LSC ticket data to an ASCII text file.

1. Load the Btrieve record manager.

Either server-based or client-based Btrieve can be used with the import/export
utility. Refer to “Btrieve Configuration Options” in Chapter 2 for a discussion of
the Btrieve options.

2. Execute the import/export utility.

Enter the following command at the DOS prompt:

LSCIMEX <ENTER>

The main menu displays.

3. From the main menu, choose the Export Data from LSC option.
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The Export Menu displays.

4. Choose either Export Ticket Information or Export Action Information,
depending on the data you want to export.

Ticket information and action information are exported separately because there
can be many actions associated with one ticket.

After choosing one of the export options, a list of fields displays.

5. Indicate the order in which to export the fields.

This list represents the fields available for export.  The numbers to the left of
each field indicate the order in which the fields will be exported.  For example,
if you want to export the ticket number, action code and person, you would put
a 1 next to the Ticket Number field, a 2 next to the Action Code field, and a 3
next to the Person field.

In order to keep track of which actions are associated with which tickets, the
ticket number field is required for exporting actions.  It is automatically
exported as the first field for actions.

If the ticket number contains a zero when exporting tickets, then only contact
information (and not ticket information) is recorded.

A zero in any field indicates that you want to skip that field during an export.  In
the example above, a zero would be placed in all other fields.  With the
exception of the zeros, the numbers you place in the fields must be unique.

6. Press the <ESC> key, and choose the Yes option to begin the export process.

Ticket information is exported to the file TICKETS.TXT, and actions are
exported to ACTIONS.TXT.  The files generated from an export will have
quotes around each text field but not around the integer fields.

Once selecting the field order and starting the export process, a “Please Wait”
box will appear and the number of records being exported displays on the
screen.  If any errors occur during the process, you will be notified at the end
and directed to the file ERRORLOG.TXT for details.

7. To exit the utility, press the <ESC> key two times.

A box displays with the title “Exit LSC Import/Export Program.”

8. Choose the Yes option to exit the utility.
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databases, 16
date editing, 129
DISKCOPY, 21
display

ticket data, 69

E

Edit menu, 48
environment, 18
error messages

LSC, 267
exiting LSC, 47
exporting data, 301

F

feature list, 14
file list, 290
File menu, 48
filtering, 135

G

generating reports, 153

H

help desks, 10
Brightwork solution, 10
cost justification, 12
cost of, 12
problem with, 10

help facility, 50
Help menu, 48
historical ticket database, 16, 105

viewing, 149

I

icons, 48
import/export utility, 18, 299
importing data, 300
installation, 21, 23

basic, 25
before you start, 22
conversion, 31
custom, 27

troubleshooting, 36
upgrade, 29

investigating, 131
IPX, 22

K

keyboard use, 50

L

launching LSC, 44
log file, 24
login default, 46, 83
LSC and Btrieve, 39
LSC and NetWare, 22
LSC.EXE, 16
LSC.INI, 50
LSCIMEX.EXE, 299

M

manual organization, 19
menu bar, 47

N

NETWARE.DRV, 22
NETX, 22

O

ODI drivers, 22

P

passwords, 86
printer setup, 110
printing

notes on, 155
reports, 153
tickets, 121

problem type sub-categories, 103

Q

qualification lists, 16, 97
customizing labels, 81
defining entries, 57, 100

queries, 155
applying to reports, 156
creating, 159
deleting, 163
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editing, 162
removing from reports, 159

R

reporting module, 17, 152
reports

adding, 164
applying queries, 156
customizing, 157
deleting, 165
generating, 66
pre-defined, 153
printing, 153
renaming, 164
sample, 165

Reports menu, 48
requirements, 18
restoring tickets, 108

S

security, 83
granting rights, 86

SETUP, 23
setup and administration, 78
smart-launching, 132
sorting, 139
staff membership, 83

adding, 84
maintaining, 87

T

temporary files, 155
ticket database

viewing, 64
ticket databases, 149
Ticket menu, 48
ticket numbering, 74
Ticket window, 73

action entries, 76

contact details, 76
fields, 113
modifying labels, 75
numbering scheme, 74
viewing multiple, 75

tickets
actions, 119
archiving, 105
creating, 59, 113, 117
cross-referencing, 119
deleting, 120
printing, 121
restoring, 108

tool bar, 48
troubleshooting, 36
tutorial, 52

U

uninstalling, 36
upgrade

converting from LSC 2.02, 31
upgrade conversion charts, 32
upgrading, 29

V

version numbers, 23
View menu, 48
View Tickets window, 70

filtering, 135
layout, 70
scrolling, 71
sorting, 139

VIPX, 22
VNETWARE.386, 22

W

Window menu, 48
Windows terms, 43
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